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Uvod

Model losa

od Kaie Pedersena.

Predkladame Vam Ceskou verzi vyukovych pfirucek (tutoriald), které byly prelozeny z
originalnich materialt vydanych spole¢nosti Maxon k jejimu fantastickému 3D programu
CINEMA 4D R8 Oxygen. Tato publikace vznikla za spoluprace mé osoby se spoleénosti
Digital Media s. r. 0. (www.cinema4d.cz), ktera distribuuje produkty sple¢nosti Maxon
Computer v Ceské republice a spoleénosti Grafika Publishing s. r. 0., na jejiZ serverech,
zejména pak na www.3dscena.cz a www.grafika.cz, vychazely tyto referenéni tutorialy
prabézné v elektronické podobé.

Preklad byl pokud mozno uplny, jedinou zasadni vyjimku tvofi kapitola Modelovani,
ve které jsem uved| misto dvou originalnich tutorialu tutoridly své, autorské, a to po
domluveé s ing. Stanislavem Szkanderou ze spole€nosti Digital Media na zakladé nasi
spole€né praxe a zkuSenosti s programem.

Nasim cilem bylo vytvoreni srozumitelného navodu, jak se od zakladu naudit pracovat
s timto vyjime&nym programem a to i v jeho demo verzi. Proto nejsou pfikazy
prioritné uvadény pod Ceskymi nazvy, které diky ceskému prostfedi existuji (na
www.cinemadd.cz), ale v anglické verzi. Vysvétlujici preklady nazvu ptikazl jsou
vétSinou uvedeny v zavorkach &i ve vétné konstrukci a proto doufame, ze tak budou
tyto tutorialy srozumitelné vSem.

Pteji vSem pfijemnou préci a radost z dila! V Praze dne 23. 4. 2003, ing. Pavel Zoch.
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O tvorbé 3D

Byt uspéSnym 3D grafikem znamena vyuZivat rozli€né znalosti z rdznych disciplin:
kresleni, sochafrstvi, architektury, inZenyrstvi, konstrukce, osvétleni, fotografie, filmarstvi,
choreografie, matematiky, fyziky, ozvu€ovacich technologii a tak dale. Samozfejmé ze
samotny jedinec asi nemuze byt expertem ve vSech téchto oborech, ale porozuméni
nékterych z nich mize velmi pomoci.

Prace ve 3D zahrnuje pét zakladnich oblasti - technologii. Samostatné pracujici 3D
vytvarnici a animatofi musi zvladat vSech pét, ale ve vétSich spole¢nostech (kde se
3D tvorbou zabyva vice pracovniku) je ¢astym jevem, Ze jeden z vytvarniku je lepSi v
jedné z oblasti nez v jinych. Pfesto i zde musi alespori v hrubych rysech rozumét i tém
ostatnim, protoZe nelze pfedavat dilo bez vztahu na pozadavky technologie, kterou
bude pouzivat jeho kolega.

P&t zakladnich technologii:

* Modelovani: Tvorba objektd, které budou ve scéné.

* Texturovani: Definovani vlastnosti povrchu objektu.

» Osvétleni: Osvétleni scény.

» Animace: Vytvareni anmaci pomoci kliCovych snimku.

» Rendering: Tvorba finalnich obrazku ¢i animovanych klipd.

Dale se muzete setkat také s témito oblastmi:

« Vizuélni efekty: Exploze, taveni, apod.
» Zvuk: Hudba, zvukové efekty nebo hlasy postav ve scéné.
« Postprodukce: DalSi Upravy vystupu v jinych programech.
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Uzivatelské
prostredi

Jestlize budete Cist pouze jednu
cast z téchto zakladnich tutoridld,
pak by to méla byt tato. Naléza se
zde popis uZivatelského prostredi
programu CINEMA 4D, jehoZ
znalost je nezbytnou podminkou
pro dalsi praci s programem.

Zakladni uzivatelské prostfedi programu CINEMA 4D obsahuje velké editacni/
modelovaci okno, tzv. viewport, které je obklopeno paletami ikon a nékolika okny
spravcu (manazer). Palety jsou prouzky obrazkovych ikon, které jsou umistény podél
okrajii obrazovky, spravci (manaZefi) jsou vétSimi plochami, ve kterych se zobrazuji
informace a vlastnosti jednotlivych objektd.

» Zvolime ptikaz Open (Otevfit) ze menu File (Soubor) a nahrajeme soubor nazvany
»quickstart.c4d“ z adresare Quickstart v adresafi CINEMY 4D Tutorials.

Nahrajeme soubor, ktery je Open File (2]

oznacen na obrazku dmlogo:z:: Lodk_ir-ju Ia QuickStart ﬂ - I‘fF Y

Na této pravé oteviené scéné si snadnéji predvedeme funkci kazdého z manazeru-
spravcu.
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1 = Viewport, 3D zobrazeni,
modelaéni okno

2 = palety ikon, nastrojové menu
3 = Object manager, spravce
objektd

4 = Material manager, spravce
materialu

5 = Attributes manager, spravce
atributu (hodnot objektu)

6 = Active tool manager, spravce
aktivniho nastroje

7 = Status bar, stavovy fadek
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Ve viewportu je nyni zobrazeno nékolik objektu, které jsou reprezentovany svymijmény
v Object manageru (Spravci objektll). Jméno objektu je umisténo za ikonou objektu a
ostatnimi tlacitkami a ikonami, jejichZ funkce si objasnime pravé v tomto tutorialu.

Material Manager (spravce material(l) obsahuje materidly pouzité na objektech ve
scéné. Materialy se pouzivaji pro definovani povrchu objektu, coZ jsou napfikad barva,
prihlednost, odrazivost a mnoho dalSich.

Jestlize chceme vidét, jak vypadaji objekty s pouzitymi materialy, pak vybereme
pfikaz Render View (Renderovat pohled) z menu Render (Rendering).

Attributes manager (spravce nastaveni) obsahuje vy¢et parametr pfislusnych kazdému
vybranému elementu. V8echny parametry zde mohou byt upravovany interaktivné. Ku
pfikladu zména velikosti objektu se bezprostfedné projevi ve viewportu (zobrazovacim
okné).

Pouzivani palet s ikonami na levé strané uzivatelského prostiedi ndm umoZriuje editovat
objekty (jak je samotné, tak napfiklad i jejich osy). Paleta ikon v horni ¢asti uzivatelského
prostiedi obsahuje néstroje pro pohyb, rotaci a méfitko objektt pro rendering a modelaci.
Paleta ikon umisténa pfimo na spodni hrané uzivatelského prostfedi se pouziva pro
animace.
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Stavovy fadek na spodni hrané uZivatelského prostfedi poskytuje uzitetné informace
o nastrojich prezentovanych ikonami, o pfikazech, které vybirame z jednotlivych menu
nebo o vypodtech, které v programu probihaji.

Souhrn

Naucili jsme se orientovat v uzivatelském prostfedi programu CINEMA 4D, v jednotlivych
manazerech, paletach a zobrazovacim okné. Nyni miZzeme ziskavat dal$i zku$enosti
s vyuzivanim jednotlivych nastrojd a funkci v nasledujicich tutoridlech podstatné
rychleji.
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O pojmenovani
V8e md sveé jméno a my spolu
objevime, jak je uZitecné

si zvyknout na vyuZivani
vyznamovych jmen u nasich
objektu, materialu a ostatnich
elemenetu.

006 FinalAnim.c4d *

File Edit Objects Tools Selection Structure  Functions  Pluging  Render Animation  Painter ‘Windo »

=, H P E Objects | Strusture | Browser |
AN K @ [XLYLZ O
4 k» . e |l 4 File Edit Objects Tags Texture

S5O -Character & Animation () 2002 Maam/Happy Ship (=

Cameras Display View
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~CAMERATARGET

[=FMime

Boned Cage
Main Controls
Extra Contrals

Left Foot Floor

Right Foot Floor

[4] |
o attributes | active Tool | Snap Settings |
360F M4l 4« B P I & r1ode  Edit  User Data

L
e =
Edit Function ‘ el 68

7 7 Basic | Color [ specular |
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Calor x R JIEA
g
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At uz si to uvédomujeme €i ne, trdvime mnoho nasich dni pojmenovavanim véci, které
jsou béZnou soucasti naseho kazdodeniho zivota. Jak bychom se asi vyrovnali s tim,
Ze bychom neméli pojmenovani pro obchod, kdyZz chceme nakupovat, pro mésto ve
kterém Zijeme, ¢i pro na8e vlastni déti a ostatni nam znamé a blizké osoby.

Obcas v kontextu mizZeme fict napfiklad ,prosim, podej mi ten Salek*, kdyZ je tento
jedinym, ktery na stole je. Jakmile bychom v8ak chtéli néjaky Salek ze skfinky v kuchyni,

ve které je $alkl vice, pak musime fici ,mGze$ mi dat ten modry, ¢insky Salek prosim?*,
nebo ,dej Zuzce jeji kafacek”.

Jména nam pomahaiji organizovat a identifikovat véci rychleji a snadnéji a také nam
pomahaji pfi tom, kdyZ o nich mluvime.

Mnoho elementt v programu ma své jméno - od objektu pfes materialy aZ k jednotlivym
taglim (vlastnostem) a proto je dlleZité davat témto vécem pokud mozno smysuplna
jména. Podivejme se tedy na to, jak jednostlivé elementy pojmenovat. Zacneme
objekty.

Vyberete menu File (Soubor) a pomoci funkce ,,New“ (Novy) vytvofime novou
scénu.
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vytvorime kouli.

Objects IStructurel Browserl
4 File Edit Objects Tags Texture

I—Sphere o o 00 =

(= [

Attributes IActive Tool | Snap Settings
4 Mode  Edit  User Data

0 Sphere Object [Sphere] é 5
Basic [Coord. [Object

Basic Properties

X Narme Fphere
Yisible in Editor  [Default =,
Yizible in Renderer m
Use Color m
Display Calor *[ |

W Enabled [ ¥-Ray

» V menu zvolime Objects (Objekty) > Primitive (Primitiva) > Sphere (Koule) a

Tato vloZzend koule se objevila také v Object manageru (spravci objektu) se jménem
Sphere a stejné jméno se zobrazi také na zakladni zaloZce Attributes manageru, kdyz
v Object manageru klepnutim mysi vybereme objekt Sphere (ndzev objektu bude

zobrazen Eervéné).

» Vybereme objekt Sphere v Object manageru klepnutim na jeho jméno.
» V Attributes manageru klepneme na zalozku ,,Basic” (Zakladni).

» Dosud je v Attributes manageru stavajici jméno, poklepeme na slovo Sphere (text

s nazvem se oznaci), vepiSeme nové jméno Ball (micek) a stiskneme klavesu

Enter.

Zménili jsme jméno koule na Ball (mic).

» V Object manageru poklepeme na slovo Ball.

Name

Mame IBaII|

Cancel | Ok |
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Otevre se dialogové okno s ozna¢enym originalnim nazvem objektu, pfipravenym pro
vloZeni nového jména. K tomuto dialogovému oknu se mdzeme dostat také zvolenim
nastroje Rename Object (Pfejmenovat objekt) z menu Objects (Objekty) v Object
manageru.

V dialogovém okné zménime jméno na Eye (oko) a potvrdime zménu stisknutim
tlacitka OK.

Pouziti konkrétni metody je zavislé na okolnostech; jestliZze mame vybrany objekt,
pak je snaz&i zménit jméno tohoto objektu v Attributes manageru. Jestlize vSak pravé
prohlizime objekty v Object manageru (spravci objektl), tak je rychlejsi poklepat na
jméno objektu a poté ho pfejmenovat.

Tak je to tedy s pojmenovavanim objektl. Materidly jsou pojmenovavany stejnym
zpusobem. JestliZze si nahrajeme materialy z naseho disku ¢i z CD, tak zjistime, Ze
jsou jiz pojmenovany, ale jestlize si vytvofime néjaké nové materialy sami, pak bychom
jim méli dat néjaké smyslupiné jméno.

V Material manageru (spravci materialu) vybereme zalozku File (Soubor) > New
Material (Novy material) a tim vytvofime novy material.

4| File Edit Function

| Mew Material Crnd+N
bhodi HUT Yolume 3
PyroCluster 3
shader 3
Load Materials... Shift+Crmd+0
Save [Materials as... Shift+Cmd+5
Save Al Materialsas...
Close Shift+

Standardni pojmenovani materialu je New, toto jméno se ale da zménit nékolika
zplsoby.

V Material manageru poklepeme na jméno New umisténé pod ikonou
materialu.

4 File Edit Function
7 .
Newk:

Otevre se nam dialogové okno s oznacenym textem New, pfipravenym pro pfepsani
novym jménem.
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» Vyplnime jméno Pupil (zornice) a poté stiskneme tlaéitko OK pro potvrzeni.

Zménili jsme jméno materialu na Pupil.

S oznaéenym materialem Pupil v Material manageru klepneme na zalozku Basic
v Attributes manageru (spravce nastaveni).

Attributes IActive Tool | Snap Settings |
4 Mode Edit User Data |

g Material [Pupil] E' 5

| Basic | Calor |Specu|ar IIIuminati0n|

Basic Properties

* bame [Fupil
|7 Color I_ Bump
[~ Diffusion [~ alpha
| i IS enanulan

Nyni opét muZeme prejmenovat material vybranim textu Pupil a naslednym vepsanim
nového jména. Zkusme si to.

Posledni moznosti jak pojmenovat material je poklepat na ikonu materialu (oproti tomu
jak jsme klikali na jméno materialu) - tim se otevie dialogové okno, které je zdrojem
informaci, jezZ jsou k dispozici také v Attributes manageru. Zde muZeme opét vyplinit
jméno materialu a poté dialogové okno materialu zavfit.

Posledni véci, kterou bychom se méli naucit, je pojmenovani tagl (vlastnosti). Tagy
jsou pfifazovany k objektim a obecné slouZi k dalS$imu nastaveni nejriiznéjSich
vlastnosti a charakteristik. Tagy mizZeme pojmenovavat podle jejich ucelu a funkci.
Zde je priklad.

V Object manageru (spravci objekti) vybereme objekt Eye.

Z menu File (Soubor) v Object manageru zvolime New Tag (Nova vlastnost) >
Display tag (Zobrazeni).

Objects IStructurel Browserl
4 | File _Edit Objects Tags Texture_

3 I_E| MNew Tag 3 Anchor Tag
MNew Expression > Compositing Tag
Restore Selection > Constraint Tag
Load Object... Shift+Crd+q || Display Tag k
FlashEx Tag

Save Objects as... Shift+Cmd+5

Hyper MURES Weight Tag
Kinematic Tag

Close Shift+'w Metaball Tag

‘ | Motion Blur Tag

| v Display Tags

Phong Tag

Pratartinn Tan
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Tim se k objektu Eye pfida tzv. display tag, ktery nam zpfistupfiuje rdzné moznosti
zobrazeni objektu Eye ve zobrazovacim okné. Zméfime parametr tagu Display u objektu
na wireframe (dratény model).

» Pfi oznaceném objektu Eye klepneme na tag a tim se aktivuji nastaveni této
funkce v Attributes manageru.

» Ujistime se, ze je zapnut Display méd a zvolime Wireframe ve spodni menu
Attributes manageru.

Attributes IActive Tool | Snap Settings |
4 Mode Edit  User Data

g Display Tag [Display] & 5
Tag Properties

|7 Use Display Mode |wireframe x|

[T use  Level of Detaill [TO0°% =%

[l use  wisibility To00% 4

I_ Use |7 Backface Culling

I_ Use |7 Use Textures

Zmeénili jsme zobrazeni objektu Eye na draténé, ale samotny tag nemusi byt pojmenovan
Display, bylo by totiz uzite€né, aby jméno tagu bylo dostate¢né popisné.

» V Attributes manageru zvolime zalozku Basic obsahujici zakladni informace o
tagu.

» Zménime jméno z Display na Wireframe.

Nyni kdyZ poklepeme na tento tag v Object manageru (vpravo od objektu Eye), tak
uvidime jméno, které jsme predtim vepsali do Attributes manageru.

Souhrn

Naudili jsme se jak pojmenovavat mnoZstvi objektl v programu CINEMA 4D a nyni jiz
dobfe chapeme, jak se s touto problematikou v uZivatelském prostfedi vyporadat. Jinym
mistem, kde se da uplatnit cit pro pojmenovani riznych véci v programu je prostredi
Time Line (Casova osa, prostiedi editace animaci) - pfejmenovani objektl se provadi
poklepanim na jméno nebo se da provést pomoci menu Object > Rename Object
(pfejmenovat objekt) €i v editanim okné F-Curves (poklepanim na jméno).
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Navigace v
zobrazovacich
oknech

CINEMA 4D ndm nabizi velké
mnoZstvi rozli¢nych pohledu na
nasi praci v modelacni plose a
takeé variaci, jak tyto pohledy ménit.

Tyto ¢tyfi ikony slouzi k rychlé
navigaci.

KdyZz modelujeme, tak se asto musime podivat na nas objekt z vice nez jedné strany.
V této ¢asti zakladnich tutorialt si budeme demostrovat rychlé metody zmén pohledl
na nasi scénu, nabizené programem CINEMA 4D.

Zvolime File (Soubor) > New (Novy) z hlavniho menu pro vytvofeni nové
scény.
Stiskem ikony Figure (Postava) levym tlacitkem mySi z liSty Primitives

(Primitivnich objektu) viozime do scény postavu. LiSta z ikonami Primitives se
naléza v hornim pruhu nastroju pod modrou krychli.

Poznamka ke ¢étyfem malym ikonam v pravém hornim rohu zobrazovaciho okna. Tyto
ikony jsou uréeny pro rychlou navigaci a polohovani ve zobrazovacim okné.

R e

Ve zobrazovacim okné stiskneme tla¢itko mysi nad prvou z téchto ikonek a
zkusime pfi tom pohybovat mysi po plose.

Prvni naviga¢ni ikonka ndm umozZiuje pohyb s pohledem ve zobrazovacim okné.
Klavesovou zkratkou pro tuto funkci je klavesa ,1“ na numerické klavesnici (pro pouZziti
je nutné stisknout klavesu a za jejiho stisknuti pohybovat mysi).
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» Stiskneme druhou ikonu a opét si zkusime pohybovat mysi.

Tato ikona se pouZiva pfi nutnosti pfiblizeni ¢i oddaleni pohledu. Klavesovou zkratkou
je klavesa ,,2“ na numerické klavesnici.

» Stejnou operaci si zkusime i u tfeti ikony.

Treti z t&chto navigacnich ikon v pravém hornim rohu zobrazovaciho okna nam umozriuje
rotaci pohledu okolo aktivniho objektu, v tomto pfipadé postavy. Klavesovou zkratkou
pro tuto funkci je klavesa ,3“ na numerické klavesnici.

» Klikneme na posledni ¢tvrtou ikonu.

Nyni se nam stavajici zobrazovaci okno rozdéli na ¢tyfi pohledy. Tato posledni navigaéni
ikona pracuje rozdilné nez ostatni - je to pfepina¢ pohledu, umozriuje nam rozdélit
celkovy pohled na ¢étyfi pohledy a zase zpét.

» V kazdém zobrazovacim okné muzeme stisknout ikonu pfepinace pohledu a
tento pohled maximalizovat.

Pro prepinami mezi celkovym a délenym pohledem muzeme pouzit také klavesy Page
Up a Page Down. Poznamka k pfepnuti do celkového pohledu: CINEMA 4D vzdy pfepne
na celkové to okno, které je pravé aktivni. To, Ze je okno aktivni, pozname podle modie
zvyraznéného okraje. Pro aktivaci jiného nez pravé aktivniho okna sta¢i klepnout mysi
do prazdné plochy zvoleného okna nebo kliknout na prouzek nastrojl tohoto okna.

Souhrn

Jak jsme vidéli, na nasi scénu se miizeme divat z riznych Uhli a perspektiv. Také jsme
se naucili polohovat zobrazovaci okno v zavislosti na objektu, se kterym pravé pracujeme
(ktery je vybrany v Object manageru). Mame k dispozici rozliéné moznosti nastaveni
pohledu vychazejicich z rozdilnych poZadavku prace, od prace na architektufe az po
tvorbu lidské postavy...

CINEMA 4D se tak umi pfizplsobit nasim potfebam.
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Tvorba a uUprava
objektu

CINEMA 4D obsahuje velky
pocet preddefinovanych objektu,
které pro nase ucely nazyvdame

L, Primitives*, tedy primitiva.

Po stisku tlacitka mysi se
vytvofi valec.

don Stucture  Functions  Plugine  Fender  Animation  Painter  ‘Window  Help

Tato ¢ast tutorialu vysvétluje zplsob tvorby a definovani jednoduchého objektu Cylinder
(valec) uzitim nastroji Move (posun), Scale (méfitko) a Rotate (rotace). Také se nau¢ime
pouzivat Attributes manager pro Upravu parametr(i objektu.

Zvolime File (Soubor) > New (Novy) z hlavniho menu pro vytvoreni nové, prazdné
scény.

Stiskneme tlaéitko mysi nad modrou krychli, ktera se naléza ve vrchni paleté
ikon.

Stiskem tlacitka mySi se otevie paletka ikon, zastupujicich primitivni objekty, jako jsou
krychle, koule, valec, trubka, krajina a dalsi.

Najedeme mysi nad ikonu Cylinderu (valec) a poté stiskneme levé tlacitko
mysi.

Vytvoreny valec bude umistén pfimo ve stfedu modelaéni plochy.

Pro vytvoreni valce jsme vybrali objekt valce z palety primitivnich objektl a poté stiskli
tlacitko mysi. Je nasnadé, zZe kdybychom chtéli vytvofit krychli, pak by stacilo kliknout
na objekt krychle bez toho, aniz bychom museli otevirat paletu pfikazu.
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Klepnuitim a tazenim mysi
ménime polomér.

Zapnutim moznosti Fillet
(zaobleni) dodame objektu valce
zaoblené vrchni a spodni hrany.

Okolo valce muzeme vidét naznaéeny ohranicujici ¢erveny kvadr (ten je
samoziejmé aktivni pouze v pfipadé, Ze je tento objekt oznacen), dva oranzové
uchopové fidici body spojené useckou a tfi barevné Sipky vychazejici z jednoho
bodu ve stiedu valce, které reprezentuji osy objektu. Osu X, ¢ervena, osu Y,
zelena a osu Z, modra. Oranzové tGchopové fidici body spolehlivé reprezentuji

parametry objektu, v tomto pfipadé vysku a polomér.

» Stisknéme tlacitko mySi nad oranzovym bodem znacicim polomér a tazenim
mysi tento polomér zménime.

Velké mnoZstvi objekttd v CINEMé 4D obsahuje moznost editace pomoci oranZovych
fidicich bodu. Tyto Fidici body umoZriuji provadét interaktivni zmény parametru objektu.
V nasSem pfipadé jsme ménili polomér valce. Oranzovy Fidici bod v ose valce nam
oznacuje vysku objektu. VSechny tyto parametry muZzeme navic prfesné numericky
nastavit v Attributes manageru (spravci nastaveni).

V Attributes manageru zapneme moznost Fillet (zaobleni).

Altributes | Shap Settingsl
4 Mode UserData
' Cylinder Object [Cylinder] &
| B asic |E00rd. |Dbiect| Caps [ Slice ]
Caps
|7 Caps
Segments Iﬁ
[ Fillet
Segments Iﬁ

Radiuz  [20m 3l

Zapnutim moznosti Fillet jsme vytvofili zaobleni na spodni a horni hrané valce. Zarover
se automaticky vytvofil novy oranzovy fidici bod pobliz vrchniho uzavéru vélce, kterym
se da definovat mira zaobleni hran valce. V8echny objekty patfici do skupiny Primitives
(nebo nalézajici se v menu Object > Primitive), mohou byt editovany v zasadé stejnym
zplGsobem. Rozdilné objekty maji rozdilné parametry, ale mnoho z nich se da editovat
pomoci oranzovych fidicich bod(.
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Potazenim ¢ervené Sipky osy X

posuneme objekt podél této osy.

Nastroj Scale je umistén hned za
nastrojem Move v téZe paleté.

Nastroj Rotate nam umozni
rotaci objektu a jinych elementu.

» Stiskneme tlacitko mysi nad €éervenou Sipkou, znacici osu X objektu, a poté
tahneme mysSi doprava. Objekt zméni svou pozici v ose X.

PotaZenim Sipky znadici jednu z os miZeme polohovat pouze podle zvolené specifické
0sy.

» Nyni umistime kurzor do volné plochy - mimo osy objektu i mimo objekt samotny
- stiskneme tlaéitko mysi a posuneme mys libovolnym smérem.

Pohybem mysi v modelaénim okné (bez vybéru konkrétni osy objektu) miZeme ménit
zcela volné pozici objektu ve vS§ech smérech.

» Klepnéme na nastroj Scale (méfitko) nalezajicim se na vrchni paleté nastroju.

ey A @ (XYZ9 W@ & AT
» Ve zobrazovacim okné klepneme do prazdného prostoru a tahneme mysi z leva

do prava a sledujeme zménu velikosti valce.

Nastroj Scale se da pouzit pro vSechny vybrané objekty ¢i elementy.

» Stiskneme nastroj Rotate (rotace) z vrchni nastrojové palety.

Fale i % 3TYON AT ] BANE IR AN

Tento nastroj nam umozni otodit valec okolo ptvodni pozice. Zluty kruh okolo os valce
nam rozdéli zobrazovaci okno na dva regiony. Jestlize budeme pohybovat mysi uvnitf
kruhu, valec bude rotovat okolo v8ech svych os najednou, pfiéemz bude zaviset na tom,
kam sméFujeme pohybem mysi. Jestlize budeme pohybovat mySi mimo Zluty kruh, pak
bude valec rotovat podle svych os kolmo k aktualni roviné svého zobrazeni.
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Souhrn

Naudili jsme se pracovat s jednim z preddefinovanych objektt a ménit nékteré jeho
parametry. Také jsme vidéli, jak se pracuje s nastroji Scale a Rotate. CINEMA 4D
nabizi Siroky rozsah preddefinovanych objektt, které mohou byt vhodné jako vychozi

velké mnozstvi editacnich nastroja.
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Vytvoreni
a aplikace
materialu

Jiz umime vytvorit objekty, nyni
je potreba je oZivit tim, Ze jim
dodame povrch pomocf textur.

Vétsina spravcu v programu
CINEMA 4D ma sva vlastni menu,
ktera obsahuji pro né specifické
pfikazy .

Mat =] B3
4 INEM - Color
R M ESE |
G M EESE |
B {|100% 3
A _» | Brightness 5 EEE |
ZW r Testure
Diffusion |
:Luminance Wieges I j
[ Transparency || Sampling [MIP <[00z 5[0z 7
Reflection [
: Enwironment i INormaI LI i I‘I 00 % ﬂ
Fog =
:Bump Edit... |
| Alpha
i Specular
| Specular Color
| Glow
Primml—mmrn s +

Nové vytvorené objekty jsou vzdy Sedé, coz je jejich vychozi barva. Abychom tento
stav zménili, vytvofime novy material v Material manageru a poté jej aplikujeme na
objekt. Tato ¢ast zakladnich tutorialt pojednava o tom, jak vytvofit novy material a jak
ho aplikovat na vybrany objekt.

» Zvolime File (Soubor) > New (Novy) z hlavniho menu a vytvofime novou

scénu.

» Stiskem ikony znacici anuloid (Torus) z menu Primitives (Primitiva) otevieného po
stisku modré krychle na horni paleté nastroju vioZime do scény tento objekt.

» V Material manageru (spravci materialu) zvolime File (Soubor) > New Material
(Novy material).

o 4

[

Mew Material Cirl+t
bhodiMUT %alurme 3
Pyrocluster 3
Shader 3

Load M aterials... Crl+Shift+0

Save I aterials as... LCtl+Ehift+S

Save Al Materals 2z,

Shift+w h

Cloze
4| File  Edit

Function

Nové vytvoreny materidl je Sedy, stejné tak jako pred chvili vytvofeny anuloid.



30 PRVN KONTAKT

CINEMA 4D TUTORIALY

Pouziti posuvniku jednotlivych
kanalu barvy pro tvorbu syté
modré.

Anuloidu je pfifazena modra
barva.

» V Material manageru (spravci materialu) poklepeme na okénko s nahledem

materialu a otevie se nam editaéni okno materialu.

V edita¢nim okné mizZeme nastavit ve$keré aspekty materialu. Pro nas je vSak v tomto
okamziku aktudlni zména barvy.

V editacnim okné materialu nastavime barvu v RGB rezimu pomoci posuvniku
na syté modrou. Hodnotu jezdce R (Red, éervena) na 20%, G (Green, zelena)
na 50% a B (Blue, modra) na 100%. Hodnotu Brightness (Jas) nastavime na
100%.

4 INew Calar

R i 0%
G 50 %
B N ESE

Brightness 100% 3
3
A -

[V [Eolar - Texture 1

oo
L

oo
L

=

i
4

=
8
L

Vyse tfi uvedené posuvniky definuji hodnotu barvy v rezimu RGB a posledni posuvnik
udava hodnotu jasu barvy.

Jestlize klikneme na barevny obdelnik nalevo od posuvniku, tak miZzeme zménit barevny
rezim, ve kterém nastavujeme barvu povrchu.

Zavieme editacni okno materialu poklikanim na ikonu zavfit (kfizek) na listé
okna.

» V Material manageru stiskneme (a stale drzime) tlacitko mysi nad nahledem
materialu. Nyni tahneme (stale drzime stisklé tlacitko) nad objekt anuloidu v
modelaénim okné a jsme-li nad nim, pak tlaéitko mysi pustime.

Anuloid je nyni modry. Kdybychom méli vice nez jeden objekt ve scéné, pak bychom
shledali, Ze je vétSinou snaz§i umistit material na objekt ve spravci objektl misto v
modela¢nim okné. Zplsob prace je pfi tom naprosto stejny.
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Souhrn

PFidali jsme naSemu objektu velmi jednoduchy material a porozuméli jsme zakladnim
pravidlim pouZivani Material manageru. V pozdéjSich tutorialech se nau¢ime pouzivat
komplexni materidly, obsahujici obrazky coby textury.
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Zmeéna velikosti
oken

Program CINEMA 4D nabiz/
Sirokou $kalu moZnosti
pfizpusobeni uZivatelského
prostredi. Pro zacatek si ukdZeme
jednu z téch nejjednodussich.

Zména velikosti modelaéniho
okna umozni najednou zobrazit
vétsi pocet materialu ve spravci

materialu.

UZivatelské prostfedi programu obsahuje velky po€et oken, ktera Ize upravovat pfi
adekvatni zméné ostatnich. MdZeme chtit napfiklad upravit vysku a Sifku téchto oken
tak, aby ziskané zobrazeni odpovidalo nasim potfebam. To samoziejmé muZze pfispivat

k vyssi efektivité nasi prace.

Abychom vytvofili mensi zobrazovaci okno (viewport) a zaroven vétsi okno
spravce materialu, staci najet kurzorem mysi nad hranici mezi obémi okny a
poté, co se zméni kurzor na znacku zmény velikosti okna, stisknout a potahnout
mysi.

Tahneme mysi vzhuru hranici mezi okny.

Zména velikosti spravce materidlu muze byt uzZite€na v pfipadé, Ze pracujeme s
komplexni scénou, ve které je velky pocet material(. Kdyz potfebujeme vice mista v
modela¢nim okné, pak jednodu$e potahneme stejnym zplGsobem hranici mezi okny
zpét tam, kde byla predtim.
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Souhrn

Pomoci rozdilného nastaveni jednotlivych oken prostfedi si miZeme podstatné ulehgit
préaci na riznych projektech; pfi praci s animacemi zvétsime okno Timeline (Casové osy),
pfi praci s velkym mnoZstvim materiald staci zvétsit okno Material manageru.

Ukazali jsme si, Ze zména velikosti okna je velmi snadna. Pozdéji se nauc¢ime, jak si
konfigurovat pohledy podle potfeby a jak tyto konfigurace uloZit pro dalSi pouZziti.
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Vytvoreni nové
palety nastroju

Obréazky patii mezi nejlepsi
zpusoby sdélovani informac;
CINEMA 4D nam zpristupriuje
obrdzky ve formé ikon.

—

(\/‘(l){\f"\/ R R T

—

Palety ikon se skladaji ze znaéného poctu logicky usporadanych kolekei nastroju, casto
shromazdénych za néjakym specifickym tucelem. Nékteré palety nastroju jsou pfimo
pfipravené k pouzivani v praxi. Do téchto palet mohou byt pfidavany extra moduly,
pluginy nebo jen ty nastroje, které potfebujeme mit po ruce. Na tomto misté si ukaZeme,
jak si vytvofime kompletné novou paletu nastroju.

» Zvolime Window (Okno) > Layout (Rozvrzeni) > New Icon Palette (Nova paleta
ikon-nastroju) z hlavniho menu.

Vytvoiili jsme novou paletu ikon-

nastroju.

Nova paleta ikon je vytvorena, ale v tomto okamziku je zatim prazdna.
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» Klepneme pravym tlaéitkem (uzivatelé platformy Mac stisknou klavesu Command
a klepnou) na prazdnou paletu a z kontextového menu vybereme prikaz Edit

Palettes.

JJ Empty Falette
Undock
Rename...
Make Tab
Mew lcon Palette...
Load Toolbar ...
Save Toolbar as ...
Faold Palette

Wrfeld Eammard
Lock zan
[elete Eammard
Edit Palettes

v lcons

Command manager (spravce pfikaz(), ktery se nam oteviel, umozfiuje vloZit do nasi
prazdné palety (ale také do vSech ostatnich palet) ikonu nastroje, ktery jsme si v ném
zvolili.

» V Command manageru (spravci pfikazu), klikneme na rozbalovaci rolovaci menu
ve vrchni ¢asti a vybereme polozku Editor Selection (Editor-Selekce).

m Z |EI|1| w' Commands H=E3
JJ Empty Falette 4 | All Commands - LI |7 Edit Palettes
ﬂ Hotk.eys
- All Commands - =
Editor
Editar - File
“ Editor-Edit
x Editor - Objects
Editar - Tools

E\. Editar - Selection

|lEz  Editor - Functions

V zakladnim nastaveni zobrazuje Command manager vSechny pfikazy, které program
obsahuje. Je jich tam velmi mnoho a tak je vhodné specifikovat, kterou skupinu pfikazl
chceme zobrazit. V naSem pfipadé chceme vytvofit paletu nastroju uréenou pro
selekci, proto zvolime jako filtr zobrazeni Editor - Selection, pro zobrazeni adekvatnich
nastrojl.

» Pomoci posuvniku se posuneme vyétem prikazu dolu, dokud se neobjevi pfikaz
Select All (vybrat vse).
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» Stiskneme tlacitko mysSi nad pfikazem Select All a poté jej pretahneme mysi
nad prazdnou paletu. Jakmile se v paleté objevi maly ¢erny prouzek a u kurzoru
mysSi maly bily étverec, pustime tlaéitko mysi a ikona nastroje bude umisténa
v nasi paleté.

m Z | Ellll W' Commands H=E3
JJ Empty Falette 4 IEditor - Selection LI |7 Edit Palettes
Separator 1| Separator 2

« Polygon Selection ]

. Rectangle Selection
2 Select Al

Select Children
& Select Cormected
% Selection Filker
4 Set Selection
&y SetWertex Weight...
54 Shirink Selection
& Unhide All

[

Command:  Select &l
Description: Select All

» Premistime se v seznamu prikazu vySe a opakujeme celou operaci s prikazem
Deselect All (Odznadéit vse).

W I[=1 B3 =lalx|
JJ’ 8 IEditor - Selection LI [V Edit Palettes
Separator 1| Separator 2
o Coreeert Selection <
# Desslect Al
F,—g‘? Dizplay Filker
. Freshand Selection
W2 Grow Selertion
» Nyni vypneme editaci palety zavienim okna Commnad manageru (spravce
pfikazu).
w' Commands H=E3

+ IEditor - Selection LI [ Edit Palettes
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» Paletu tazenim mysi po stisku levého tlaéitka nad dvémi levymi prouzky na levé
strané vedle ikon pfetahneme ke spodnimu okraji modelaéniho okna. Jakmile se
objevi éerny prouzek na spodni hrané modelacniho okna a u kurzoru se objevi
maly bily Etverec, pustime tlacitko mysi a paleta se ,,ukotvi“ na prisluSném
misté.

» Stiskeneme pravé tla¢itko mysi (klavesa command a klinuti u platformy Mac)
nad paletou a zvolime z vyvolaného menu pfikaz Text pro zobrazeni nazvu
prikazu.

» Stiskneme pravé tlacitko mysi (klavesa command a klinuti u platformy Mac) nad
paletou a z vyvolaného menu odznacime pfikaz Icons (ikony) a skryji se nam
ikony.

I I
|| selectan  Desslectal

——

LRGE 5
e Edit Function

Po vypnuti zobrazeni ikon nam zlstaly zobrazeny pouze nazvy pfikaz(. Na spodni hrané
modela¢éniho okna nyni mame po ruce paletu selekce, kterd nam muze usetfit mnoho
Casu pfi praci, protoze nestravime tolik €asu pouzivanim menu Selection (selekce) pro
vybér a zruSeni vybéru objektu ¢i elementd v nasi scéné.

Souhrn

Palety nastrojl jsou nejlep$i moznosti, jak si vylepSit vlastni pracovni prostiedi programu.
Vidéli jsme, jak je snadné vytvofit si vlastni paletu a také jak nastavit jeji zobrazeni podle
naseho gusta. Stejné snadné je editovat stavajici palety. CINEMA 4D je totiZ nastroj,
ktery pracuje pro nas a snazi se pfizplsobit nasim potfebam.
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Integrace
editoru
materialu s
prostredim

Schopnost zaloZit a uvolnit
dialogova okna pfidava
uZivatelskému prostredi programu
CINEMA 4D na flexibilité.

To, jak si uspofadame dialogova okna v pracovnim prostfedi Cinemy 4D, zavisi vétSinou

na chrarakteru projektu, na kterém pracujeme. Napfiklad kdyZ nastavujeme parametry
mnoha materialu, tak budeme chtit mit stale k dispozici editor materialu, abychom ho
nemuseli neustale otevirat klepnanim mysi.

» V Material manageru zvolime File (soubor) > New (novy) Material.
» Poklepanim na nahled materialu otevieme editor materialu.

Tento editor bude integrovan do | B Material
uzivatelského rozhrani.

Nyni chceme tento editor integrovat do uZivatelského prostredi tak, abychom ho napfisté
nemuseli pokazdé zdlouhaveé otevirat a zavirat pfi kazdé editaci materialu.
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» V editoru materialu stiskneme tlacitko mysi nad ikonou malého modrého
Spendliku.

EINEW

/2

» Se stisknutym tlacitkem mysi tahneme kurzorem doprava, dokud se kurzor
nenaléza na pravé strané od zalozky Attributes (Nastaveni) a poté tlacitko mysi
pustime.

o
[ ]
Altributes ﬁ Shap Seftings I
4 ModeUser Data |
[ .
g Material [Mew] ﬁ
| Basic | Color | Specular |IIIuminati0n|
Color

Falar - S | vy |

Jakmile pustime tlacitko my$i, tak bude editor materialu umistén mezi dvé zalozky. Editor
byl ukotven a nadale nebude spoustén coby plovouci neukotvené dialogové okno.

Nyni mdZeme opét stisknout ikonu Spendliku a dale mezi ostatni zalozky a zalozku
materialu umistit jiné dialogové okno, a to stejné jako jsme pracovali s editorem materialu.
Ten pak jiz nadale nepotfebujeme zdlouhavé otevirat a zavirat. Editor materialu je nyni
dobfe zaintegrovany. Jestlize je v systému aktivni jiny spravce a editor materialu je
skryty, tak staci dvakrat poklikat na nadhled materidlu v Material manageru a editor
materidlu se zaktivni a ,vysune“ na povrch.

Souhrn

Vidéli jsme jak je snadné ukotvit dialogové okno v programu CINEMA 4D prostym
kliknutim na ikonu Spendliku. Kdybychom si pfali toto dialogové okno uvolnit, pak
jednoduse staéi kliknout nad ikonou Spendliku a z nabidky zvolit moZnost Undock
(Uvolnit).

Umime ukotvovat a uvolfiovat dialogova okna a tim si upravit uZivatelské prostredi tak
,abychom méli vzdy po ruce to, co pravé potfebujeme.
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Modelovani
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HyperNURBS 1

Tvorba velmi jednoduchého
modelu se zaoblenym povrchem
s ostrym trnem je vybornym
prikladem modelovani. Naucr
nds, jak vykonna je prdce s funkcr
HyperNURBS.

Nurbsové modelovani je metoda tvorby objektu, pfi které je potfeba pro vytvoreni
plochy objektu pomérné maly pocet kontrolnich bodu. HyperNURBS néam poskytuje
moznost vytvoreni vyhlazenych a zaroveri slozitych objektd bez nutnosti jeho rozdéleni
na jednotlivé diléi ¢asti.

Toto je B-Spline, tedy NURBS
kfivka, jejiz body ovliviuji
smér jejich €asti. Spojnice

jednotlivych po sobé jdoucich

bodu tvofi teény modelované
kfivky. Jsou tedy jejimi
derivacemi (pozn. pfekladatele).

Na vy$e uvedeném obrazku si mizZeme ilustrovat chovani kfivky pfi zméne polohy
fidicich bodu. Budeme-li ignorovat prvni (pocatecni, Zluta barva) bod a posledni bod
(Cervena barva), tak pfi posunu jakéhokoliv mezilehlého bodu bude tento bod kfivku
ovliviiovat tak, jako kdybychom na jeji tvar pisobili magnetem.
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HyperNURBS posouvaji B-Splines jesté o néco dale a pridavaji jim dalsi rozmér. Tedy
misto vyuziti bod( ke tvarovani kfivek, které vS§ak samostatné netvofi plochu, je zde
obdobné pracujici funkce HyperNURBS, diky niZ jsme schopni dodat objektlim realnou
geometrii. Budeme tedy spolu postupovat na tvorbé velmi jednoduchého pfikladu, ktery
nam objasni, jak tato funkce pusobi.

Prfidame si do nasSi scény objekt Cube (krychle) z hlavniho nastrojového
menu.

Ll N

V nasi malé ukazce bude povrch krychle ovliviiovan funkci HyperNURBS. Pozn. nase
zakladni krychle se sklada z osmi bodd, Etyf na vrchni a étyf na spodni sténé, tedy v
kazdém rohu je jeden.

Pridame do scény objekt HyperNURBS z hlavniho nastrojového menu.
. % | Y

Objekt HyperNURBS netvofii sam o sobé Zadny povrch, ale ovlivriuje tvar jinych objektu.
Funkce HyperNURBS a také dfive vloZena krychle se automaticky objevi také v Object
Manageru (spravci objektu). Objekt krychle je v seznamu zafazen vyse, protoZe jsme
ho do scény vlozili jako prvni.
V Object manageru (Spravci objektu) uchopime levym tlaéitkem mysSi objekt
krychle a ten zafadime pod objekt HyperNURBS.

Objects | Structurel Browserl

4 File Edit Objects: Tags Testure |

ErHypeiNURES (]2 v -

I—Eube ‘ ' OQ

Jestlize jsme umistili objekt krychle pod funkci HyperNURBS, tak si v§imnéme, Ze se
nam v modelaénim okné zménila krychle v kouli. Divodem této zmény je pravé to, ze v
momenté aplikovani funkce HyperNURBS se v8echny body na krychli pouziji k vytazeni
povrchu krychle. Vzhledem k tomu, Ze vSechny body maji na tvar objektu stejny vliv,
bude vysledkem pravé koule uvnitf krychle.
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Primitivni objekty neni mozné
ménit bez pfedchoziho
pfevedeni na editovatelna télesa.

Rozdilné médy nam zapinaji
rozdilné Fidici elementy objektu.

Touto zménou jsme docilili
zmény tvaru objektu, nas model
jiz neni perfektni kouli

» Ujistime se, ze mame v Object manageru (spravci objektu) vybrany objekt krychle

a stiskneme tla¢itko Make Editable (prevede objekt na editovatelny), které je v

horni éasti levé nastrojové listy.

5

KaZdy objekt pfevedeny na editovatelny se zméni trvale (funkce neni pozdéji vratnd, tedy
jestlize upravime nap¥. plochy prevedené koule a poté bychom chtéli objekt opét prevést
na primitivni kouli, tak to nebude mozné). Tim, Ze jsme objekt pfevedli na editovatelny
ale ziskame moZznost jej editovat pomoci Upravy bodd, hran a polygonu, které definuji
jeho povrch. Primitivni objekt neni nutné pfevadét na editovatelny ihned po vioZeni do
scény, protoze v nastaveni kazdého takového primitivniho objektu se da velmi lehce

nastavit poCet segmentu ze kterych se sklada, mira zaobleni a dal$i parametry, které
nam ulehéi naslednou praci s pfevedenym objektem.

Vybereme Points mod (Mod editace bodu), stisknutim tlaéitka v levé nastrojové
liste.

Pfi modelovani muZzeme vyuZit tfi druhd fidicich elementd objektu - body, hrany a
polygony. P¥i editovani pomoci kaZzdého jednoho z nich muZzeme vyuZit rozliénych
nastrojl, které ndm umozni editovat model specifickym zplisobem pro dany rezim, jez
je v jiném rezimu jen téZce dosazitelny.

V modelaénim okné vyberte poklepanim mysi jeden z fidicich bodu a potahnéte
jej smérem od koule, coz zméni tvar koule.

KdyZ potdhneme vybrany bod smérem od koule, tak se zméni tvar celého objektu.
Jestlize bychom bod umistili zpét na pvodni misto, tak by se na8 model stal identickym
s plvodni kouli.
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» Se stale vybranym bodem stiskneme a podrzime klavesu . (tecka), stiskneme
tlacitko mysi a tahneme po modelaéni ploSe smérem doprava.

Vytvofili jsme slzu.

Timto krokem pozménime vliv tohoto konkrétniho bodu nad tvarem findlniho objektu.
Tato vlastnost je znama jako HyperNURBS Weight, tedy HyperNURBS véaha.

Souhrn

Ukazali jsme si, jak se pouziva HyperNURBS u velmi rychlého vytvoreni vyhlazeného
objektu, vychazejiciho z jednoduchého modelu o nékolika mala Fidicich bodech. Od této
chvile mGzeme experimentovat s polohovanim polygonu ¢i bodu a sledovat, jak se bude
se zménou pozice téchto fidicich fragment( ménit tvar naSeho modelu. MiZzeme také
zkusit posunout bod dovnitf stavajiciho objektu a vytvofit tak konkavni prohluber.

Jak je vidét, tak i z objektu o osmi Fidicich bodech se da vytvofit velmi zajimavy a
tvaroveé slozity model.
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HyperNURBS 2

Diky rozsahlym moZnostem nové
verze programu CINEMA 4D,

je tvorba realistickych modeld
podstatné snazsi neZ drive. Na
ndsledujicim pfikladu si ukaZeme,
jak se tvorf pomérné sloZity model
Z4streky.

S funkci HyperNURBS se
nejcastéji pracuje pravé za
vyuziti médu editace bodu,

polygonu a hran, kdy je v téchto
modech pfistupny velky pocet
rozliénych funkci.

Pfedchozi kapitolou jsme ukongili zakladni seznameni s funkci HyperNURBS a nyni
je vhodna chvile k vyuziti naSich znalosti pfi vyrobé praktického objektu. Dotvofime
standardni americkou dvoukonektorovou zastréku. Dlivodem vybéru tohoto pfikladu je
nutnost vyuziti funkce Bridge (pfemosténi) a nékolika dalSich zajimavych pracovnich
postup.

Nahrajeme si scénu nazvanou ,,Plug Before.c4d“, ktera se nachazi v adresafri
Modeling, ktery je v adresafi CINEMA 4D Tutorials.

Jak vidime, tak nas§ model nebudeme vyrabét od zakladu, mame jiz k dispozici zakladni
¢ast zastréky. My model dotvofime za pouZiti rozli€nych nastrojl a postup(.

Vybereme mod editace polygonu z liSty na levé strané.

Pfi médu editace polygont je pfistupno mnoho funkci, pfi¢emz vétSina téchto nastroju
se nachazi v menu Structure (Struktura).
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Vybereme ty polygony, které
potiebujeme upravovat.

Pomoci nastroje Extrude
muzeme polygony vytahnout
ven, ale také je muzeme zapustit
dovnitf.

» V modelaénim okné oznaéime pomoci mysi a pfi souéasném stisknuti klavesy

Shift dva centralni polygony, tak jak jsou oznacené na obrazku.

Se stisknutou klavesou Shift miizeme mysi oznadovat vice objektl. Témito objekty
nemusi byt jen polygony, ale i hrany, body, ¢i celé objekty. Za stisku klavesy Ctrl
miZeme objekty odznacovat od vyznacenych skupin. Jestlize budeme chtit upravit
nékteré casti objektu, tak nejdfive vybereme ty €asti, na které budeme aplikovat dalSi
nastroje. V naSem pfipadé tedy vybereme dva predni polygony, coZ jsou zaklady obou
konektoru.

» Z menu Strukture (Struktura) vybereme pfikaz Extrude (vytazeni) a tahneme

v modelaénim okné mysi doprava, az se nam vytvofi zakladni tvary obou
konektoru.

Prikaz Extrude (vytaZeni) je aplikovatelny jak v rezimu polygond, tak v rezimu editace
hran a to stejnym zpusobem, jak byl uveden vyse. Timto se daji velmi snadno vytvorit
nové polygony. Tento pfikaz je pouZivan pro tvorbu detaild bez naru$eni struktury
okolnich ploch. Jestlize budeme tahnout po zvoleni tohoto pfikazu mysi doprava,,
vytahneme nové polygony ven (ve sméru normal, Zlutych kolmic z polygonu), tAhneme
li doleva, tak vtdhneme nové polygony dovnitf. Tyto zmény sméru neberou ohled na
globalni polohu objektu.
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Toto dal$i vytazeni nam pfipravi
model pro budouci tvorbu
detailu.

Polygony vybirame klepanim
mysi za sou¢asného stisku
klavesy Shift.

» V modelaénim okné tahneme za stalého zapnuti funkce Extrude jesté jednou
mysSi doprava stavajici polygony - tim pfidame k vytazenym konektorum jesté
jednu sekci.

VytaZeni dal$i sekce na obou konektorech je pfipravou na nékolik dalSich krokl a
my jej budeme potiebovat pro vytvoreni detaild na koncich konektori. Na tomto
misté je dlleZité poznamenat, Ze pfi modelovani bychom se méli vyvarovat pouZziti
trojuhelnikovych polygonud za souc¢asného uziti funkce HyperNURBS, protoZe by tim
mohly vznikat nechténé artefakty, projevujici se zejména pfi finalni vizualizaci.

Z horni listy nastroju zvolime nastroj pro vybér (Selection - druha ikona zleva

se Sipkou) nebo muzeme pracovat i s nastroji posun, rotace, méfritko (ale prace
oznacéime ctyfi ¢tvercové polygony, které budeme upravovat (nezapomeneme
pfitom na nutnost stisknuti klavesy Shift pro vicenasobny vybér).
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Pouziti funkce Extrude Inner.

Pfi vybéru polygond pfi zapnutych funkcich posunu, rotace a méfitko musime za
stisku klavesy Shift pouze klikat na polygony, které chcete pfimo oznadit. Jestlize
bychom pfi tomto oznagovani i mirné potahli mysi, tak by se ndam oznaéené polygony
posunuly, pootogily i zméniliy velikost podle zvolené funkce. Proto je lepSi a snazsi
vyuzit vybérového nastroje, u kterého toto nehrozi a je ¢asto také rychlejsi, protoze
Ize pouze tdhnout mysi pfi stisknuté klavese Shift a nové polygony se oznaduji bez
nutnosti dalSiho klepani.

Stiskem klavesy ,,i“ vyvolame funkci Extrude Inner (Vytazeni uvnitf) a tazenim
mySi doleva v modelaénim okné vytahneme uvnitf oznaéenych polygonu nové
vnitini polygony.

Stiskem klavesy ,i“ jsme pouZili jednu z mnoha zkratek, které slouZi ke spusténi
riznych funkci v rozliénych médech editace objektu. Ve standardnim pfipadé (nebyly
li nadefinovany jinak) se klavesovou zkratkou ,,i“ spusti pfikaz ,Extrude Inner” (Vytazeni
uvnitf), ktery jinak najdeme v menu Structure (Struktura). Jestlize po spusténi této
funkce potahneme mysi v modelaénim okné doprava, tak se vytvofi polygony vétsi nez
puvodni, pfi taZzeni doleva se vytvareji polygony mensi.

> Stiskneme klavesu ,,b“ (pfikaz Bridge) a poté tahem vytvofime spojnici
mezi korespondujicimi rohy obou vybranych vnitfnich polygonu. Tento postup
aplikujeme u obou konektoru.
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Klepneme na jeden roh z vybranych
polygonu, poté tahneme se stale
stisknutym tla¢itkem mysi nad
korespondujici roh protéjsiho
vybraného polygonu. Jestli-ze jsme
méli stale stisknuté tlaéitko mysi,
pak se nam urcité vytvofi otvor.

Mod editace hran zpfistupni
hrany naseho objektu k
editovani.

Nastroj pro vybér zapne
moznost aktivniho vybéru.

Vybereme hrany, na které
budeme aplikovat miru zaobleni
hran pomoci HyperNURBS vahy.

Jednou z mnoha moZnosti vyuZiti nastroje Bridge (Pfemosténi) je vytvoreni otvoru &i
tunelu skrz objekt. Jestlize se na misté budouciho otvoru nenachazeji zadné polygony,
vytvofi se nové. Nutnosti je pouze pospojovat navzajem korespondujici rohy, takze
nastroj pochopi, co pfesné a jakym zplsobem ma spojit.

» Vybereme méd editace hran z levého menu.

» Zvolime nastroj vybéru z horniho menu.

» V modelaénim okné vybereme za stisku klavesy Shift osm hran okolo otvoru,
které jsme pred chvili vytvorili na konektorech.

Jestlize chceme nastavit miru zaobleni hran (HyperNURBS vaha) u hran (i v ostatnich
médech), tak nejdfive musime vybrat ty hrany, na které chceme tuto funkci aplikovat.
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Pokud mate s vybérem hran problémy (oznacuje se vam vice hran najednou), zmérite v
Attributes manageru na zalozZce Active tool (Aktivni nastroj) hodnotu Radius (Polomér)
na 4 body.

» V menu Active Tool (aktivni nastroj) v Attributes manageru se ujistime, ze je
nastavena hodnota jezdce vahy na 100% a poté tuto hodnotu potvrdime stiskem
tlacitka Set.

MuZeme zkusit ménit hodnoty vahy a sledovat, jak se tyto zmény projevi na mife
zaobleni.

Po nastaveni hodnoty miry
zaobleni HyperNURBS vahy
na 100% se nam na koncich
konektoru vytvofily otvory s

ostrymi hranami.

Radéji nez opakované nastavovani miry zaobleni na jednotlivych hranach je vhodné;jsi
peclivé vyuzit nastroje pro vybér, vybrat vSechny hrany a nastavit pro vdechny hodnotu
zaobleni najednou. To je obzvlasté dilezité v pfipadech extrémnich hodnot tohoto
parametru.

V nékterych pfipadech mizeme mit potfebu funkci HyperNURBS vypnout - napfiklad
abychom mohli vidét urcité body nebo hrany. V nasem pfipadé se to tyka tfeba styku
kovovych zastréek s plastovym zakladem.

» Pro vypnuti funkce HyperNURBS staci klepnout na zelené zatrhavaci
znaménko u této funkce v Object manageru, které se tim zméni na ¢erveny
kiizek.

» Zapnuti funkce je stejné, klepneme na éerveny kfizek a ten se spolu se
zapnutim funkce zméni na zelené zatrhavaci znaménko.
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Vybereme ty polygony, na které
budeme aplikovat miru zaobleni
HyperNURBS vahu.

Budeme vytvaret uchopovaci
plochy a ohebna zebra.

» Vyuzijeme nastroj vybéru pro oznaceni ¢tyr velkych polygonu, tvoficich zaklad

u kazdého konektoru a také polygony nad a pod vytvorenymi otvory.

» V okné Active Tool (Aktivni nastroj) se ujistime, ze je jezdec nastaven na hodnotu

100% a stiskneme tlacitko Set.

Musime si zapamatovat skute€nost, Ze funkce HyperNURBS weight (HyperNURBS
vaha) je aktivni a nastavovatelna v menu Aktivniho néstroje jen pfi zapnuti nastroje
pro vybér!

» V modelaénim okné vybereme polygony mezi budoucimi zebry a také velké

plochy na vrhu a ve spodu zastréky. Ridime se p¥i tomto vybéru nize uvedenym
obrazkem.

U vétSiny elektrickych zastréek jsou identické nékteré ¢asti, které pomahaji pfi jejich
uchopeni. Také se u téchto objektl ¢asto nachazi plastové Zebrovani v ohebné &asti,
které chrani kabel proti zlomeni a odtrzeni od konektoru.

Uzivatelé Macu musi simulovat p V modelaénim okné stiskneme pravé tlac¢itko mysi a z vyvolaného menu pfikazu,

pravé tlacitko stiskem klavesy
Command.

vybereme Extrude (Vytazeni).
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' Unda fAction] :
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Tento zpuUsob je jeden z mnoha, jak vyvolat tytéz pfikazy. Kromé tohoto menu se dé&,
pouzit zkratek pro jednotlivé funkce nebo vybrat pfikazy v menu Structure. Kontextova
menu, kterd se objevi po stisku pravého tlacitka mysi, obsahuji nejcastéji pouzivané
pfikazy a pro dany objekt.

» V modelaénim okné potahneme mysi doleva a tim vytvofime Zebra u kabelu a
uchopové plochy na velkych plochach zastrcky.

PFfesné hodnoty nejsou v tomto principialnim pfikladu podstatné a je na nas, jak moc
vyrazné budou nami vytazené fragmenty.
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Vybér téchto polygonu je
pfednostni pro nasledné
zaobleni hran pomoci
HyperNURBS vahy.

Nadefinujeme miru zobleni hran.

» Vybereme v modelaénim okné polygony Zeber, pficemz ignorujte vertikalni

polygony.

» Vybereme nastroj Convert Selection (Konvertovat vybér) z menu Selection

(Vybér) a vybereme zménu vybéru z polygonu na hrany.

Nez nastavovat miru zaobleni u polygon(, tak je efektivnéjsi ovliviiovat zaobleni u
pfislusnych hran a bodd. Kdyz u téZe plochy budeme nastavovat vétsi miru zaobleni
(zostfeni) u polygonu, tak se nam zostfi rohy podobné jako bychom je zostfili pfi
nastaveni zaobleni v reZimu bodl. Pfi zméné vybéru z polygonl na hrany mizeme
bezpecnéji vyuzit zaobleni bez nechténého zostfeni zaobleni v rozich, které mizeme
nasledné dosahnout, budeme li to potfebovat, v rezimu bodd.

» Nyni mame vybrany automaticky méd editace hran.

» Stiskneme klavesu . (te€ka) a poté za stisklého tlacitka mysSi tahneme v
modelacnim okné kurzorem doprava. Vytvofime zostiené, ale nikoliv Upiné
ostré hrany.

Mira zaobleni hran musi byt zvolena tak, aby nebyly tyto hrany zcela ostré, ale mirné
zakulacené. Nechceme totiz, aby tyto hrany vypadaly nepfirozené.
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» Vybereme madd editace polygonu z levé palety.

» V modelaénim okné vybereme étyfi vnitini polygony na kazdé strané zastrcky,
které spojuji propadlé polygony tuchytové éasti s télesem zastréky.

Musime pamatovat na to, Ze se déa pfipadné vypnout funkce hyperNURBS pro lepsi a
presnéjsi praci pfi vybéru polygon(.

» Za stisklé klavesy “.” a tla¢itka mysi interaktivné tazenim nastavime miru zaobleni
vybranych polygonu.

Toto je typicky pfiklad procesu
formovani objektu.

Kdyz se tvofi Uchytova ¢ast zastrcky, tak opét nejsou potfeba zcela ostré hrany.
Potfebujeme vytvofit ne zcela ostré, mirné zaoblené hrany.
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» Prepneme na méd editace hran a vybereme ¢tyfi hrany na poéatku a konci
kabelu.

Jsou to hrany na které bude
aplikovana mira zaobleni
HyperNURBS vaha.

» Stiskneme klavesu . (tecka) a za stisklého tlacitka mysi interaktivné tazenim
vytvofime zcela ostré hran napojeni a konce kabelu.

Nyni ma kabel konstantni profil
po celé déice, nas model je tim
hotov.

Souhrn

Naucili jsme se nékolik zakladnich postupt modelovani za pouZiti funkce HyperNURBS.
Pro spravné funngovani HyperNURBS je duleZité se vyvarovat pouZiti trojuhelnikovitych
polygon(. Pokud nelze jinak, tak je pouZijeme jen v co nejnutné&jsi mite, protoze pfi
renderingu by na obratku mohly vzniknout nechténé artefakty.

Jestlize je to mozné, tak je vhodnéjsi tvofit modely o mensim poctu ploch, které mizeme
vyhlazovat pomoci funkce HyperNURBS. Men§i pocet polygonud na nasich objektech
je vkladem do budoucna, kdy budeme pracovat s animacemi, protoZze se samoziejmé
|épe pracuje s modelem o 500 polygonech nez s modelem o 5000 polygonech.

Nemusime také nastavovat pouze miru zaobleni na polygonech a hranach, ale i na
bodech. To, Ze jsme tento fakt nepouZili na nasem modelu bylo zpisobeno pouze tim,
Ze tuto funkci jsme u naseho modelu nepotiebovali.
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Vyuziti primitiva
jako polotovaru
pro polygonové
modelovani

Na ndsledujicim jednoduchém
prikladu si ukazeme jak vyuZit
zakladni primitivni objekt, krychle,
k tvorbé pomérné sloZitého
modelu. Pii modelovani uplatnime
znalost funkce HyperNURBS a
vyzkous$ime si prdci s nékterymi
funkcemi aplikovatelnymi pri
editaci polygonu.

d

» Zakladem modelu lahve na motorovy olej je primitivni objekt Cube (krychle)

Vybereme objekt Cube a ten se nam vlozi do scény. U objektu Cube, stejné jako u
v8ech ostatnich primitivnich objektl se daji nadale nastavovat jejich parametry v zaloZce
Attributes, kterou nalezneme pod spravcem objektu.
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Dobfe pfipraveny polotovar
modelu je zakladem pro
efektivni vyuziti modelovacich
funkci a také zjednodusi a
zrychli praci!

Pfi pfevedeni na editovatelny
objekt pfestava byt objekt
primitivnim a neda se nadale
nastavovat pomoci nastaveni
v zéloZce Attributes jako pred

nékolika okamziky.

Z vybranych polygonu bude
vytvofena nad zéakladnu

vytazena ¢ast lahve.

» Editace parametru objektu je dulezita vzhledem k dalSimu modelovani.

Mambates | e Tock | Srap Setings | Seles Te|
A Mode Bt s Date 5

[ somwien

Objekt Cube je nastaven dle vySe uvedeného obrazku. Velikost objektu je 90*90*150
a segmentace objektu je 3, 3, 5. Segmentace vyjadfuje hodnotu na kolik dild je
rozdélena plocha. Ku pfikladu €elni plocha (vyjadfena osami X, y) je rozdélenana 3 a
3 segmenty. Az na$ model pfevedeme do editovatelného tvaru, tak bude v této ploSe
3*3=9 polygon.

Pfevedeme model na editovatelny pomoci funkce Make Object Editable.

Pfevedenim objektu jsme si vytvofili polotovar, ktery nadale budeme utvaret pomoci
nastrojl aplikovatelnych pfi editaci polygon(.

Pfepneme do rezimu prace s polygony a vybereme vrchnich devét polygonu.

r

T

]
)
3
*

Pfi selekci polygon(, hran a bodu vyuzivdme vybérovy nastroj (Sipka, laso) a také
klavesy Shift a Ctrl. Pri stisku Shift muZeme oznacenim mysi pfibirat k jiz vybranym
elementdm dalsi, pfi stisku Ctrl miZzeme elementy odecitat. Vysledny vybér viz. nize.
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Skupina nastroju, ktera je

v tomto menu, je vybérem
nejéastéjsich nastroju, jejichz
uplny vycet naleznete pod menu
Structure v hlavnim menu.

Funkce se opét nastavuje v
zélozce Active Tool.

» Aplikujeme nastroj Extrude (vytazeni) z menu aktivovaného po stisku pravého
tlacitka mysi.

ititndes Active Todl | Seap Seltngs | Seteet Toud |

A Edndo

MuimmAnge  [B3°

Ofset [fom ¢

Vadiance |
Edge Bevel | [

B [T 1
FET N

e |

Po zvoleni nastroje miizeme provést jeho aplikaci interaktivné tazenim mysi (doprava,
vytahneme polygony ve sméru normal, doleva proti sméru normal), av§ak my zvolime
presné nastaveni, které nalezneme po zvoleni kazdého nastroje v zaloZce Active Tool.
Nastavime hodnotu Offset na 50 a stiskneme Tlacitko Apply.

» Aplikujeme nastroj Bevel (Zkoseni) z menu aktivovaného po stisku pravého
tlacitka mysi.

Atibutes Ackv Tool | Snap Setfings | Sebect Todl |
* Bevel

Mudmmange [
Erusion [20n
WVariance 0%
I Offyet 125 m
Vs (B

Nastavime parametr Extrusion (VytaZeni) na 30 a parametr Inner Offset (Vnitfni posun)
na 13,5. Vysledny efekt je shodny s postupem, pfi kterém bychom nejdfive aplikovali
funkci Extrude (Vytazeni) a nasledné bychom pomoci Normal Scale (Velikost podle
normaly) z téhoz menu vyvolaného pravym tladitkem zménili velikost vrchni plochy.
Nastroj Bevel je tedy kumulativni funkci.
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» Jestlize jsme neopomnéli na Zzadny z predchozich kroku, tak by nas model mél
vypadat takto.

» Vybereme polygon ktery bude tvorit zakladnu dchytu lahve a vybereme z
menu vyvolaného pravym tla¢itkem mysSi kumulativni nastroj Matrix Extrude
(parametrické vytazeni).

Matrix Extrude je dalsi
kumulativni funkci, ktera se da
zastoupit vhodné aplikovanou

funkci Extrude a tpravou
polygonu pomoci nastroju Scale
a Rotate z hlavniho nastrojového
menu.

Tato funkce je jednou z mala, ktera se needituje v zaloZce Active Tool.

» Nastavime parametry Matrix Extrude.

PFi kazdém kroku, pfi kterém je
pouzita nova funkce se nebojime
experimentovat.
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Nastaveni jednotlivych parametru je nasledujici. Steps, pocet krokl uréuje podet
vytazenych fragment(, Move, hodnoty uréujici posun, hodnota Z je shodna se smérem
normaly a tak neodpovida soufadnému systému objektu. Scale je hodnota zmény
velikosti vytazeného polygonu a hodnota Rotate znaci rotaci. Kazda z téchto hodnot je
relativni a tak je kazdy krok upraven dle téchto parametr(i vzhledem ke kroku minulému
a ne k matefskému polygonu. Pro pochopeni funkce mizZeme experimentovat.

Vytazeni je nastaveno na dva kroky (Steps) v hodnoté vytazeni 20 v ose Z pfi rotaci
10° v ose X. Stiskneme tlacitko OK a funkce probéhne.

» PFi spravném nastaveni vypada model takto.

» Vybereme polygon jez je vybran na predesiém obrazku a opét aplikujeme nastroj
Matrix Extrude.
Vytahneme polygon proti [0 e x|
polygonum vytazenym se spodni Swga[ |7 Pobgon Codne

&asti lahve. M e Baian.
%[on %[0 Hfo*

o= | [roox R

_;zﬁ_m |2[ioox E_l_'o‘
Mo fiE || [ u [FE—
e e umfT
! Y woeaf o !

Nastavime hodnoty dle vySe uvedeného obrazku. SniZime pocet krokl na jeden,
hodnotu vytaZeni ponechame a nastavime rotaci na -10° v ose Y. Stiskneme OK a po
aplikaci funkce vybereme proti sobé lezici polygony rukojeti.
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» Aplikujeme nastroj Bridge (pfremosténi) a tim dokonéime rukojet lahve.

Nastroj Bridge je dalSi z
nastroju, které nalezneme
VvV menu vyvolaném pravym
tlacitkem mysi.

P¥i aplikaci nastroje Bridge je nezbytné mit pfed uZzitim této funkce vybrané ty polygony,
které chceme propojit. Po vybrani funkce klikneme na roh jednoho polygonu, drzime
tlacitko mysi stale stisklé (levé) a nalezneme kurzorem adekvatni protéjsi roh. Budouci
spojeni simuluje Seda Usecka. Jsme li nad adekvatnim protéjSim rohem, tak pustime
tladitko mysi a funkce probéhne.

» Vybereme vrchni stfedni polygon v prostoru budouciho hrdla a ten posuneme
pomoci nastroje Normal Move (posunout podle normaly).
Nastaveni hodnoty funkce

nalezneme opét v zalozce Active
Tool.

Hodnotu nastroje Normal Move nastavime na 20 a stiskneme tlaitko Apply (nastavit).
Tim se posune polygon o tuto hodnotu vzhiru.



» Pomoci nastroju Extrude (vytazeni) a Extrude Inner (vytazeni uvnitf) z pravého
menu (vytazeni uvnitf) vytvofime hrdlo lahve.

Nasledujici krok je
nékolikastupriovy. Veskeré
hodnoty parametru jsou
nastavovany v zalozce Active
Tool.

Nejdfive vybereme nastroj Extrude Inner a nastavime hodnotu na 2 a aplikejeme.
Poté vybereme nastroj Extrude a nastavime postupné hodnoty 2, 16, 2. Po kazdé
zméné hodnoty stiskneme tlacitko Apply. Poté opét vybereme nastroj Extrude Inner a
nastavime hodnotu 2. Poslednim krokem je opét zvoleni funkce Extrude a postupné
nastavime hodnoty -2, -16, -2.

» Nas model je v zasadé hotov.

» Vlozime do scény funkci HyperNURBS a umistime polygonovy objekt pod
HyperNURBS.

Timto je model dokonéen




» Tim ze jsme vlozili objekt vytvofeny z puvodni krychle pod HyperNURBS (v
Object manageru, spravci objektu), tak byl model vytvoreny z krychle vyhlazen
a tim dokonéen.

The sections must be added to
the Loft NURBS in the correct
order to ensure a smooth
flowing mesh.

Souhrn

Na tomto malém a praktickém pfikladu jsme se naugili, jak je dllezité si pro polygonové
modelovani vhodné pfipravit primitivni objekt a také jsme se naugili pracovat s nastroji
Extrude, Extrude Inner, Normal Move, Bridge a Matrix Extrude.
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Vyuziti funkce
Lathe a prace s
HyperNURBS

Na jednoduchém prikladu si
ukdZeme jak pracovat s pfikazem
Lathe (rotace Nurbs). Soucasné
se seznamime s druhy krivek,
které nam CINEMA 4D umoZriuje
vytvolit a taktéZ si vyzkousime, jak
muZeme rotacni objekty formovat
pomoci funkce HyperNURBS.

Funkce Lathe, rotace Nurbs, je zakladni funkci tvorby objektu rotaéniho tvaru. Tento
tvar je definovan zakladni kfivkou, ktera je vyrotovana dle zadanych hodnot okolo
svislé osy.

» Uprava pohledu na pohled zpiedu.

Uprava pohledu v modelaénim I
e ]

Zagéneme Upravou naseho pohledu. Funkéni klavesou F4 i pfepnutim max/min (nejdfive
plvodni okno s perspektivou rozdélime na &tyfi okna, poté vybereme pohled zpredu,
to je pole z viditelnymi osami ,x“ a ,y“, a toto pole tlaéitkem max/min maximalizujeme)
tladitek si maximalizujeme pohled z pfedu. Prva ikona znaci posun pohledu, druha
oddaleni/pfiblizeni, tfeti rotaci pohledu a ¢tvrta je max/min modela¢niho okna. Pro
zménu v pohledu (posun, rotace...) mdZeme najet mysi na ikonu a stisknout tlaéitko
mysSi. Pfi stale stisknutém tlacitku mGZeme tahnout mysi a dle sméru pohybu se méni
zobrazeni v modela¢nim okné. Zkuste polohovat v modelaénim okné i pomoci klaves
na numerické klavesnici 1, 2, 3 a pfi jejich drzeni ménit polohu kurzoru mysi!
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» Vlozime do scény lomenou kfivku bud’ z menu Objects, nebo pomoci palety
kfivek z horniho menu.
Oba zpusoby jsou identické, nyni muzeme [Gemess [To

zacit kreslit kfivku, vSimnéme si zmény
kurzoru!

Nyni mizeme do nasi scény vlozit nasi kfivku. Kurzor se zménil na Sipku se znackou
kfivky znacici zvoleny nastroj a tak kliknéme do modelaéni plochy, &imz viozime prvy
bod. Poté dodame dal$i body tak, aby tvorili kfivku podobnou na niZze uvedeném obrazku.
Editaci ukonéime stisknutim ikony vybérového nastroje (Sipky) z horniho menu.

» Polohu bodu muzete editovat pomoci Coordinates manageru (Koordinaty). Dalsi
metodou je moznost vyuzita nastroje Set Value (nastavit hodnotu) pro zarovnani
jednotlivych bodu.

Tvofime polotovar tvaru nizké sklenky

Oznadime body které potfebujeme zarovnat €i nastavit jejich hodnotu a klikneme
pravym tlagitkem. Tim se spusti menu s pfikazy aktualnimi pro méd editace bodd,
do kterého patfi editovani tvaru kfivky. Z tohoto menu vybereme nastroj Set Value
(Nastavit hodnotu).
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Nastroj Set Value je silnym nastrojem pro
upravu polohy bodu a polygonu.

Timto pfikazem se da velmi snadno
vytvofit nejen obrys stavajici krivky, ale i

polygonového objektu.

» Spusti se dalSi dialogové okno s parametry nastaveni hodnot elementu.

Hodnoty u jednotlivych os objektu jsou Leave (ponechat), Set (nastavit), v této volbé
se prosvétli okno na nastaveni hodnoty a Center. Pfi této volbé se zarovnaji vSechny
vybrané elementy do stfedu svych soufadnic ve zvoleném sméru. Ve spodni ¢asti se
nastavuje soufadny rezim, dle kterého dojde k zarovnani.

Mame li dotvofenu zakladni kfivku, tak klikneme do plochy kurzorem, abychom
odznacili pfipadné vybrané body a klikneme pravym tlaéitkem pro vyvolani
nastrojového menu a z néj vybereme nastroj Create Outline (vytvoreni obrysu),

ktery se nachazi ve spodni éasti tohoto menu.

Tazenim mysi doleva vytvofime obrysovou kfivku, ktera je vSak spojena se kfivkou
puvodni. MozZnosti této funkce je i vznik nové nezavislé kivky (nastaveni v menu Active
object (aktivni nastroj)) av§ak v naSem pfipadé tuto moznost nevyuzijeme. Nyni stejnym
zpusobem jako jsme nastavovali polohu bod( u zakladniho tvaru kfivky dotvofime tvar

v této ose
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» Zménime parametr kfivky z uzaviené na otevieny.

_'m'indwtwlwml
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V manazeru Attributes (Nastaveni, pod Object Managerem, spravcem objektu) jsou v
pfipadé Ze mame v Object manageru zvolenu kfivku jako aktivni editovany objekt jeji
parametry. V téchto parametrech miZeme ménit vlastnosti kfivky a mezi jinymiito, zda
je oteviena Ci uzaviena (Close Spline). Zatrzené policko odznacte. Kfivka se rozpoji
mezi prvnim a poslednim bodem (pIné Zlutym a pIné ¢ervenym). Nejsou li tyto body v
ose rotace, tak vyberte bod v tomto stfedu a v menu vyvolaném pravym tlac¢itkem jsou
nastroje na zménu tohoto stavu. Tyto nastroje jsou Set First Point (nastavit prvy bod),
Reverse Sequence (otogit sekvenci kfivky, oto¢i pofadi bodu), Move Down Sequence
(posun sekvence doll, posune poradi bodl o jeden niZe, tedy je li bod druhy tak po
této operaci bude tfeti) a Move Up Sequence (totéz, ale obracené).

Vlozime do scény rotaci kfivky Lathe z menu na horni listé.

N F
=358

Do Object Manageru (spravci objektt) se nam vlozil objekt Lathe, pod kterym je objekt
nasi dfive vytvorené kfivky. Uchopime klikem levého tlagitka mysi kfivku a pfesuneme
jinad funkci Lathe. U kurzoru je Sipka, ktera se zméni nad objektem Lathe z vodorovné
na svislou. To znaci, Ze kdyZ nyni pustime objekt kfivky tak ten se zaradi hierarchicky
pod funkci Lathe. Pustime kurzor. Vznikl nam rotaéni objekt. Stisknutim klavesy F1 se
muZeme podivat jak nas objekt vypada v prostoru. Do pohledu ve kterém modelujeme
se vratime stiskem klavesy F4.
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» V manazeru Attributes (Nastaveni) zménime parametr druhu kfivky a vyzkousime
jak se bude kfivka chovat pfi zméné jejiho nastaveni a jak se bude chovat cely
rotacni objekt Lathe. Vybereme méd B-Spline.

Zménou tvaru kfivky probéhne i zména
tvaru celého rotaéniho objektu.

A vS§imnéme si, jak se zménil tvar rotaéniho objektu a také tvar vstupni kfivky. Zkusime
vS8echny parametry druhu kfivky a sledujme zmény. VSechny tyto druhy jsou shodné s
témi, které jsou v nabidce pfi tvorbé kfivky. Nyni v§e vratime do plGvodniho stavu, tedy
nastavime linearni druh kfivky.
» Vlozime do scény funkci HyperNURBS z horniho menu.
Objekt funkce HyperNURBS je prvnim

nastrojem v paleté, ze které jsme vlozili
do scény funkci Lathe.

Pod objekt HyperNURBS v Object manageru vloZime skupinku s rotaci Lathe a kfivkou.
Vznikne nam objekt, ktery neni nepodobny rotaci kfivky B-Spline. Jediny rozdil je ve
spojitosti kfivek v ose rotace. To je zpusobeno pravé funkci HyperNURBS. Poklikanim
na zelenou zatrhavaci znacku u funkce HyperNURBS tuto funkci prozatim vypneme.
Zelena znacka se zméni v Cerveny kfizek.
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» Budeme editovat parametry funkce Lathe. V Object manageru tuto funkci
oznacéime a v zalozce Attributes se objevi parametry, které Ize u této funkce
nastavovat.

Marbuten | tuctiv Tood | S Sngs |

4 Mode Ede UseDain

L) Lothe Object [Lathe NURBS] @8
Dbt Propestins

Lrgin 30
Subdnon 2x
Irogaem Subehvinion [£
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Movemert
Scaing [0%
I i Nl

Tato funkce ma dvé zasadni zalozky. A to Object (objekt) a Caps (uzavéry). V hlavni
zaloZzce mGzeme editovat nasledujici prametry: prvou poloZzkou je ,Isoparm Subdivisoin®
udavajici pocet izoparm pro zobrazeni, dilezitéjsi jsou v8ak polozky nasleduijici, ,Angle”
uhel rotace, ,Subdivisoin“ udava pocet svislych segment, které jsou vytvoreny rotaci,
~Movement“ udava posun otocky spirdly, tedy je li rovna tato polozka nule, tak jde o
Cisté rotacni objekt. Podobné funguje polozka ,Scaling” avSak jak nazev napovida, jde
o velikost. Posledni nabidkou je moZnost otocit normaly (toto se projevi az v pfevedeni
objektu do editovatelného). V zaloZzce Caps jsou nastaveny parametry uzavérd, coz
neni v nasem pfipadé aktualni.

» Vytvofime kopii nasi rotace, protoze cilem nasi prace bude nékolik ruznych

druhu sklenic, které vSak budou vychazet se stejné zakladni kfivky. Oznaéime v
Object manageru skupinku Funkce Lathe a se stisknutou klavesou Ctrl tahneme
nahoru manageru nad funkci HyperNURBS. U kurzoru je symbol +, jsme li nad
vSemi objekty, tak pustime tlacitko mysSi a na prvé pozici mame kopii rotace
Lathe.

“laehURES1 [ :.ri%
Splen v

U kazdého objektu v Object manageru je za nazvem objektu Seda dvojtecka. Poklikate
li na nékterou z tecek ze kterych se sklada, tak ta zméni barvu. Vrchni te¢ka znadi zda
je objekt viditelny pro modelaci, Cervena barva znamena Ze neni, zelena Ze je, i kdyz
je hierarchicky nadfazeny objekt skryty. Spodni te¢ka ovliviiuje podobné vlastnosti
objektu pro rendering. Skryjeme puvodni skupinu s HyperNURBSem.



72 MODELOVANI

CINEMA 4D TUTORIALY

Pro vytvoreni oblé kfivky v rezimu B-
Spline je nutny optimalni pocet a poloha
fidicich bodu této kFivky!

Vytvofili jsme model polygonalni
whisky sklenice pouhou zménou poétu
segmentu.

» Vytvorime finalni model prvé sklenice. V parametrech rotace Lathe zvolime pocet

segmentu Subdivision na 48 a tim vytvofime dojem dokonale hladkého objektu
avSak s ostrymi hranami v mistech kde jsou jednotlivé body Fidici kfivky. Tu v
rezimu linearni kfivky musime dotvofit.

Pravym tladitkem vyvoldme néastrojové menu a vybereme nastroj Knife (nz), kterym
muZeme ,fezat“ kfivku a tim na ni vytvofit dalsi fidici body. Tvar kfivky si kontrolujeme
pomoci pfepnuti parametru druhu kfivky (Linear do B-Spline), ale pro snaszi praci radéji
editujeme kfivku v reZimu Linear. Nastroj Knife pracuje tak Ze stiskneme tlacitko mySi na
zacatku mista fezu (pfed kfivkou), drzite tlaCitko az za misto konce Ffezu, kde jej teprve
pustime. Na vzorovém obrazku jsou u osy rotace dodany dva body, které maji stejnou
vysku (hodnota osy y) jako body v ose rotace. Tim jsme zamezili vzniku ostrého hrotu

v misté rotace. Po ukon&eni editace pfepneme druh kfivky z linearni na B-Spline.

Mame vytvoreny model prvé sklenice s kruhovym prufezem. Nyni zkopirujeme v
Object manageru tuto sklenici a zménime pocet segmentu Subdivision na 8.

Umistime nové vznikly model mimo model ptvodni sklenice a to pomoci Coordinates
manageru. Je libovolné na jaké misto jej umistime, staci jen zachovat hodnotu osy vy,
aby byla nova sklenice ve stejné vysce s puvodni. Pfepnutim modelacniho okna do
perspektivy si muZeme zkontrolovat pozici obou sklenic. (Pro tuto zménu pozice je nutné
stisknout nejdfive nastroj Use Model Tool aby bylo mozno hybat s celym objektem).
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Pripravime si objekt sklenice a poté jej
pfevedeme do editovatelného objektu.

Oznacime hrany abychom mohli nastavit
miru zaobleni hran.

» Nové vytvorena sklenice s polygonalnim prurezem je efektni, avSak k dosazeni

realného vzhledu ji chybi mirné zaobleni hran ve vrcholech prufezu. To
napravime za vyuziti funkce HyperNURBS. Zkopirujeme si model polygonalni
sklenice a umistime jej opét do puvodni pozice, do stfedu scény (soufadnice
0,0,0) a skryjeme sklenici s kruhovym prufezem.

7o G

Model si musime pfipravit pro pfevedeni do editovatelného objektu. Zménime druh
krivky zpét na linearni, a poté vybereme v Object manageru novou skupinku tvofenou
funkci Lathe a kfivkou. Stiskneme tlacitko Make Object Editable z vrchu levého menu.
Na&s objekt nyni neni fizen kfivkou, ale je tvofen soustavou polygon(.

Smazeme obsah skupinky HyperNURBS, ktery byl pouze demonstrativni a pod
HyperNURBS vlozime nové vznikly polygonovy objekt. Skupinku zaktivnime.
Pfepneme do Use Edge Tool (nastroj editace hran) a vybereme v§echny svislé
hrany na vnéjsi i vnitfni strané sklenice.

Oznadovanim mysi a sou¢asnym stiskem klavesy Shift vybereme svislé hrany, a hrany
spojujici svislé hrany na vrchu sklenice. Pro leh&i vybér vypneme docasné funkci
HyperNURBS. Vybereme li néjaké hrany navic, tak je z vybéru odstranime kliknutim
mys$i na danou hranu za sou¢asného stisknuti klavesy Ctrl.
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» Zapneme HyperNURBS, zvolime vybérovy nastroj a zvolime zalozku Active Tool
(aktivni nastroj), ve kterém nastavime zaobleni hran.

Mira zaobleni hran se nastavuje pomoci
dialogového okna HyperNURBS Weight.

Nastavime hodnotu na 85 % a stiskneme Set (nastaveni). Tim se vytvofi podobna
sklenice avSak s mirné zaoblenymi hranami jako jsme vytvofili prostou rotaci Lathe.
Tato nova sklenice méa v8ak podstatné realisti¢téjsi vzhled. MdZeme jesté vybrat spodni
obvodové hrany na zakladné sklenice a nastavit jejich zaobleni na 75%. Umistime

novou sklenici na jiné misto a zobrazime skryté sklenice.
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Souhrn

Naudili jsme se ovladat funkci Lathe a také jak vyuZit tuto funkci ve spojitosti s funkei
HyperNURBS. Jiz vime jak se chovaji kfivky a jaké maji médy a umime editovat polohu
jejich bodl. Kromé dal$iho jsme se naucili ovladat dal$i editacni nastroje.
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Obloha

V této kapitole se naucime pouZivat
technologie rozostreni a viastnosti
dlazdicového opakovani textury
pro vytvoreni pozadi obklopujiciho
nasi scenu.

Dobfe otexturovany objekt je kli€ovym parametrem vystupniho obrazku nasi scény a
presto je aspekt texturovani ¢asto prehlizen. Vhodna textura nam muZe usetfit mnoho
Casu straveného modelovanim. V této kapitole se nauc¢ime dvé véci. Za prvé se nau¢ime
otexturovat rizné objekty riznymi postupy a technologiemi. A také se néco nauc¢ime o
druhé ¢asti procesu texturovani, kterd je vice technicka - a sice o pfesném a detailnim
umistovani textur na nase modely. Pfi texturovani musime navic umét programu pfesné
fici, jakym zpusobem chceme nas$e textury umistit na plochy objektu, protoze vychozi
nastaveni byva zfidkakdy vhodnym FeSenim. Klasickym pfikladem je umisténi etikety
na valcovou plochu lahve, coZ se nau¢ime na konci této skupiny tutoriald.

Pro udrzeni dobré organizace nasi scény bychom méli dat nasim materialim
odpovidajici jména (jméno se da ku pfikladu vepsat v levém hornim rohu
dialogového okna editoru materidlu). KdyZz se nam zacne nase scéna rozristat,
tak bychom mezi stovkami jednotlivych materiald mohli snadno ztratit prehled . Méli
bychom si zvyknout pojmenovavat vSe vystiznymi nazvy, protoze si pozdéji snaze
vzpomeneme, co to vlastné je. Ku pfikladu tento material simdZeme pojmenovat jako
Sky (obloha), nebo Background (pozadi). Od této kapitoly nechame pojmenovani
materialt na vas samotnych. DalSi rady ohledné pojmenovavani materiald se nalézaji
v relevantnim tutorialu patficim do zékladnich tutorial(, které byly uvedeny dfive.
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» Nahrajeme si scénu pojmenovanou ,Party Before.c4d‘ z adresare Texturing
- Basic, ktery je v adresafi CINEMA 4D/Tutorials.

DOpen File

Look jr: I 5 Texturing - Basic

| e ®EeE-

tex
@ Party After.c4d
Party Before,c4d
Party. jpg

V této scéné nalezneme vSechny objekty potifebné pro praci ve vSech tutoridlech
tykajicich se zakladu texturovani. Nejdfive otexturujeme oblohu (nebo background
(pozadi) pro celou scénu). Pro tento kol pouZijeme vhodny obrazek, na ktery aplikujeme
rozostreni, &imz vznikne dojem rozostfeného pozadi.

V Material manageru zvolime File (Soubor) > New (Novy) Material. Editor

materialu otevieme poklepanim na nahled materialu v Material Manageru.

Klepneme na tlacitko Image... a pouzijeme dialog pro otevieni souboru s nazvem

~party.tif“ z adresare ,,tex“, ktery se nachazi adresari Texturing - Basic.

Obrazek se zobrazi na pravé strané editoru matrialu a jeho 3D nahled je vlevo.

O (Offset, odsazeni pfi rozostieni) na 20%.

/4

|7 Color

[ Diffusion

I_ Luminance
I_ Tranzparency
I_ Fieflection
I_ Enwvironment
[ Foa

E Bump

R 3 EE3E
G M EE3E |
B f1o0x 3
Brightness | 0% 3

5 d

- Texture

Mlpart}l.tif j' ’ -
Sampling (54T =] 020z 3sfox 3 . r
_Edt..| B00:800x24

V editoru materialu nastavime hodnotu Sampling (Interpolace) na SAT a hodnotu

Interpolace se pouziva v pfipadech, kdy nami zvoleny obrazek nema stejné rozliSeni
jako vysledny obrazek pfi renderingu. SAT je typem interpolace, ktery se pouzivan pro
rendering textur pfi vysoké kvalité.

Rozostreni textury provedené pomoci hodnoty Offset doda scéné dojem, Ze kamera neni
zaostfena na tuto ¢ast obrazku. Technickym nazvem pro rozostfeni objektu v pozadi
(a také nékdy v popfedi) je termin Depth of Field (hloubka pole), neboli zkratka DOF.
Ackoliv m& CINEMA 4D specialni funkci DOF, tak v fadé pfipadu je efektivnéjsi pouZit
manualni rozostieni textury, ktera je uréena na background (pozadi) scény.
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Vlevo: textura tvofi viditelné

hranice jednotlivych dlazdic.

Vpravo: hranice jsou redukovany

zapnutim moznosti Seamless.

» Uchopime material v Material manageru a tahneme jej nad objekt Sky v Object
manageru, kde jej na tento objekt umistime.

Obrazek je nyni viditelny ve zobrazovacim okné (viewportu) a v Attributes manageru jsou
zobrazeny parametry, které definuji zpusob promitani textury na objekt Sky (oblohu).

» V Attributes manageru se ujistime, ze je aktivni zalozka Tag a nastavime hodnotu
Tiles X (dlazdice X) na 2.

Nyni se obrazek na pozadi opakuje pouze horizontalng, je v8ak zfejmé, Ze Spatné
navazuje. MiZeme se na tento efekt podivat ve viewportu (zobrazovacim okné).

» V zalozce Tag v Attributes manageru zapneme moznost Seamless (bezesva,
zrcadlové navazovani).

Dlazdicové tvofena textura miZe mit za nésledek vytvoreni viditelnych hranic mezi
jednotlivymi dlazdicemi. Volba Seamless nam pomaha se tohoto problému vyvarovat
diky zrcadleni kazdé textury misto jednoduchého umistovani jednoho obrazku vedle
druhého.

Souhrn

Naudili jsme se vytvofit material a aplikovat na néj obrazek coby texturu. Pak jsme se
naucili pfidat materialu néjaky efekt a nakonec jsme se dozvédéli néco o dlazdicovém
navazovani a o vicenasobném rozmisténi naseho materidlu na vétsi objekty bez
nezadoucich efektd.



82 ZAKLADNI TEXTUROVAN/ CINEMA 4D TUTORIALY

Podlaha

Pri definovani matriglu uréeného
pro podladu budeme muset
pouZit dalsi parametry, abychom
napfiklad mohli vidét obrazy
objektu, které jsou na ni umistény.

Mnoho ploch odrazi svétlo stejné dobre, jako jej pohlcuje. Diky tomu mizeme spatfit
napfiklad odraz nasi nohy ve dvitkach trouby z antikorozni oceli nebo obraz vazy na
sklenéném stole. Pfi tvorbé realisticky vypadajicich materialt budeme potfebovat také
prihlednost, kterd je vlastni mnoha materialim. Tento efekt muzeme pouzit také k
prolnuti jednotlivych povrchu. K tomu se pouZziva tzv. alfa kandl, coz je jedna z vlastnosti
materialu v Cinemé 4D, pomoci které miZeme maskovat riizné ¢asti objektu nebo scény.
Pro definovani pozvolného pfechodu do prihledna pouzijeme nahrany obrazek do alfa
kanalu, jednoho z parametrt materialu uréeného pro podlahu.

» Jestlize jiz nemame scénu otevienou, tak si nahrajeme scénu nazvanou ,Party
Before.c4d‘ z adresare Texturing - Basic umisténého v adresafi CINEMA 4D
Tutorials.

» V Material manageru zvolime New Material (Novy material) z menu File (Soubor)
a poklepeme na nahled nové vzniklého materialu abychom otevreli editor
materialu.

» V polozce Color (barva), nastavime jezdce RGB barevného rezimu na hodnoty
R=80%, G=90%, a B=100% a hodnotu Brightness=60% (jas).
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» Klepneme na zatrhavaci pole u polozky Reflection (Odrazivost) a zapneme
vlastnost odrazivosti u tohoto materialu. Zobrazi se stranka s parametry
odrazivosti, kde nastavime jezdce RGB na tmavé modrou (R=85%, G = 90%, B
= 100%, Brightness = 20%).

Toto doda podlaze tu spravnou miru malé odrazivosti a ten spravny jas plastového
povrchu; cokoliv se bude odrazet na podlaze bude zabarveno mirné do modra.
Alternativou je, Ze ponechame kazdého jezdce RGB na hodnoté 100% a pak se
budou vSechny objekty odrazet v barvé, kterd je jim vlastni. To uz ale také mizeme
rovnou nastavit barvu odrazivosti na jinak modrém povrchu pomoci jezdci RGB na
Cervenou. Ackoliv se toho miiZe v redlném svété pouze obtizné dosahnout (ale vSe
je mozné), tak je tato technologie vyznamnou pro tvorbu vS§ech moznych vizualnich
efektl a zajimavych povrchu.

» Klepneme na zatrhavaci pole u polozky Alpha (alfa kanal) a tim pfifadime

tuto vlastnost naSemu materialu. Nasledné se objevi stranka s adekvatnimi
parametry.

Uzitim alfa kanalu v materialu mGzeme docilit pozvolného pfechodu &i ostrého fezu ¢asti
povrchu objektu. Tyto ¢asti budou pak vyrendrovany jako nepatrné ¢i zcela prahledné.
(poznamka: tato technologie neni stejna jaka se pouziva pro tvorbu priihlednosti objektu
pomoci kanalu Transparency (prihlednost)).

» Klepneme na tla¢itko Image... a otevie se dialogové okno, ve kterém vybereme

soubor ,floor-alpha.jpg‘ z adresare tex, umisténého v adresafi Texturing -
Basic.

V tomto obrazku je erna kruhova plocha s postupnym pfechodem do bilého pozadi na
okraji. Bude nam definovat, ktera ¢ast plochy bude neprahledna a ktera prihledna.

» Zatrhneme moznost Invert a ,,oto¢ime“ pusobeni obrazku.
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SIE ooz 2
/ da — || 0% 3
4
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| Diffusion db— ] 0% ﬂ
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| Trangparency | - Texture
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[ Fog Sampling [MIP =[O0z Hsfox 3
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v [&Iph, Edi...
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Texturu muzeme pouzit pro
kontrolu pruhlednosti materialu
tak, ze jednu barvu definujeme
jako pruhlednou nebo pomoci
nastavené hodnoty brightness.
Vypneme hodnotu Soft (mékky)
u charakteristiky ofezu

podle obrazku a Klepneme

do plochy nahledu materialu
do éasti, kterou chceme
ofiznout. Alternativnou je, ze
ponechame zapnutou hodnotu
Soft a vyuzijeme vlastni alfa
kanal obrazku ktery jsme
nacetli do alfa kanalu v editoru
materialu. Tento alfa kanal se
potom zobrazi v nahledu misto
samotného obrazku.

Objekt podlahy nyni ma mékké
okraje, které se ztraci do pozadi.

Pfi pouZiti obrazku pro definovani alfa kanalu se absolutné ¢erna barva interpretuje
jako zcela pruhledné oblast, zatimco bilé ¢asti se interpretuji jako zcela neprihledné. U
tohoto obrazku (¢erna ve stfedu a bila na okrajich), jsme to vSak potfebovali obracené

a proto pouzijeme funkci Invert, ktera provede inverzi obrazku (pfeklopeni barev).

Vypneme kanal Specular (Odlesk) klepnutim na pfislusné zathavaci pole vievo
od napisu.

Chceme se vyhnout velkému odlesku svétel na podlaze, ktery by ji dodal pfili§ velky
jas, coz neni nutné.

Mysi uchopime material v Material manageru a pretahneme jej nad objekt Floor
Disc (podlaha, objekt kruh) v Object manageru, kde jej pustime.

V tomto pfipadé nepotfebujeme upravit projekci ani navazovani materialu umisténého na
objekt. Objekt podlahy je tvofen parametrickym objektem Disc (kruh), ktery je definovan
matematicky (je to primitivni objekt) a ma nastaveny systém projekce materialu na Flat
(plosny), coz je nastésti tentyz, ktery sami pravé chceme.

Zvolime Render > Render View abychom se podivali na test renderu nasi
scény.

Souhrn

V této sekci jsme se naudili zaklady pouzivani odrazivosti, priihlednosti a také jsem se
dozvédéli néco malo o alfa kanalu. PouZili jsme tyto znalosti pro tvorbu lesklé podlahy
postupné splyvajici s pozadim. O dalSich parametrech se toho vice nau¢ime pozdéiji.
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Lahev

Sklenéné objekty maji své viastni
charakteristiky, které muZe byt
docela ndro¢né napodobit.

>

Hlavni charakteristikou vétSiny sklenénych materiald je to, Ze je mozné se skrze né
vidét. Jsou vétsi ¢i mensi mérou pruhledné. Sklo také odrazi ostatni pobliz stojici
objekty. Kromé toho svétlo prostupujici sklem z jedné strany na druhou méni smér,
coz je zpusobeno tvarem objektu. Tento jev se nazyvéa lom svétla. A v neposledni fadé
muZeme Cas od ¢asu zahlédnout intenzivni odrazy svétel, zndmé jako ,zrcatka“, na
vnéjsim povrchu skla, coZ jsou malé koncentrované plochy svétla.

Pro nasi lahev vytvofime prahledny zeleny materidl, ktery bude odrazivy a ktery také
bude lamat svétlo. Také pfidame néjaky ten efekt ,zrcatek”.

Jestlize jesté nemame scénu otevienou, tak si nahrajeme scénu nazvanou
,Party Before.c4d‘ z adresare Texturing - Basic umisténého v adresafi CINEMA
4D Tutorials.

V Material manageru zvolime New Material (Novy material) z menu File (Soubor).
Poklepeme na nahled vzniklého materialu a otevieme editor matrialu.

Vypneme kanal Color (barva) odtrzenim zatrhavaciho pole vievo od napisu
Color.

Barva tohoto materialu bude definovana prahlednosti a barvou odrazivosti, pouziti
nastaveni barvy v kanalu Color by dodalo objektu jen na nepfirozenosti.
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» Klepneme na zatrhavaci pole vlastnosti Transparency (pruhlednost), tim si tuto
hodnotu zpfFistupnime a zobrazi se nam stranka, kde tuto vlastnost muzeme
blize definovat.

» Nastavime jezdce RGB tak, abychom vytvofili zelenou barvu lahve (R=30%,
G=100%, B=50%, Brightness=70%).

» Do pole lomu svétla (Refraction) nastavime hodnotu na 1,5. (Hodnota indexu
lomu svétla bude vyznamna pozdéji).

Refraction

n |1 5 H
[ Fresnel
[ Additive

3D nahled materialu okamzité zobrazi zménu lomu svétla. Material skla nyni zkresluje
vSe co vidime za nim, pravé tak, jak to déla sklo ve skute¢ném svété. Seznam indexu
lomU svétla u béZnych materiald najdete napfiklad v referenénim manudlu k programu
CINEMA 4D.

» Zapneme moznost Fresnel.

Sledujme v nahledu materidlu zménu, kterou zpusobi tento efekt. Fresnel simuluje
efekt, ktery mdZeme vidét na skutec¢nych sklenénych objektech, ale i na vodni plose
a ostatnich pruhlednych materidlech. Vezmeme si ku pfikladu okno. JestliZze stojime
pfimo proti oknu, tak pfes néj vidime vSe bez deformaci a zmén. Jestlize bychom se
ale divali pod ostrym uhlem, tak sotva uvidime skrz diky tomu, Ze budeme vidét spiSe
odraz prostiedi na ,nasi“ strané. Tento jev se nazyva Fresnellv efekt a CINEMA 4D
jej umi simulovat.

» Zapneme moznost Reflection (Odraz) zatrzenim prislusného pole a otevie se
nam stranka pro definovani vlastnosti tohoto efektu.

» Nastavime hodnoty RGB posuvniku na tmavé zelenou (R=40%, G=100%, B =
45%, Brightness = 30%).

To doda sklu trochu odrazivosti, praveé tolik, aby to nebylo pfilis.
» Zapneme moznost Specular (Odlesk) kliknutim na zatrhavaci pole.

Tato zalozka kontroluje odlesk na materialu, coz jsou velmi jasné odrazy svétel
umisténych ve scéné.
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» Nastavime hodnoty Width (Sifka) na 60%, Height (vySka) na 75%, Falloff (abytek)
na -25% a Inner Width (vnitini Sifka) na 25%.

b Ibottle

Material pro lahev je zelené sklo
s intenzivnim odleskem.

7.

I_ Color

[ Diffusion Mode IPIastic LI
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¥ Transparency wiidth B 60% J
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I_ Enwironment

[~ Fog Falloff 5 5% 3

]
F s Inner width | R

Toto nastaveni doda materidlu silny intenzivni odlesk s ostrou hranou, takovy, jaky se
vyskytuje u skute¢ného skla.

» Uchopime material skla v Material manageru a aplikujeme jej na objekt Bottle
(lahev) v Object manageru.

Souhrn

Vytvofili jsme zajimavy material - sklo. Dodali jsme nasemu zakladnimu vstupnimu
materialu prihlednost, odrazivost a odlesk. Zjistili jsme, jak ¢asto se musi u texturovani
kombinovat jednotlivé vlastnosti.
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Balonky

Jednou z charakteristik balonkd je
to, Ze jsou z gumy - coZ je vyzva
pro nas.

Gumové materidly vypadaji vétSinou zaroven jako lesklé i matné (zalezi na aktualnim
materiélu). A vSechny maji obvykle odlesky.

My dodame povrchim balénk( mirnou prihlednost, odrazivost a ,gumovitost“. Jeden
z balénku bude Zluty a druhy r(iZovy. Po vytvoreni prvého materialu vytvorime jeho kopii
a tuto kopii rad&ji upravime, nez abychom vytvareli druhy materiél cely znova.

» Jestlize jeSté nemame scénu otevienou, tak si nahrajeme scénu nazvanou
,Party Before.c4d z adresare Texturing - Basic umisténého v adresari CINEMA
4D Tutorials.

» V Material manageru zvolime New Material (novy material) z menu File (Soubor).
Poklepeme na nahled vzniklého materialu a otevieme editor matrialu.

» Zménime barvu materialu pomoci posuvniki na zluto oranzovou (R=100%,
G=75%, B = 30%, Brightness = 100% (jas)).

Balének bude zesvétlovan diky osvétleni ve scéng, proto neni potieba vytvaret prespfilis
svétlou barvu.
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» Klepnutim na zatrhavaci pole u vlastnosti Transparency (pruhlednost) tuto
vlastnost zapneme a otevie se nam stranka, kde muzeme editovat prislusné
parametry.

» Nastavime refraction index (index lomu svétla) v pravém hornim rohu stranky
na 1.1

Povrch balénku nyni jen velmi mirné lomi svétlo, protoZe jsme pouzili maly index lomu
svétla.

» Klepneme na malou Sipku napravo od pole kam se vklada adresa obrazku a
otevieme menu se shadery.

» Zvolime bhodiNUT Channel (kanal) > bhodiNUT Fresnel.

» Klepneme na tlacitko Edit... a otevie se nam dialogové okno shaderu.

Pouzitim shaderu Fresnel @ Smells Like Almonds
budeme kontrolovat miru

pruhlednosti na okrajich a
stfedu plochy balonku.

% o < ¥ Uz Bump Render: IFront & Back LI
|7 Sphere LI Interpolation: IEubic Kot LI Position: |D°/° j

[ i S

Tento shader je soucasti baliku shadert bhodiNUT od firmy Smells Like Almonds,
ktery je detailngji popisovan v tutorialech patficich do skupiny pokrocilého texturovani
bhodiNUT shadery. Shader bhodiNUT pracuje praveé tak jako vlastnost Fresnel, kterou
nalezneme na strance Transparency (prihlednost) v editoru materialu, avéak umoZriuje
nam kontrolovat tuto vlastnost pomoci pfechodu. To je v nasem pfipadé vyhodné,
protoZe chceme, aby naSe balonky byly po okrajich neprdhledné a uprostfed pouze
¢astecné prahledné.
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» Pod prouzkem s prechodem poklepeme levym tlac¢itkem na barevnou tchopku

(bilou) a otevieme okno pro nastaveni barvy. Zménime barvu na ¢ernou a okno
zavieme.

NN
7 T |

F

Odstranime stfedni barevnou (Sedou) uchopku (také se jim fika knot) tim, ze
na ni klepneme a tdhneme mimo prouzek s prechodem.

Poklepeme na pravou tichopku a znovu tim otevieme okno s nastavenim barvy.
Nastavime barvu na svétle zlutou (R = 255/ 100%, G=232/90%, B=151/60%) a
poté okno zavieme.

MISTIME U s Daurs T

Positiar: |1DD % 3

a

Nyni je balének uprostfed prahledny. Barva prihlednosti je Zluta a tak vSe co uvidime
skrz balének bude mit Zluty odstin.

Stiskneme tlacitko OK a zavieme dialogové okno shaderu.

Nyni zapneme vlastnost Reflection (odrazivost) a nastavime posuvniky na tmavé
Zlutou (R=100%, G = 82%, B = 62%, Brightness=30%).

Tim jsme vytvofili materialu pravé takovou odrazivost, jakou maji balénky ve skute€ném
svéte.



CINEMA 4D TUTORIALY

ZAKLADNI TEXTUROVANI 91

» Klepnutim na slovo Specular (odlesk) otevieme stranku pro editaci této

vlastnosti.

Nastavime hodnoty odlesku Width (Sitka) na 100%, Height (vyska) na 70% a
Falloff (Ubytek) na -22%.

* Iballoon

7.

|7 Color

[ Diffusion Mode IPIastic LI

I_ Luminance . —

|7 Transparency wiidth J 100 % J

|7 Heflgction Height Jl 0% ﬂ

I_ Enwironment

[~ Fog Falloff I 2% 3
B

F o Inner width | 0% 3

To dodé povrchu Siroky odlesk s mékkym ubytkem.

Vytvorime kopii tohoto materialu (v Material manageru, Klepneme na material
balénku a poté zvolime Edit > Copy (kopirovat) a pak Edit > Paste(vlozit)).

MuZeme také misto toho pouZit klavesovou zkratku pro kopii a vlozZeni.
Poklepeme na nahled zkopirovaného materialu a otevieme si editor materialu.

Na strance Color (barva) zménime barvu na ruzovou (R=100%, G = 50%, B =
60%, Brightness = 100%).

PFemistime svou pozornost na stranku Transparency (pruhlednost). Klepnutim
na tlacitko Edit... otevieme dialogové okno shaderu Fresnel.

Poklepanim na pravou tichopku otevieme okno pro nastaveni barvy a nastavime
barvu na svétle ruzovou (R = 255/100%, G =168/66%, B = 168/66%). Zavieme
okno barvy a také dialogové okno shaderu.

Dalsi vlastnosti ménénou je Reflection (odrazivost), kde nastavime posuvniky
na tmavé ruzovou (R=100%, G = 50%, B=60%, Brightness = 30%).

Nyni mame pro balénky Zluty a rGZovy material.

Uchopime jeden z materiala v Material manageru a v Object manageru jej
aplikujeme na jeden z balénku.

Poté stejnym zpusobem aplikujeme i druhy material.
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» Zkusime si vyrenderovat scénu zvolenim funkce Render > Render View
(Renderovat pohled) z hlavniho menu.

Je uzite¢né si zkusit
vyrenderovat pohled, abychom
méli jistotu, Ze vSe probéhlo
podle ocekavani.

VétSina prace tykajici se texturovani této scény je jiz dokonéena. Nyni ndm zbyva vytvorit
jednoduchy material na korek, papirovou hvézdu na podlahu a etiketu na lahev.

Souhrn

Naudili jsem se pouZzivat bhodiNUT Fresnel shader pro vytvoreni postupné prihlednosti
(balonky jsou vice priihledné ve svém stfedu). Také jsme se dozvédéli, jak se kopiruje
a vklada material, abychom mohli snadno vytvofit dvé varianty materialt pro balénky
v nasi scéné.
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Korek

Tak tohle bude docela snadné,

pohrajeme si trochu s hrbolatosty ...

>

Korek (ted nemluvime o téch novych plastovych Spuntech) ma velmi hrbolaty povrch,
ktery jako by se skladal z tmavSich a svétlejSich oblasti. Pro vytvofeni tohoto efektu
pouzijeme ¢ernobilou texturu jako tzv. bump mapu (mapu hrbolatosti) a diky osvétleni
vzniknou na povrchu tmavé a svétlé plochy. To vSe diky jediné texture davajici povrchu
tento samoziejmy zevnéjsek.

Pro vytvoreni korkového materialu potfebujeme pouze dva obrazky, jeden do kanalu
barvy a druhy do kanalu hrbolatosti (bump), ktery vytvofi realisticky povrch.

Jestlize jeSté nemame scénu otevienou, tak si nahrajeme scénu nazvanou
,Party Before.c4d‘ z adresare Texturing - Basic umisténého v adresafi CINEMA
4D Tutorials.

V Material manageru zvolime New Material (novy material) z menu File (Soubor).
Poklepeme na nahled vzniklého materialu a otevieme editor matrialu.

Na strance Color (barva) klepneme na tlaéitko Image... a pomoci dialogového
okna otevieme soubor cork.jpg, ktery je v adresafri tex, jenz je v adresafri
Texturing - Basic.

Zapneme moznost Bump (hrbolatost) klepnutim na zatrhavaci pole.
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» Na strance Bump stiskneme tlacitko Image... a pomoci dialogového okna
otevieme obrazek nazvany cork-bump.jpg, ktery je v adresafi tex, jenz se
nachazi v adresafri Texturing - Basic.

» Nastavime hodnotu jezdce na 100%.

Kanal Bump simuluje nerovnost povrchu. Ve vyrenderovaném obrazku budou vypadat
plochy ovlivnéné svétlymi oblastmi obrazku jako by vystupovaly a ty ¢asti, které budou
ovlivnéné tmavymi plochami, budou vypadat jako by se propadaly.

» Klinutim na zatrhavaci pole vypneme moznost Specular (odlesk).

I Bumj
Material korku vyuziva bump i B —
mapu pro simulovani nerovného Strength {100z J
povrchu.
Texture

Image... ”cork-bump.ipg j
A Sampling [MIP w|0f0x 3 sfox 3

[ Calor Edit.. | MIP Fallaf

[ Diffusion —I o :

[ Luminance 5124512424
I_ Tranzparency

I_ Fieflection

I_ Enwvironment

[~ Foa

|7 Bump

» Mysi pfeneseme material z Material manageru nad objekt Cork v Object manageru
a poté jej na néj aplikujeme.

» V Attributes manageru nastavime zpusob projekce textury na Cylindrical
(valcovy).
V Attributes manageru jsou nyni zobrazeny parametry projekce materialu pouzitého
na korek. Tento korek Iépe vypada s valcovou projekci nez se sférickou a proto jsme
ji pouzili.

» Ujistime se, ze v Object manageru mame vybranou ikonu materialu a poté

vybereme nastroj Texture (editace textury) z levé palety nastroju, ¢imz se nam
zobrazi textura ve viewportu s referen¢ni mfizkou.

Pouzitim tohoto nastroje
muzeme vidét a kontrolovat E

projekci textury na objektu.
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» Ujistime se, ze v Object manageru mame stale vybrany tag materialu a z menu
Texture zvolime Fit to Object (pfizpusobit objektu).

Vlevo pred aplikaci a vpravo po
aplikaci pfizpusobeni objektu.

Modra mfizka reprezentujici texturu je pfilis velka a je potreba ji upravit, presnéji fe¢eno
zmenS§it. Pfikaz Fit to Object to provede automaticky.

Souhrn

V tomto tutoridlu jsme se naugili pracovat s bump mapami, tedy ¢esky fe¢eno o
hrbolatosti. Je to vlastnost materialu, ktera nam umoznuje simulovat hloubku v objektu
pouzitim 2D textury. Také jsme se dozvédéli jak automaticky adaptovat velkou texturu
na mensi objekt.
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Papirova hvezda
Pridame na podlahu detail,
poloZime na ni ostfihany papir.

>

Jiz jsme dfive pouzili alfa kanal na objektu podlahy pro vytvoreni plynulého pfechodu ,,do
ztracena", ale nyni pouzijeme tuto techniku pro vyfiznuti tvaru na jiz existujimim objektu.
Abychom scénu ozvlastnili, tak do ni na podlahu pod lahev pfidame papirovou hvézdu.
Vse, co pro to potfebujeme, je bily material a textrura v alfa kanalu ve tvaru hvézdy.

Jestlize je$té nemame scénu otevienou, tak si nahrajeme scénu nazvanou
,Party Before.c4d‘ z adresare Texturing - Basic umisténého v adresafi CINEMA
4D Tutorials.

V Material manageru zvolime New Material z menu File. Poklepeme na nahled
vzniklého materialu a otevieme editor matrialu.

Na strance Color nastavime posuvnik Brightness (jas) na 100% a tim vytvofime
bilou barvu materialu.

Kliknutim na zatrhavaci pole u polozky Specular (odlesk) tuto polozku
vypneme.

Papir normalné zadny odlesk nema a proto tuto moznost vypneme.

Klepneme na zatrhavaci pole polozky Alpha, ¢imz zapneme alfa kanal a zobrazi
se nam stranka s jeho parametry.
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U objektu Floor v Object
manageru jsou nyni dvé ikony
(tagy) materialu.

MFizka predstavujici projkeci
textury neni nastavena vhodné
a tak musi byt jeji pozice
upravena.

>

v

v

Klepneme na tlaéitko Image... a pomoci dialogového okna nahrajeme soubor
pojmenovany star.jpg z adresare tex, ktery je v adresari Texturing - Basic.

Tento soubor je obrazek jednoduché dernobilé hvézdy. Cerna ¢ast obrazku vymezuje
ofiznutou oblast (prihlednou) alfa kanalu, pficemz nam zlstane bila hvézda.

Uchopime mysSi material hvézdy v Material manageru a umistime jej v Object
manageru na objekt Floor (podlaha).

}»floor disc: . :\(‘ 00 “

Nyni jsou na podlaze aplikovany dva materialy, modry odrazivy a na ném papirova
hvézda. Umisténi tagu materialu v Objekt manageru udava, ktery material bude
renderovan jako vrchni a to v pofadi zleva (materidly nize) doprava (materialy umisténé
vyse). Materidly s alfa kanalem (s prihlednymi plochami) byvaji obvykle umistény na
pravé strané.

V Attributes manageru nastavime zpusob projekce na Flat (plosny).

NemuZeme pouzit vychozi nastaveni UVW mapovani, protoZe to by rozprostielo hvézdu
pres celou plochu kruhu, ktery tvofi objekt podlahy. Toto nastaveni by bylo v pofadku
pro modry zakladni material, ale pro papirovou hvézdu musime zménit projekci na Flat
(ploSnou) tak, abychom mohli manualné upravit velikost a pozici textury.

Ujistime se, ze v Object manageru mame vybrany tag materalu bilé hvézdy.

Ujistime se, Ze mame v levé li§té nastroju zvoleny nastroj Texture Axis (osy
textury).

Ve viewportu (zobrazovacim okné) mizeme vidét, Ze referenéni mrizka textury je
umisténa kolmo k podlaze a nikoliv tak, Ze by na ni lezela.

Ve vrchni nastrojové listé zvolime nastroj Rotate (rotace), poté klepneme ve
viewportu (zobrazovacim okné) na éervenou osu a tahneme mysi, pficemz
sledujeme ménici se hodnoty v Coordinates manageru (spravci soufadnic).
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» Pustime tlac¢itko mysi jakmile hodnota rotace P v Coordinates manageru dosahne
90 stupnu.

Jak jsme vidéli, muzeme
upravovat pozici, rotaci a
velikost textury v Coordinate
Manageru.

WF MAAEPDH 1) | 020 | [ FERAP
I o ot | Acive Tool|

| % Position Scale Fiatation
Hm 2 x[oom ELIE E|
v om 2 [toom ElZEE []
L Zfom zz[oom EL:A R ]
= IDbiect LI ISize LI Apply |

Alternativou k tomu, abychom pracné nastavovali hodnotu 90° ruéné pomalym
pootacenim osy textury, je nastavit tuto hodnotu pfimo do pfislusného okna Coordinates
manageru.

» Taktéz v Coordinates manageru nastavime hodnotu Scale pro v§echny tfi sméry
na 165.

VétSi hodnota Scale nam zvétsi hvézdu.

» V Attributes manageru, na strance Properties (vlastnosti) vypneme vilastnost
Tile (dlazdice).

| Basic | Tag |E00rdinates|

Moznost Tile (dlazdice) v
Attributes manageru umoznuje Tag Properties

vypinat a zapinat dlazdéni textur. Matenal g R S j
Selection
Projection [Flat =l
Side Bath =]
Offseti |0 % =]
Offzety |0 % =]
Lengthi< [100% 3l
Lengthy [100% 3l
Tiesx |1 =
Tilesy |1 =
I_ Mix Textures
[ Tile
I_ Seamless

Texturu hvézdy nechceme opakovat mimo plochu podlahy a tak vypneme moZnost
Tile.
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Souhrn

Pouzili jsme alfa kanal pro vytvoreni vystfizené papirové hvézdy na podlaze. Také jsme
se naucili ménit umisténi, rotaci a méfitko materialu.
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Etiketa

Ceka nds posledni drobnost,
vytvofime na nasr ldhev atraktivni
etiketu.

e

Texturovani nasi scény dokon¢ime vytvorenim etikety na lahev a nastavenim valcové
projekce okolo lahve. Nau¢ime se manualné ménit velikost a pozici etikety podle toho,
kam ji budeme chtit umistit.

> Jestlize jeSté nemame scénu otevienou, tak si nahrajeme scénu nazvanou
,Party Before.c4d z adresare Texturing - Basic umisténého v adresafi CINEMA
4D Tutorials.

» V Material manageru zvolime New Material z menu File. Poklepeme na nahled
vzniklého materialu a otevieme editor matrialu.

» Na strance Color stiskneme tla¢itko Image... a pomoci dialogového okna
nahrajeme soubor c4d-logo.tif z adresare tex umisténého v adresari Texturing
- Basic.

Tim do kanalu barvy nahrajeme texturu etikety.

» Uchopime material etikety v Material manageru a tazenim jej umistime na objekt
Bottle (lahev) v Object manageru.

» V Attributes manageru nastavime zpusob projekce na Cylindrical (valcovy).

Vychozi zpUsob projekce je pro texturu etikety nepouzitelny a tak jej zménime na valcovy,
ktery bude mozné snadno upravit.
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Pomocr valcové projekce
na ldahev “nalepime” viastni
etiketu.

» Ujistime se, ze v Object manageru mame vybrany tag materialu etikety a poté

zvolime Texture (textura) > Fit to Object (pFizpusobit objektu). Na otazku ,,Do
you want sub-objects to be included?”, tedy zda chceme zahrnout pod-objekt
odpovime ne, tedy ,,no*.

Tato funkce upravi velikost textury podle velikosti lahve. Dialogovym oknem jsme byl
dotazani, zda chceme do pfizpusobeni objektu zahrnout pod-objekty. To je v poradku,
ale lahev je tvorena objektem Lathe NURBS (rotace kfivky) a jejim pod-objektem je
pouze kfivka a tak to neni nezbytné.

Ujistime se, Ze je stale zvolen nastroj Texture (editace textur) v levé nastrojové

listé a pak zvolime nastroj Scale (méfitko) z vrchni listy.

Ve viewportu (zobrazovacim okné) uchopime zelenou osu objektu a zmensime
velikost etikety tak, aby logo jiz nadale nevypadalo zdeformované.

V Attributes manageru vypneme moznost Tile (dlazdice) na zalozce Properties
(vlastnosti).

Ve vrchni nastrojové listé zvolime nastroj Move (Pfesun), uchopime zelenou

osu a popotahneme referencéni mfizku textury etikety trochu dolu, tak jak je to

na nize uvedeném obrazku.
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» Z hlavniho menu zvolime Render > Render to Picture Viewer (renderovat do
prohlizeée) a vyrenderujeme obrazek scény v plném rozliSeni.

Scéna je hotova, je ¢as na

malou party!
IR THE REAL Wi

L/

[/
(l

Souhrn

Nyni jiz rozumime tomu, Ze texturovani neni pravé jen véci vybéru obrazku a jeho
umisténi na plochu objektu. V problematice texturovani objekt( se naléza mnoho
aspekt(, o kterych jsme dfive ani neuvaZzovali. Napfiklad bez Upravy miry odrazivosti
¢i hrbolatosti plochy miZzeme kompletné znicit iluzi, Ze to co sledujeme, je skute¢ny
film ¢i fotografie a ne pocitacem vytvofena scéna.

Samoziejmé nemusime mit vzdy v imyslu vytvaret fotorealistické obrazky, to preci
zélezi na kazdém z nas. Nicméné pred zacatkem prace na nasem projektu bychom
meéli védét do nejmensich detaill, jak by mél vypadat nas finalni obrazek. Je nutné si
naptiklad dukladné promyslet jak zrnity bude povrch vybraného objektu, protoZe tim
mu mGzeme dodat na realité nebo naopak muZe vypadat jako nakresleny.
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Shadery bhodiNUT
Pouzivani vestavénych shadert
bhodiNUT, zndmych také jako
Smells Like Almonds, muZeme
vytvofit mnoZstvi drive nevidanych
podivuhodnych proceduralnich
materidld.

Materiél je v Cinemé 4D tvoren kombinaci fady parametru, které uréuji jeho vzhled a
fyzikalni vlastnosti - napf. barvou, lesklosti, odrazivosti, hrbolatosti, prihlednosti apod.
Tyto parametry se oznacuji jako “kanaly” (channels) a jejich obsahem mohou byt také
bitmapové obrazky a/nebo shadery.

Slovo textura je obecné spojovano s 2D bitmapovymi obrazky - typicky ve formatu JPG
nebo TIFF, které vzniknou naskenovanim néjaké predlohy nebo tviréim procesem pfi
praci v grafickém editoru. VSechny bitmapové obrazky maji ale omezenou velikost
neboli rozlieni. TakZe pokud si pfipravite texturu o rozliSeni 320x240 bodu a aplikujete
ji na pokryti objektu podlahy, kterd& ma velikost 1024x768 bod(, dojde automaticky
k “roztaZeni” textury na celou plochu objektu. Vysledny vzhled bude naprosto
nepresvédgCivy, protoZe textura se roztahne a rozmaze.

Naproti tomu jsou shadery na rozliSeni naprosto nezavislé. Je to zpusobeno tim, Ze jsou
generovany na zakladé matematickych vypoctu a proto jsou ¢asto oznacovany také jako
proceduralni shadery. Shadery se vypocitaji pfi kazdém spusténi renderingu a tak jejich
vzhled bude vZdy perfektni bez ohledu na velikost objektu nebo pfiblizeni kamery.
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2D shadery se chovaji podobné jako 2D bitmapové textury, samoziejmé s vyjimkou
toho, Ze jsou nezavislé na rozliSeni. 2D shadery |ze promitat na objekty pomoci
standardnich druh(i mapovanijako plosného, cylindrického nebo sférického. 2D shadery
jsou “ploché” stejné jako 2D textury a je nutné je kolem vybraného objektu obalit. 2D
shadery pouzivaji pro zobrazeni na povrchu onjektu soufadnice U a V. Pokud bychom
z objektu vyfizli néjakou jeho ¢ast, pak se 2D shader bude chovat naprosto stejné jako
bitmapova textura.

U bitmapovych textur i 2D shader(i mdze byt nalezeni nejvhodnéjsiho typu mapovani
dost problematické, zvlasté pfi jejich aplikaci na geometricky slozité objekty. Zde nam
pfichazeji na pomoc 3D shadery. Ty se €asto oznaluji jako volumetrické shadery,
protoze umi pracovat se tfemi rozméry, reprezentovanymi soufadnicemi U, V a W, kde
pravé W predstavuje hloubku.

P¥i pouziti 3D shaderu si nemusime lamat hlavu s nastavenim mapovani, protoze se
vzdy pouzije mapovani UVW. 3D shadery jsou idealni pravé na texturovani slozitych
objektl, kde by bylo pouZiti 2D textur nebo 2D shaderu problematické.
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3D shader ma skute¢nou
hloubku. Jestlize bychom vyfizli
diru do objektu, pak bychom
mohli vidét, ze shader pokracuje

uvnitf objektu.

Nékteré shadery mohou byt pouzity v jednotlivych kanalech materialu, napf. pro definici
barvy, odrazu, hrbolatosti apod. Tyto shadery oznadujeme jako kanalové a mohou
byt jak 2D, tak 3D. Do kanalu barvy miZzeme nahrat napfiklad brick shader (cihly), do
hrbolatosti 3D noise shader atd.

Cinema 4D standardné obsahuje kolekci proceduralnich shaderd Smells Like Almonds
(SLA) od firmy bhodiNUT, které podstatnym zplsobem rozsifuji moznosti programu.
bhodiNUT SLA shadery obsahuiji jak 2D, tak 3D shadery. KaZdy z téchto shaderd ma
relativné velky pocGet nastaveni, takZe neni problém s jejich pomoci vytvofit specialni
povrchy jako les§téné kovy, transparentni skla apod. bhodiNUT SLA shadery jsou
ptistupné jako kanalové shadery v editoru materialt nebo jako samostatné shadery v
menu File (Soubor) v Material manageru.

bhodiNUT SLA shadery poskytuji neomezené texturovaci moznosti a timto souborem
tutoriall si odkryjeme pouze jejich nepatrnou ¢ast. Nasim cilem bude ziskat dostate¢né
zku$enosti, na jejichz zakladé bychom mohli experimentovat a vytvaret nase vlastni
kombinace shader(. Tyto tutoridly zaénou jednoduchym pfikladem pouZiti shaderl pfi
vyrobé oblohy s mraky a budou pokra¢ovat vyrobou komplexniho materialu na médénou
trubku s ¢asti povrchu pokrytého rzi.

Souhrn

bhodiNUT SLA shadery nabizeji Siroky rozsah proceduralnich 2D a 3D shaderd, které
nam umozZnuji snadno vytvaret realistické i zcela fantastické textury. Proceduralni
shadery, kterymi generujeme textury z matematickych rovnic, jsou neuvéfitelné silnou
alternativou texturam vytvarenym klasickymi obrazky.
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Obloha s mraky
Je mnoho zpusobu jak vytvorit
oblohu pokrytou mraky. Techniku,
kterou zde pouZijeme, muZeme
aplikovat u mnoha dalsich pfipadu.

Spojenim nékolika bhodiNUT SLA shaderu vytvofime snadno a rychle modrou oblohu
s nékolika bilymi mraky. Nau€ime se jak pouzivat pfechody pro vytvofeni barvy oblohy
a pouzijeme shader Noise (Sum) pro pfidani mrakd.

» Nahrajeme si scénu pojmenovanou ,Sky Before.c4d‘ z adresare Texturing - SLA1,
ktery je v adresafi CINEMA 4D Tutorials.

Pro pokraéovani prace si Open File [ 7]
nahrajeme scénu. ; : = ;
I Lok jr: I@ Testuring - 5LA 1 j L] £ Ed-
@Sky After.c4d
Fare,c4d

Tato scéna obsahuje objekt Sky (obloha) a objekt Torus (anuloid), na némz je aplikovan

odrazivy material. Anuloid je zde proto, aby se v ném odraZela obloha v kazdém jeho
Uhlu a ne jenom na malé Casti.

» V Material manageru poklepeme na nahled materialu oblohy.

Otevie se dialogové okno se strankami parametri materialu. Nase obloha bude
vytvorena kombinaci nékolika SLA shaderu v kanalu Color (barva).
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» Klepneme na malou Sipku vpravo od pole pro vkladani obrazku a zvolime
bhodiNUT Channel (kanal) > bhodiNUT Gradient (pfechod).

V otevieném menu jsou k Z Color Texture
vtevrenem Diffusi
dispozici véechny druhy = LLI,II'I:::::CE [ ” |’ ‘

shaderu. [ Transparency Sampling [MIF =] D W 5 IW Copy Channel
Reflection . Fazte Eharme!
[ Environment Wi INormaI = i |1 00 %

Fog - bhadiMUT Channel ¥ bhodiMUT 20 Moize

— Edit....

| Bump —II shader ¥ bhodiMUT 30 Moize

- g'pha | " bhodMUT Banj

pecular : :

[ Specular Color E:DSI:EI gnffhtness Cortrast
Glow odi Uity
Disp!acgment bhoditUT Colorizer
NmireiEn bhodNUT Distorter

bhodiMUT Fallaff
bhodiMUT Fresnel
bhodiMUT Fusion

bhodiMUT Gradient

[ETTHE R

Toto pravé oteviené menu obsahuje vSechny kanaly shaderu, které mame k dispozici
a také obsahuje vSechny shadery bhodiNUT. Nyni si vybereme bhodiNUT gradient pro
tvorbu barevného prechodu, jak miZeme vidét na obrazku.

» Klepneme na tlaéitko Edit pro otevieni dialogového okna nastaveni shaderu.

-

Klepnuti na tlagitko Edit @] Smells Like Almonds
zpfistupni dialogové okno
|2D -U x| [ Cycle

Sitart
[x J-100 ERA[ 2z E

End
J7 |20 | [x Jron ERA[ El= El
Fadius I‘IDD j Space; |Object LI

Interpolation; IEubic Kot LI Position: |D°/° j

;

()3 | Eancell
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Dialogové okno nastaveni shaderu nyni zobrazuje ¢tvercovy nahled pfechodu a jeho
aktualni pouzity pfechod s malymi posuvniky znamymi jako knoty pod nim. Kazdy knot
do barevného prechodu pfidava barvu.

» V rozbalovacim menu umisténém ve vrchni ¢asti dialogového okna zménime
typ pfechodu z 2D-U na 2D-V.

To zméni pfechod z horizontalniho na vertikalni.

» Poklepeme na levou tchytku barevného pfechodu, otevieme okno editace barvy
a nastavime barvu tohoto bodu na bilou. Poté okno zavieme.

Tim, Ze jsme nastavili hodnotu pfechodu ve spodni ¢asti na bilou, simulujeme efekt
mlhy, ktery se obvykle tvofi pobliz horizontu.

» Stfedni uchytku nastavime na svétle modrou (R = 99, G = 166, B = 220).
» Pravou uchytku nastavime na tmavé modrou (R = 0, G = 52, B=91).
Pravéa Uchytka definuje vrchni €ast oblohy.

» Zavieme dialogové okno shaderu klepnutim na tlaéitko OK a zkusime si
vyrenderovat pohled (zvolime Render > Render View z hlavniho menu).

Na pozadi je nyni pfili§ pozvolny pfechod mezi svétlou modrou a tmavé modrou. Navic
ale takika vibec neni vidét mlhou na horizontu, tvofenou bilou plochou.

» Znovu si otevieme dialogové okno shaderu (stiskem tlaéitka Edit) a pretahneme
bilou uchytku doprava, dokud nebude jeji pozice podle okna z polohou na
25%.

|2D - =] [Cycle

Sitart
[x J-100 ERA[ = El

End
J7 |20 | [x J1on ERA[l Bl rl
Fradius I‘IDD j Space; IDbiect LI

Interpolation: IEubic Kot LI Position: |25 4 j
| 4 O
' @

] a

Tento posun bilé (mlhy) nam umoznil jeji vétSi zobrazeni v horizontu nasi scény. Zakladni
prechod pro oblohu jsme dokon€ili, nyni jsou na pofadu mraky.
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» Klepneme na tlaéitko ve tvaru Sipky na pravé strané dialogového okna pro
nacteni obrazku a zvolime Copy Channel (kopirovat kanal), abychom vlozili
do klipboardu kanal vytvoreného prechodu a poté zvolime bhodiNUT Channel
(kanal) > bhodiNUT Fusion.

ZW Texture |
: [ Image... IbholeUT Gradient |>

| Transparency || Gampling [MIP <] 0 fo% 3] §fox | EditShader.
Reflection _—
: Enwiranment Mix INormaI | il |1 0% | Copy Channel

Fag ; Fazte Charme!
W Edit... | B —

: Alpha bhadiMUT Channel ¥

v Specular shader 3

Shader Fusion (fGze) je velmi mocnym nastrojem. MGzZeme ho totiZ pouzivat pro
kombinaci neomezeného poctu shaderd, vytvorenim jejich postupné hierarchie.

» Otevieme dialogové okno shaderu Fusion stisknutim tla¢itka Edit a do polozky
Base Channel (zakladni kanal) vlozime po stisknutim Sipky na pravé strané
dialogového okna pro nacteni obrazku pomoci moznosti Paste Channel
pfechodovy shader, ktery mame v klipboardu.

[) smells Like Almonds il |

- Blend Channel

Image... || j
Blur Dffset J7|nz []

Blur Strength J—IDX j
Interpolation IMIF' = Edi |

=i ask Ehannel
Flm Image... ” j
Blur Offset Jim
I—— | F
Bland: |—1UU°/°j |terpalation IMIF' LI Edit___l

J rBaze Channel ‘

Image... || |>

Mode: |Mormal LI

Blur Strenath

[ Use Mask Burlfset | [0% Capy Charinel
Paste Channel
[~ Irvert Mask Blur Strength e— ID 5 —

bhodiMUT Channel »
Irvert Olutput Interpolati MIFP AL Elit
o p nterpalation I _I i | S ;
()8 | Cancel |

Vlozili jsme shader s pfechodem do zakladniho kanalu shaderu Fusion, nyni jej miZzeme
michat s jakymkoliv jinym shaderem.
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» Stiskneme malou Sipku u dialogového pole v sekci Blend Channel (michaci
kanal) a zvolime kanal bhodiNUT > bhodiNUT 2D Noise (Sum).

- Blend Channel

Image..._|[bhodNUT 20 Noise 3
Burlfset f————[0% 3!
Blur Strength ——— — lﬂ .
Interpolation Iﬂ M =
- sk Chanre!

Image... | I j
Blrdfiset ——[0% &
Blur Strength — lﬂ
Blend: 100 || |

J rBaze Channel

Image..._|[bhodNUT Gradient o

Pfechod je nyni v zakladnim
kanalu a 2D Sum je v michacim
kanalu.

Mode: |Mormal LI

[~ Use Mask Blur Offset J—|nz [
[ Irwert Mask Blur Strength ——— F—— ID # ﬂ

[ Irnwert Qutput Interpalation IMIF' LI Edit...l

Pouzijeme 2D shader Sumu pro generovani mraku. Je tu k dispozici také 3D Sum,
volumetricky shader, ale my pouZijeme kulové mapovani materialu oblohy na velkou
kouli, ktera tvofi objekt oblohy a na to volumetricky shader nepotfebujeme.
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» V Blend Channel (michacim kanalu) stiskneme tlacitko Edit a otevieme dialogové
okno s nastavenim shaderu 2D Noise (Sum).

Stisknuti tlaéitka Edit otevie [ Smells Like Almonds x|

shaderu 2D Noise.
g & " [ Animate Preview
Scale —————

Global Scale {100 % 2]
U Scale 100% 5
W Scale 100% 5

i
4

i
4

i
4

7 IAnimated 2 |

r Moise

INoise > || Octaves |5 j

Animation Speed |0 j Delta: 100 2j

Detail Attenuation {100 % 2]

Color 1 Low Clip
——Ff* 3
High Clip

Calar 2 J 100 % j
Brightness
—— % 3

Abzalute [
Contrast

Cycles [0 3]||[——F+—o=z 3

()3 | Eancell

V tomto dialogovém okné muzZeme ménit parametry jako jsou barva (nas Sum nemusi

byt ernobily), contrast (kontrast), scale (méfitko) (Sum muZe byt protaZeny horizontalné
i vertikalné), typ Sumu a mnoho dalSich.

» V nastaveni Sumu zvolime typ Sumu na Wavy Turbulence (vinita turbulence).

- )

Zména pozadovaného typu Maise
Sumu. .
IWavy Turbulence | Octaves v
Amimation Cnaad 4l Malta Fon==l

Tento typ Sumu je rozdilny od toho puvodniho, je podstatné zajimavé;jsi a vhodny pro
vytvoreni mrak(.
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» V hodnotach Scale (méFitko) zvolime hodnotu U (horizontalni) na 500% a hodnotu

V (vertikalni) na 200%.

I L= AR

Scale
Global Scale
U Scale
W Scale

Vytvofili jsme Sum o vétsi struktufe, jehoz vysledkem budou vétsi mraky, které také
budou roztaZené do stran.

V casti nastaveni clipu (nastaveni intenzity kanalu), nastavime Low (spodni)
klip na 53% a High (vrchni) klip na 73%.

| LB SIS MU 1LY Ce |

Color 1 Low Clip
— T 3

High Clip
Calar 2 Y J_Iﬂ
S =

Toto tésné vymezeni hodnot Sumu vytvofi z vétSiny tmavsich ploch plochy cerné
a ze sveétlych bilé. Tak na misto zamlzené a zatazené oblohy mame nékolik bilych
nacechranych mraka.

Zavieme dialogové okno 2D Noise (2D Sumu) stisknutim tlaéitka OK a vratime
se do dialogového okna Fusion.

Na levé strané dialogového okna shaderu Fusion nastavime mod kryti kanalu
Blend na Screen.

Maod Screen (prekryti) smicha mraky s pfechodem v zavislosti na jasu mraku.

Zavieme dialogové okno shaderu Fusion stisknutim tlacitka OK a zvolime Render
> Render View (renderovat pohled) z hlavniho menu.

Souhrn

MiZeme dostate¢né kontrolovat viditelnost mrakd pomoci michaciho posuvniku (kryti)
v shaderu Fusion, nebo mGzeme zkusit jiné moédy interakce kanalu pro vytvoreni
rozdilnych vysledkd. Médy michani kanall pracuji stejné, jako interakce vrstev ve
2D grafickych aplikacich. Misto kanalu pfechodu a Sumu miZeme kombinovat kazdy
z kanalu dalS§im shaderem Fusion, ktery bude opét obsahovat dalSi dva navzajem
mixované kanaly. Shader Fusion ndm umozZzriuje michat cokoliv s imkoliv. Neni limitovan
pouze na shadery, pomoci néj mizeme mixovat i shader s obrazkem. Je to ziejmé jeden
z nejsilnéjsSich nastrojl v baliku shader( bhodiNUT.
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Spinava med
bhodiNUT SLA shadery se mohou
pouZit pro simulaci Sirokého
spekira materidld. PouZijeme
jeden z 3D shaderu pro vytvoreni
prastarého kusu médi.

Pro pokracovani si nahrajeme
scénu.

V8echny bhodiNUT 3D shadery (také znamé jako volumetrické) maji vlastni uzivatelska
rozhrani. Nékteré slozky jako tfeba Specularity (odrazivost), Roughness (nerovnost
povrchu) ¢i Reflection (odlesk) jsou zafazeny do v8ech druh( 3D shaderd, ale jsou
zde i specifické vlastnosti pro specifické shadery.

BANUJI se pouZziva pro sklo a pruhledné plochy, BANZI pro dievo, CHEEN pro elektronové
mikroskopické typy materiald, DANEL pro kovové plochy, MABEL pro mramorové
povrchy a NUKEI pro povrchy skladajici se z dvou povrchd, tfeba dodanim c¢asti
povrchu zihaného vzhledu €i rzi.

NUKEI se muZe také pouZit pro vytvoreni povrchd, které maji na své ploSe vrstvu
prachu ¢i Spiny, coz si pravé ukazeme na nékolika nasledujicich strankach. Vytvofime
materidl pro médénou trubku s vrstvou $piny na vrchni ¢asti. Tato vrstva Spiny potom
bude renderovana pouze na vrchnich plochach. Nas shader bude kombinovat NUKEI
Falloff, shader Fusion a shader Noise (Sum).

Nahrajeme si soubor pojmenovany ,Dirty Copper Before.c4d‘ z adresare
Texturing - SLA 2, ktery je v adresari CINEMA 4D Tutorials.
DOpen File EHE
Look jn: I@Texturing-SLA2 j = &5 Ef-
Dirty Copper After,cdd

Dirty Copper Before,c4d
Dirty Copper.jpg

Tato scéna obsahuje kouli a trubku.
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Seznam 3D shaderu je k
dispozici vtomto menu Material
Manageru.

Stranka Diffuse definuje
celkovou barvu prvého povrchu
NUKEI.

» V Material manageru zvolime File > bhodiNUT Volume > bhodiNUT NUKEI.

|w Mews Material Chil+h |

’? | bhadMUT Yolume »  bhodiNUT BANJI
V Purocluster ¥ bhodiMUT BAMNZI
Shader »  bhodMUT CHEEN
Load Materials... Chl+shiteg  bhodNUT DANEL
: - bhodiMUT MABEL

Saye Materials az... LCirl+Ehift+5 lm

] Save All Materials as... 1—=

Seznam volumetrickych 3D shaderl je v menu Material manageru.

» Novy material pfifadime objektu koule a Sweep NURBS (trubka, protazeni profilu

podél kfivky) tazenim materialu z Material manager nad jednotlivé objekty v
Object manageru.

» Dvakrat poklikame na nahled materialu v Material manager a otevieme tak

dialogové okno shaderu NUKEI. Klikneme na napis Diffuse (difuze, rozptyleni)
a otevieme stranku s nastavenim této polozky.

xl
r Diffuze Color
R | ERE |
G [ EEE |
B N EE3E |
_» | Brightness Jf1o0% 3

Suface 1 LI r Diffuse Attributes

7Fusing Algorithm Ilntemal LI Foughness [100 % J
[ [Di e

w Diffuse lllumnination IBD 4 j Contrast 0% j
v

Environment
[~ Ambient
[ Foughness
[ Anizotrophy
[ Alpha
lllumination

ok | Eancell

Tato sekce definuje celkovou barvu prvého povrchu, tedy barvu médi.




Nastavime hodnoty posuvniki na oranzovou (R=100%, G = 60%, B = 40%).

Pfemistime se na stranku Specular 3 (odrazivost, zrcadlivost) a nastavime
pomoci posuvniku barvu na stejnou barvu jako na strance Diffuse.

Nastavili jsme barvu difuze na oranZovou a potfebovali jsme nastavit barvu odrazu také
na oranzovou, protoZe jinak by zlstala nastavena nepfirozena vychozi modra barva.
3D shadery bhodiNUT umozZniuji nastavovat tfi barvy odrazu misto jedné. To oproti
normalnim materialim programu CINEMA 4D, které maji pouze jeden kanal, poskytuje
velkou miru kontroly. Kazdy kanal odrazu ma vychozi nastaveni a prvé dva nam jiz pro
nase zaméry svym nastavenim vyhovuiji a tak jsme nastavili pravé jen treti kanal.

Pfemistime svou pozornost na stranku Fusing a nahrajeme Sipkou vedle pole
Image shader bhodiNUT 3D Noise (Sum). Stiskeneme tlac¢itko Edit a otevieme
dialogové okno shaderu 3D Noise.

Nastavime Global Scale (celkové méritko) na 500% a zavieme dialogové
okno.

Na malém nahledu je nyni vidét i druhy (Spinavy) povrch.

V dialogovém okné NUKEI, najdeme malé rozbalovaci menu pod nahledem
materialu a typem zobrazeni nahledu a zvolime Surface 2.

Zména Surface 1 do Surface 2 je krokem, po kterém muZeme editovat parametry
druhého, Spinavého povrchu.

Pfemistime se na stranku Diffuse a nastavime hodnotu posuvniku na 0%.

Spinavy povrch je nyni kompletné &erny. To je vée, co zatim potfebujeme v této strance
zménit.

Na strance Fusing nahrajeme do pole pro vlozeni obrazku shader bhodiNUT
Fusion (tim pfemazeme 3D Noise). Klikneme na tlaéitko Edit a otevieme
dialogové okno s nastavenim shaderu.

3D Noise sam nedokazal vytvofit Spinavy povrch tak, aby se projevoval pouze
na vrchnich partiich naSich objetd. K tomu potfebujeme pomoci shaderu Fusion
kombinovat 3D Noise a speciani shader, ktery bude kontrolovat kde bude shader 3D
Noise viditelny.



V dialogovém okné shaderu Fusion nahrajeme do Basic Channel (zakladni kanal)
shader bhodiNUT 3D Noise.

Do Blend Channel (michaci kanal) nahrajeme shader bhodiNUT Falloff a klikneme
na tlacitko Edit pro jeho editovani.

Shader Falloff je podobny shaderu Gradient (pfechod), ktery jsme pouZili v pfedchozim
tutorialu pfi vyrobé oblohy. U shaderu Falloff je pfechod mapovan na povrch objektu v
zavislosti na umisténi jednotlivych éasti povrchu objektu. V nasem pfipadé chceme, aby
se Spinavy povrch projevil na téch ¢astech plochy, které sméfuji vzhlru a ne na téch,
které sméruji dolu. Nékde mezi nimi se bude zmensovat Spinavéa plocha do Cisté.

Uchopime stfedni knot z editace pfechodu a tahem vzhuru jej odstranime.
Tahneme levy knot na pozici okolo 60%.

Dvakrat poklikame na pravy knot a pouzijeme okno nastaveni barvy na zvoleni
bilé barvy.

"Vector

%o ERAL 2z|o E
Space: IDbiect LI |7 Usze Bump
|7 Sphere LI Interpolation: IEubic Kot LI Position: I‘IDD % j

T

@ a

Zavieme dialogové okno shaderu Falloff.

V dialogovém okné shaderu Fusion zvolime méd kryti na Levr a hodnotu Blend
(michani) nastavime na 75%.

Mode: ILew LI

Blend: |?5z []
Levr je specialni méd, ktery doda pouzitému prechodu strukturu Sumu s tvrdym a
roztfepenym okrajem. Hodnota Blend kotroluje jak tvrdy tento okraj je.
Zapneme moznost Invert Output (inverse vystupu).

Kdyz to takto nastavime, tak se v nahledu materialu zobrazi Spinava plocha ve vrchni bilé
oblasti. Pfed timto krokem byla bila spodni oblast, coZ jsme nechtéli. Zapnuti moZnosti
Invert Option nam oto¢i toto zobrazeni bez nutnosti ménit samotny pfechod Falloff.
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» V Base Channel klikneme na tlaéitko Edit a otevieme dialogové okno shaderu

3D Noise. Nastavime globalni méfitko na 30% a dialogové okno zavieme.

Touto Upravou méfitka jsme zjemnili drsnost Spinavého povrchu. Toto zjemnéni vypada
podstatné presvédcCivéji.
» Zavieme dialogové okno shaderu Fusion.

Jak mGzeme vidét na nahledu materialu, tak je Cerna $pina na vrsku koule.

» Zavieme dialogové okno shaderu NUKEI a zvolime z hlavniho menu Render >
Render View.

Na vrchnich éastech objektu
nyni je silna ¢erna vrstva $piny.

Nyni mame na vrchnich partiich nasi lesklé médéné trubky ¢ernou vrstvu Spiny.
Pro kontrolu $itky této $piny musime zménit pfechod v shaderu Falloff. Napfiklad
premisténim ¢erného levého knotu doprava zlGzime vysledny $pinavy pruh.

Souhrn

Shadery bhodiNUT jsou silnym a fenomenalnim nastrojem a experimentovani je jednim z
nejlepsich zplsobu jak se s nimi naugit pracovat. Pro zagatek je nejlepsi si zkouSet hrat
se shaderem Fusion. Fusion umozZniuje vzit dva materialy a ty kombinovat. Napfiklad
pro vytvoreni dlazdicové podlahy staci skombinovat shader s hrbolatosti se shaderem,
ktery bude definovat dlazdice.
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Tribodové
osveétleni

Metoda tribodoveho osvétleni je
jednim ze zdkladnich zpusobu
nasvétleni scény s jednim Ci
vice objektu. Jak v praxi takové
osvétleni nastavit si ukdZeme v
tomto tutoridlu.

a definuje hlavni thel osvétleni. Vypliujici svétlo se pouziva pro zjasnéni ploch, které
nejsou ovlivnény kli¢ovym svétlem nebo ty, které by zlstaly zcela ¢erné. Dodava scéné
osvétlené klitovym svétlem diky své oranzové &i Zluté barvé teply dojem. Zadni svétlo
zjasfiuje okraje objektl pro zvySeni jejich viditelnosti a ,vytahuje” objekty z pozadi.
MozZnou barvou pro zadni svétlo je modra, kterou povaZzuje lidské oko za chladnou a
je v opozici k teplym barvam, coz dodava scéné vétsi hloubku.

NiZe uvedeny obrazek zobrazuje zakladni pozici kli¢ového svétla, vyplriujiciho svétla
a zadniho svétla. Klicové svétlo je vlevo od kamery, vyplfiujici vpravo a zadni osvétluje
scénu z vétsi vzdalenosti zezadu.

Kliéové svétlo je umisténo vievo
od kamery, vypliujici vpravo a
zadni osvétluje scénu z vétsi
vzdalenosti zezadu.

Poznamka. Tfibodovy systém se pouziva pro osvétleni hlavnich objektl ve scéné.
Objekty v pozadi tedy potfebuji své vlastni separatni osvétleni.
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Nasledujici obrazek zobrazuje rozdily mezi vychozim osvétlenim programu CINEMA
4D (scénu osvétluje jedno svétlo pfimo od pohledu kamery) a tfibodovym osvétlenim.
Zatimco s vychozim osvétlenim vypada objekt ploSe, nezajimavé a pfi tom ztratil
mnozstvi svych detaill, tak s tfibodovym osvétlenim ziskal objekt na hloubce i detailu.
Celkové je podstatné pfitazlivéjsi.

Vychozi nastaveni svétla dodava
objektum plosny vzhled.

Tfibodové osvétleni zobrazi
detaily a doda scéné hloubku.
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Tribodové osvétleni neni striktnim pravidlem, je v8ak dobrym startovnim bodem pro
nastaveni svétel ve scéné. Kazda scéna a kazdy objekt je od prvopo&atku rozdilny
a tak se kazdé aplikovani tfifbodového systému musi osvétlované scéné pfizplsobit.
Rozdilné uhly dopadajiciho svétla produkuji rizné ,nalady“ osvétleni. Extrémni Ghly se
mohou pouZivat pro vytvoreni dramatické nalady ve scéné. Nize uvedeném obrazku je
vidét, jaké Ize docilit pfi riznych pozicich kli¢ového svétla.

e

1 = kliéové svétlo je umisténo
vievo od kamery a trochu vyse.
2 = klicové svétlo je umisténo

nad hlavou.

3 = klicové svétlo je umisténo
pod hlavou.

3 = klicové svétlo je umisténo
za hlavou.

» Nahrajeme si scénu pojmenovanou ,Still Life Before.c4d‘ z adresare Lighting
- 3 Point umisténého v adresafi CINEMA 4D Tutorials.
Tato scéna obsahuje zatisi. Open File [ 7]x]

Lok jr: | {3 Lighting - 3 Paint =] = EB-

V z4tisi jsou jiz pfipravené objekty, materialy i kamera.
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» Zvolime z hlavniho menu Render > Render View (Renderovat pohled) abychom
vidéli nahled nasi scény.

Pokud nejsou ve scéné Zzadna svétla, program automaticky pouZzije pfi rendingu tzv.
vychozi osvétleni. Toto osvétleni pouZziva vnitfni vSesmeérové svétlo, které je umisténé
lehce vlevo od kamery. Toto svétlo je zcela bilé a nevrha Zadné stiny. Jak mGzeme
vidét, tak pfi pouziti vychoziho osvétleni se objekty zdaji byt ploché a jejich obrysy
nejsou vidét, protoZze zanikaji v &erném pozadi. Rovnéz podlaha, ktera je modra, se
jevi jako ¢ernd, protoZe svétlo na ni dopadajici je pod pfilis kosym Ghlem, nez aby ji
doké&zalo osvétlit.

Zvolime Objects (Objekty) > Scene (Scéna) > Light (Svétlo) z hlavniho menu a
vytvofime prvé svétlo, které si pojmenujeme Key.

Toto bude naSe kli¢ové svétlo. Jakmile jej vytvofime, v modelaénim okné se okmazité
zméni svételné podminky scény. Poznamka. Modelaéni okno nyni pracuje v rezimu
Gouraud Shading (Gouraudovo stinovani) a pouze v tomto zobrazeni se projevi zmény
osvétleni. Zménit zobrazeni miZzeme v menu View (pohled) u kazdého modela¢niho
okna. Zobrazeni Quick Shading (rychlé stinovani) zobrazuje scény vzdy se standardnim
osvétlenim, coz je uzite¢né tehdy, kdyZ mame ve scéné mnoho svétel a chceme zrychlit
zobrazovani scény na monitoru.

V Object manageru se ujistime, ze mame vybrané klicové svétlo Key a poté v
modelaénim okné stiskneme pravé tlacitko mysi a tahneme doprava tak dlouho,
dokud nejsou vS§echny objekty na scéné viditelné.

Timto pohybem pfemistime svétlo smérem dopfedu ke kamefe. Tazenim za stisku
levého tlacgitka pohybujeme svétlem doleva a doprava. P¥i stisku pravého tlacitka pak
smérem dopredu a dozadu.
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» Stiskeneme levé tlaéitko mysi a umistime svétlo v modelaénim okné doleva

nahoru.

Objekty nyni jsou osvétlovany zleva a shora.

» Ujistime se, ze Object manageru mame oznaceno svétlo Key a klepneme na

zalozku Coord. (Soufad.) v Attributes manageru (Spravci atributu).

» V Attributes manageru nastavime pozici svétla P.X=1.74, P.Y=376, P.Z=-795.

Coordinates

P.®[1.74m 3 5.x[1 2l R.H|o® E|
P.ovlavem 3 5.v[1 szl R.P|0° E|
P.2|795m 3 5.2|1 zl R.B|D® E|

Nyni je klic¢ové svétlo umisténé trochu nad objekty a osvétluje scénu ze strany. Coz
je ta pozice, kterou jsme potfebovali pro zdarny koneény vysledek. V tomto kroku a
také v nékolika dalSich budeme pro umisténi svétel pouzivat exaktni systém soufadnic.
Normalné bychom mohli umistovat kazdé svétlo ruéné, testovat scénu a opét upravit
pozici svétla, dokud by nebylo nastaveni perfektni. V této scéné ale pouZijeme presné
hodnoty polohy svétel, abychom pro toto zatisi vytvorili dokonalé osvétleni.

Vytvofime druhé svétlo a pojmenujeme jej Fill (vypln).

Ujistime se, ze v Object manageru mame vybran objekt svétla Fill a poté
klepneme na zalozku General (Hlavni) v Attributes manageru.

Pomoci RGB posuvniku nastavime barvu svétla na svétle oranzovou (R=100%,
G = 83%, B = 68%, Brightness=100%).

Nastaveni svétle oranzové barvy pro vyplfiové svétlo doda scéné ten spravny mékky
dojem, jakoby vyvolany svétlem od ohné.
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» V Attributes manageru v zaloZzce Coord. (Soufad.) nastavime polohu vyplhového

svétla na P.X=1178, P.Y=159, P.Z=187.

Coordinates

P ®[1178m 3 5.X[1 zl R.H|o® E|
P.v[159m 3 5.v[1 zl R.P|O° E|
P.2187m 3 5.2[1 zl R.B|D® E|

Diky umisténi vyplfiového svétla vpravo od objektl jsou zjasnény ty plochy, které byly
tmavé, protoze je neosvétlovalo klicové svétlo. Vyplriové svétlo je také ponékud nize
nez klic¢ové, osvétluje objekty odspoda.

Vytvofime tfeti svétlo a pojmenujeme jej Back.
Toto je nase zadni svétlo.

V Object manageru se ujistime, Ze mame vybrano zadni svétlo (objekt Back) a
poté klepneme na zalozku General (Hlavni) v Attributes manageru.

V Attributes manageru nastavime pomoci RGB posuvniku barvu svétla na svétle,
studené modrou (R = 53%, G=77%, B = 100%, Brightness=200%).

Modra je studena barva a kdyZ ji pouzijeme na zadni svétlo, tak scéné doda dojem
hloubky. To také vizualné naznacuje, Ze scénu obklopuje néco jiného. Svétle modra
barva také byva Casto asociovana se svétlem vrhanym oblohou. Poznamka. Jas
(Brightness) neni omezen na hodnotu 100%. U zadnéiho svétla jsme hodnotu brightness
nastavili na 200%, protoZe toto svétlo bude osvétlovat pouze vnéjsi okraje objektl a
ty by byly pfi nastaveni 100% jen tézko zfetelné.
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» V Attributes manageru klikneme na zalozku Coord. a nastavime polohu zadniho
svétla na soufadnice P.X=-507, P.Y=2135, P.Z=2005.

Toto jsou soufadnice zadniho

Coodinates

svétla. P.®%|607m 2 5.%[1 2l R.H|oO® 3l
P.Y¥[2135m 3 S.%¥[1 3 R.P[O” B
P.Z2[2005m 3 S.Z2]1 3 R.E[D B

Zadni svétlo osvétluje scénu
zezadu a shora.

Timto jsme umistili zadni svétlo docela daleko. Scénu osvétluje shora a zezadu Zadnim
svétlem také osvétlujeme podlahu a tim vizualné “vyjmeme” objekty z pozadi.

» V Object manageru za stisklého tlaéitka Shift pro nasobny vybér vybereme
vSechna tfi svétla.
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» V Attributes manageru klikneme na zalozku Details (Detaily) a nastavime kontrast

na -30%.
Hodnota kontrastu Eelails
kontroluje mékkost pfechodu W' Uselrner

mezi osvétlovanymi a [rner Anale n* 3l
neosvétlovanymi plochami. Duter Angle TR E|
Azpect Fatio 1 ]

Brightress 10z 3l

Contrast A0 3l

Vlevo: Contrast = 0%. Vpravo:
Contrast = -30%.

Takto zmensSime kontrast u vSech tfi svétel. Hodnota kontrastu kontroluje mékkost
prfechodd mezi plochami osvétlenymi a témi, které osvétleny nejsou. Za jistych
okolnosti, kdyZ je povrch osvétlovan vice jak jednim svétlem, muZe tento prfechod
vypadat nepfirozené. Toto je pfipad vejce v nasi scéné, protoze prechod mezi svétlymi
a tmavymi plochami je pfili§ nahly. Negativni kontrast zméni pfechod na meékei a tim
se zamaskuje efekt Svu, ktery na ném vznikal.

v

V Object manageru vybereme svétla Back a Key a klikneme na stranku General
(Hlavni) v Attributes manageru.

» V Attributes manageru nastavime Shadow (Stin) na Soft (mékky).
» Zvolime z hlavniho menu Render > Render View (Renderovat pohled) a udélame
si nahled nasi scény.

Zadni svétlo nyni vrha sv(j stin zezadu a kli¢ové svétlo vrha stin ze strany. Nicméné,
stiny na podlaze a na mrkvi a jsou pfili§ tmavé a nevypadaiji realisticky. Ve skute¢ném
svété nenalezneme absolutné €erné stiny, ty jsou vzdy zjasnéné odraZzenym svétlem
od zdi ¢i jinych objektl.

v

V Object manageru vybereme svétla Back a Key a klepneme na zalozku Shadows
(Stin) v Attributes manageru.
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Vlevo: : Shadow density (hustota
stinu) = 100%. Right: Shadow
density (hustota stinu) = 50%.

» V Attributes manageru nastavime hodnotu Density (Hustota) na 50%.

Timto nastavime u stind obou svétel polovi¢ni tmavost.

» V Object manageru vybereme vSechna tfi svétla a klikneme na stranku General

(Hlavni) v Attributes manageru.

» V Attributes manageru zménime typ svétla z Omni (VSesmérové) na Spot

(Kuzelové).

VSesmérové svétlo se Sifi z mista svého plsobisté vsemi sméry, takZze neosvétluje
jen objekty v nasi scéné, ale také prostredi - v nasem pfipadé podlahu. Nastavili jsme
v8echna svétla na typ Spot (kuzelové) a tak nyni budou osvétlovat jen malou plochu okolo
zatisi. Objekty stojici mimo zlstanou tmavé. To dodéa nasi scéné vétsiho kontrast.

V Attributes manageru klepneme na stranku Details a nastavime Inner Angle
(Vnitfni ahel) na 20",

Kuzelové svétlo ma dvé moznosti nastaveni thlu, vnéjsi a vnitfni thel. Uvnitf vnitfniho
Uhlu je intenzita svétla vzdy 100% a mezi vnéj$im a vnitfnim thlem klesa od 100%
do 0%. JelikoZ mame doposud vybrana vSechna tfi svétla, tak miZeme v Attributes
manageru ménit Uhel pro vS§echna svétla najednou.

V modelaénim okné klepneme v pravém hornim rohu na ikonu prepinacée pohledu
(Toggle) a rozdélime si pohled na étyri okna.

V8echna kuZelova svétla maji chybny smér. V tomto okamziku pouZijeme jedno z
modela¢nich oken jako okno ,pohledu” svétla, kterym upravime smér a thel kazdého
ze svétel.
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» V Object manageru vybereme svétlo Key a z menu Cameras (kamera) nahore
vlevo v modelaénim okné zvolime Link Active Object (propojit s aktivnim
objektem, objekt jako kamera).

Svétlo se chova jako kamera,
€0z nam umoziuje vidét scénu z
mista jeho pusobeni.

Kli¢ové svétlo je nyni aktivni jako kamera a my mizZeme pozorovat scénu z mista jeho
pusobeni. MiZeme také vidét dva kruhy, znadici vnéj$i a vnitini Uhel kuZele svétla.

» Zvolime nastroj Rotate (rotace) z vrchniho menu a pootoc¢ime s klicové svétlo
tak, aby byly vidét vSechny objekty a aby byly umistény uprostied modelaéniho
okna (H=-8.6", P=-15.2",B=0’).

Pro rotaci svétla Ize pouZit jiné modela¢ni okno abychom se vyvarovali naklonéni, &i
otoceni.
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» Uchopime jednu oranzovou uchytku vnitfniho dhlu a tahneme ji, dokud

neohranicuje vS§echny objekty. Totéz provedeme u vnéjsiho uhlu, a to tak, ze
mezi vnéjSim a vnitfnim dhlem bude maly rozestup (Inner Angle (vnitini uhel)
= 40’, Outer Angle (vnéjsi uhel) = 50°).

Dame kuzelovému svétlu mékky pfechod na okraji. Pro to je nutné, aby vnéjsi uhel
byl vétsi vnitfni.

» V Object manageru vybereme svétlo Fill (vyplfiujici) a z menu Cameras (Kamery)

z levého vrchniho menu modelaéniho okna vybereme Link Active Object (Objekt
jako kamera).

» Z hlavni nastrojové palety vybereme nastroj Rotate a pooto¢ime vypliujici svétlo

od bodu pusobeni smérem k zatiSi (hodnoty rotace H=84", P=-4.7°, B=0’).
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vSechny objekty ve scéné. (Inner Angle (vnitini Ghel) = 49°, Outer Angle (vnéjsi
uhel) = 60°).

Vypliiové svétlo sméfuje z mista
svého pusobni k objektum.

» V Object manageru vybereme zadni svétlo Back a v menu Cameras (Kamery)
v modelaénim okné zvolime Link Active Object (Objekt jako kamera).

» Z hlavni nastrojové palety vybereme nastroj Rotate a pootoéime zadni svétlo
od bodu pusobeni smérem k zatisi (Rotation H=-158.9°, P=-48.6", B=0").

Zadni svétlo nyni sméfuje od
mista svého pusobeni k zatisi.
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» Zvolime Render > Render to Picture Viewer (Renderovat do prohlize¢e) a
vyrenderujeme scénu.

Nyni méa zatisi takové osvétleni, diky kterému vypada celd scéna velmi pestie a
zajimavé.

Souhrn

TFibodové osvétleni miZe byt aplikovano na komplexni scény stejné jako v tomto pfipadé.
Jestlize mame néjaké objekty vice v pozadi ale chceme zdUlraznit objekty v popiedi,
pak je dobré nasmérovat teplé a pestré tfibodové osvétleni na objekty v popredi a
chladnéjsi modré osvétleni na objekty v okolnim pozadi.

VZdy musime pamatovat na to, Ze spravné nasviceni scény je stejné dllezité jako
samotné objekty. Napadné stiny a dramatické barvy mohou pfeménit nezajimavou scénu
na umélecké dilo. Nékteré z nejlepsich uméleckych dél pouzivaji velmi jednoduché
scény, jejichz zajimavost a zvlastnost je vysledkem dimysiné hry svétel a stind.

Nicméné u volby osvétleni naSeho projektu bychom se méli vyvarovat jednoduchého
svétla umisténého u kamery, pak bychom totiz nemohli o€ekavat nic vic, nez nudny a
nezajimavy vysledek.



CINEMA 4D TUTORIALY

OSVETLENI 137

Volumetrické
svétlo

Program CINEMA 4D ném
poskytuje rozsahlé spektrum
moZnosti nastaveni svétel. PouZitim
volumetrického svétla vytvofime
zajimavé a moderné vypadajici
logo.

Vlevo: viditelné svétio
Uprostied: volumetrické svétlo
Vpravo: inverzni volumetrické
svétlo

Na televizni obrazovce muZeme €asto vidét zajimavy svételny efekt, kdy néjaké logo
€i napis vrha viditelné pruhy svétla. Tento efekt je opravdu velmi atraktivni a sou¢asné
pomérné snadny. V tomto tutoridlu se nauc¢ime jak tohoto efektu docilit za pouziti
volumetrickych svétel.

TEF

Ve skutecnosti je viditelné svétlo tvofeno mnozstvim malych ¢astecek prachu nebo
rozptylenych kapének vody (mlha), které jsou osvétlovany prochazejicim svétlem.
Vytvoreni viditeIného svétla vSak docilime i bez téchto ¢astecek ¢i mlhy a to prostym
zapnutim parametrd viditelnosti svétla. Jestlize chceme vytvofit blok viditelného svétla,
Ci pouze jeho ¢ast, pak zvolime svétlo volumetrické. Volumetrické svétlo také mizeme
obratit - misto bloku viditelného kuzele svétla dopadajiciho na objekt a za objektem
pohasinajiciho, mohou objekty umisténé v oblasti kuZele svétla teprve volumetrické
svétlo zaktivovat a to je poté viditelné jen v oblastech stinénych témito objekty. Tato
svétla nazyvame inverzné volumetricka.
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» Nahrajeme si scénu pojmenovanou ,Volumetric Light Before.c4d‘ z adresare
Lighting -Volumetrics umisténého v adresafi CINEMA 4D Tutorials.

Tato scéna obsahuje logo. Open File HE

Look jr: I@ Lighting - Yolumetrics j =] ﬁ v

tex

@ Wolumetric Light After, ch

History ‘Wolumetric Light Bel e
g Wolumetric Light . moy

Tato scéna obsahuje jednoduché logo, pozadi a nastavena svétla. Tedy vSe, co
potfebujeme k vytvoreni poZadovaného efektu.

» Z hlavniho menu zvolime Objects (Objekty) > Scene (Scéna) > Target Light
(Zamérené svétlo).

Zaméfené svétlo neni nic jiného nez normalni svétlo s nulovym cilovym objektem
a vlastnosti target expression (cil-chovani). Diky vlastnosti target expression bude
svétlo stale z mista svého plsobi$té zameérovat cilovy objekt. Cilovy objekt a logo jsou
shodné umistény na pivodnich vychozich soufadnicich a tak se kuZel svétla bude stale
zamérovat na pozadovany objekt.

» Pouzijeme nastroj Move (Posun) ne Coordinates Manager (Spravce soufradnic)
a upravime polohu svétla tak, aby bylo umisténo za logem. (X=0, Y= -170,
Z=1112).

Kuzelové svétlo musime umistit
za logo (na obrazku je pohled
z boku).

» V Attributes manageru klepneme na zalozku General (Hlavni) a upravime barvu
svétla na jasné modrou. (R = 80, G = 90, B = 100, Brightness = 300).

Nastaveni barvy a jasu neni uréeno jen pro osvétlujici parametry svétla, ale také ovliviiuje
jas viditeIného svétla. Potfebujeme, aby nami vytvorené viditeIné pruhy svétla byly
dobfe zfetelné a proto jsme nastavili jas na 300%.
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Na vysledném renderu je logo, z
néhoz vychazeji pruhy svétla.

» V Attributes manageru nastavime parametr svétla Visible Light (Viditelnost

svétla) na Inverse Volumetric (Inverzné volumetrické).

Tato vlastnost je tou, ktera je zodpovédna za dosazeni poZadovaného efektu.
V Attributes manageru klepneme na stranku Visibility (Viditelnost).

Na této strance mizZeme upravovat dal$i parametry viditeIného svétla.

Nastavime Outer Distance (Vnéjsi vzdalenost) na 4000 a Inner Distance (Vnitini
vzdalenost) na 3000.

Nase scéna je pomérné velka a tak by byla vychozi vnéj$i vzdalenost dosahu
viditeIného kuZele svétla pfili§ mala a svétlo by ani nedosahovalo k logu. Proto jsme
museli podstatné zvétsit vnéjsi vzdalenost dosahu svétla a také vnitfni vzdalenost.
Diky nastaveni vnitfni vzdalenosti na 3000 jednotek ma nyni kuzel svétla v oblasti loga
maximalni moznou intenzitu, ktera se sniZuje smérem od loga a pusobisté svétla, az
je ve vzdalenosti 4000 jednotek nulova.

Aktivujeme 3D pohled v modelaénim okné a z hlavniho menu zvolime Render
> Render View (Renderovat pohled).

Tento efekt je zvlasté zajimavy u animaci, kdy animovanim pozice volumetrického svétla
muZzeme dosahnout pusobivych efektd.
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Souhrn

Volumetrické svétlo se vyborné hodi pro vytvareni atmosféry celé scény a dodava
ji nezaménitelny vyraz a dojem. Jednoduchy paprsek svétla mize znacit posledni
moznost zachrany, ¢i probliknuti nadéje, kdezto vétsi pocet svételnych paprski se
muiZe pouZit pro ztélesnéni ohromujici sily. Zde jsme pouZzili volumetrické svétlo pro
naznaceni unikajici energie z loga, dodali jsme mu dojem sily. V jinych scénach mizeme
vidét volumetricka svétla jak prosvétluji prach v podkrovi, v zakoufeném baru nebo
jak prochazi chramovymi okny, pfi¢emz jsou jednotlivé pruhy svétla zabarvené podle
sklenénych tabulek.
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Kli¢ové snimky,
animace polohy

Na&s prvni pohled na zdkladni
animacni technologie bude
smérovat k prozkoumani klicovych
snimku a vytvoreni animace, ve
které bude objekt ménit svou
polohu.

CINEMA 4D umozZiiuje mnoho rlznych postupd animovani, ale asi nejednodusi je
ten, kdy si nahrdvame ruzné polohy objektu do rliznych ,Easu“ (kli€ovych snimku).
Program pak nasledné sam vygeneruje pohyb objektu na zakladé interpolace mezi
jednotlivymi polohami.

Jak uvidime, je to celkem jednoduché. Pfedstavme si, Ze bychom chtéli animovat pohyb
automobilu po silnici. Ta ale neni zcela rovna a obsahuje nékolik zataek. Na zadatku
cesty miZeme nahrat pozici a smér vozu do tzv. kli€¢ového snimku. Od tohoto okamZiku
by se vlz pohyboval rovné po silnici, a novy kli¢ovy snimek zaznamename az kdyz se
objevi prvni zatacka a my budeme muset zménit smér jizdy. Program mizZe interpolaci
vypocditat pozici a smér vozu mezi témito dvémi body. Kdybychom vhodné pfidali vétsi
pocet kli¢ovych snimkdl, pak by mohl viiz jezdit dokola po zatackach a program by
pomoci interpolace vypocitaval pozici mezi jednotlivymi snimky.

Nejdfive si ukdZeme, jak se nahravaji klicové snimky pozice objektu, které tvofi zaklad
jednoduché animace.
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» Klepneme na vrchni ikonu levé nastrojové palety a zvolime si uzivatelské
prostiredi Animation.l4d.

PFi animaci budeme pracovat v
tomto uzivatelském prostredi.

V této nabidce je obsaZeno nékolik zékladnich uZivatelskych prostfedi, kterymi je
program vybaven. Jedno z nich je navrZzeno pro animace. Okna manaZert Timeline
(Gasova osa) a F-Curves jsou jiz oteviena a proto neni nezbytné je pro kazdy krok
animace hledat a znovu otvirat.

Abychom to méli jednoduché, vytvofime pohyb objektu mezi body A, B, C.

» Z hlavniho menu zvolime File (Soubor) > New (Novy) a vytvofime novou
scénu.

» Ujistime se, Ze v levé paleté nastroju mame zvoleny Object tool (editace objektu,
k animaci).
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» Zvolime z hlavniho menu Objects (Objekty) > Primitive (Primitiva) > Sphere
(Koule). Muzeme také pouzit paletu primitivnich objektu z vrchni nastrojové
palety.

» Vybereme nastroj Move (Posun) a posuneme kouli do levého vrchniho rohu
scény. To je startovni pozice nasi animace.

» V nastrojové paletce animaci (dole pod modelovacim oknem - viewportem)

vypneme tlaéitka pro zaznamenani parametru rotace a méfitka.

Vypneme v8e, kromé tlacitka zosobriujiciho polohu objektu. V tomto bodé budeme
pracovat praveé jen s polohou objektu ve scéné.

V nastrojové paletce animaci
definujeme parametry, které
chceme nahravat.

» Klepneme na tlaéitko s éervenou teckou.

Prvé tlacitko s €ervenou teckou
je nahravaci.

Timto tlagitkem na nahrajeme prvou pozici koule v nasi kratké animaci.

» Zménime pomoci posuvniku klicovy snimek, pfejdeme na snimek 45.

Potahneme posuvnik.

» Ujistime se, Ze mame stale zvoleny nastroj Move a v modelovacim okné uchopime
kouli a pfremistime ji smérem doprostied scény, k dolnimu okraji okna.

Premistime kouli dolu.
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» Znovu klepneme na nahravaci tlaéitko.

Tim zaznamename novy klicovy snimek pozice koule, snimek 45. Kdybychom nyni
uchopili posuvnik ¢asové osy a jezdili bychom s nim sem a tam, tak bychom vidéli, jak
se nam koule pohybuje.

» Umistime posuvnik ¢asové osy Upiné doprava.

» Opét se ujistime ze mame zvoleny nastroj Move a umistime kouli do pravého
horniho rohu.

» Znova klepneme na nahravaci tlacitko.
Timto jsme nahrali posledni kli¢ovy snimek nasi animace.

» Stiskneme tlacitko Play a zkontrolujeme si pohyb koule v animaci.
Koule se nyni pfemistuje mezi body A, B a C.

» Zvolime File (Soubor) > Save (Ulozit) a nahrajeme nami vytvofenou scénu do
téhoz adresare a pod stejnym jménem.

Budeme pokradovat v praci na této scéné i v dalSich tutorialech patficich do tohoto
tématu.

Souhrn

Naucili jsme se nahravat klicové snimky pozice objektu pomoci prostého stisknuti
nahravaciho tlacitka. Mazeme zménit polohu objektu a opét pouze stisknout tlagitko.
Program pak jizZ sdm pomoci interpolace vypodita pfechodové snimky animace mezi
jednotlivymi kliovymi snimky. Stejnym zplsobem jako polohu objektu Ize animovat
také polohu kamery ¢&i svétla.
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Kli¢ové snimky,
animace
velikosti

Jinou viastnosti objektu, kterou Ize
snadno animovat, je jeho velikost,
neboli méritko. V tomto tutoridlu
vytvolime pulsujici kouli.

Nahravanim kli¢ovych snimkl miZeme animovat velikost objektl a program opét
propocita pomoci interpolace ostatni snimky animace. Animace velikosti ndm umozriuje
vytvofit cokoliv od vypousténého balénku po pulsujici srdce.

» Jestlize nemame nahranou scénu z predchazejiciho tutorialu, pak si ji
nahrajeme.

Tato scéna obsahuje nami vytvofenou kratkou animaci pohybu koule mezi body A, B
a C. Animace velikosti objektu docilime pfesné stejnym postupem, jaky jsme pouZili u
animace pohybu.
» Ujistime se, zZe v levé paleté nastroju mame zvoleny Object tool (editace objektu,
k animaci).
Pfi kazdém animovani se

musime ujistit ,Ze mame zvolen ﬂ
nastroj Object tool.

» Nastavime posuvnik v ¢asové ose na snimek 0.

» V nastrojové paletce animaci vypneme tlaéitka pro zaznamenani parametru
rotace a polohy, zapneme tlacitko pro zaznamenavani velkosti.

Abychom nahravali pouze zménu .
velikosti, zapneme pouze toto . &9 | "*" @ P .

tlacitko.
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Pro zménu velikosti zvolime
nastroj Scale z vrchniho

nastrojového menu.

Diky uchopeni zelené osy (y)
jsme zménili rozmér koule jen v

jedné ose.

» Z vrchniho nastrojového menu zvolime nastroj Scale (méfitko / velikost).
b x, Wit @

» V modelaénim okné uchopime zelenou osu koule a tAhneme mysi doleva, koule
se zplosti.

V nastrojové paletce animaci stiskneme tlaé¢itko pro nahravani.
Nyni jsme si uloZili zménu tvaru koule do snimku 0.

Posuneme posuvnik v ¢asové ose na snimek 45.

Ujistime se, ze mame stale vybrany nastroj Scale (méfitko / velikost) a poté opét
uchopime zelenou osu objektu a potahneme mysi doprava dokud z objektu opét
nevytvofime kouli.

V nastrojové paletce animaci stiskneme tlac¢itko pro nahravani.

UloZili jsme si zménu tvaru do kliGového snimku 45. jestlize jsme vSe provedli korektné,
pak by méla byt naSe koule na poéatku smrsténa a poté se v pllce animace roztadhne.
MiZeme zatrhnout moznost aby se posuvnik pfemistoval tam a zpét.

Posuneme posuvnik zcela doprava.

Ujistime se, ze mame stale vybrana nastroj Scale (méfitko / velikost) a poté
opét uchopime zelenou osu objektu a potahneme mysi doleva dokud z objektu
opét nevytvorime zplostélou kouli.

V nastrojové paletce animaci stiskneme tlac¢itko pro nahravani.
Ulozili jsme posledni kli€ovy snimek animace.
Stiskneme tlacitko Play a zkontrolujeme animaci.

Pfi pfejezdu objektu pfes prostfedek obrazovky se koule roztahne ze zplostélé podoby do
normalniho tvaru a poté se opét zplosti.
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» Zvolime File (Soubor) > Save (Ulozit) a ulozime scénu do téhoz adresare a pod
totéz jméno.

S touto scénou budeme pokracovat v praci v dalSim tutorialu tykajiciho se tohoto tématu.

Souhrn

Vidéli jsme jak se animuje velikost objektu za vyuziti stejnych principll a postupt jako
u animace polohy objektu. VyuZzili jsme kli¢ovych snimkd pro nahrani meznich rozméra
koule a program pak sam dopocital velikost objektu v jednotlivych snimcich animace.
Animace velikosti objektu se nepouziva pfili§ ¢asto, ale mize se vyuZit na zajimavé
efekty, napfiklad na vykuleni o&i animované postavicky.
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KliGové snimky,
animace rotace

Do nasi animace si zavedeme
rotaci objektu. A pomdze nam pfi
tom automatické vkldadani klicovych
snimku, nastroj, kterym muZeme
uSetfit mnoho prace i ¢asu.

Pfi kazdém animovani se
musime ujistit Ze mame zvolen

nastroj Object tool.

Pro zapnuti rotace zapneme

tlaéitko rotace.

. ®

Jak urcité kazdy z nas oCekava, pfiddme do nasi animace ke zméné polohy a velikosti i
rotaci objektu. To je véc, ktera se pouziva u animaci velmi €asto, napfiklad pro vytvoreni
rotujiciho loga &i lodniho Sroubu. V tomto tutorialu si ukazeme, jak trochu jednoduseji,
rychleji a efektivnéji vyuZit proces nahravani kli¢ovych snimkl. PouZijeme automatické
vkladani kli¢ovych snimku, u kterého pak jiz neni nutné zaznamenavat kli¢ové snimky
klikdnim na nahravaci tla¢itko. Jak je jiz pfedeslano, tato funkce zaznamenava klicové
snimky automaticky.

Jestlize jesté nemame otevieny nas predesly soubor, pak si jej nahrajeme.

V této scéné mame kratkou animaci, ve které se pohybuje koule mezi tfemi misty a také
pfi se tom zplo$tuje a roztahuje. Nyni kouli je$té dodame rotaci.

Ujistime se, ze mame v levé paleté nastroju zvoleny Object tool (editace objektu,
k animaci).

R

Nastavime posuvnik na éasové ose na snimek 0.

V nastrojové paletce animaci vypneme tlacitka pro zaznamenani parametru polohy
a méritka, zapneme tlacitko pro zaznamenavani rotace.
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» Stale jsme v nastrojové paletce animaci, zapneme tlaéitko s ¢éervenou teckou
na niz je bily kli¢ (vpravo od nahravaciho tlaéitka).

Toto tla¢itko zapina automatické _ .
T M) 0@ | ul

Toto tlacitko zapina automatické nahravani. Jakmile jej zapneme, tak je spusténo
automatické nahravani snimkd a okolo modelovaciho okna - viewportu je ¢erveny
ramecek.

Pfi pouZiti automatického nahravani kli¢ovych snimk( musime mit na paméti, Ze jej
po ukongeni editace musime vypnout, abychom se vyvarovali nasledné vytvofenych
nechténych zmén!

» Z vrchniho nastrojového menu zvolime nastroj Rotate (Rotace) a poté klepneme
mysSi do plochy mimo Zluty kruh a tahneme mysi dolu a trochu doprava.

Natocéime kouli Sikmo.

Tento novy uhel rotace koule je nahran automaticky do kli¢ového snimku 0.
» Nastavime posuvnik ¢asové osy na snimek 45.
» V modelaénim okné pootoc¢ime kouli zpét do horizontalni polohy.
Toto nové nastaveni rotace se opét automaticky nahraje do kli€¢ového snimku 45.
» Nastavime posuvnik na ¢asové ose na posledni snimek.
» Pootocime kouli dolu a trochu doleva.

Toto nové nastaveni rotace se opét automaticky nahraje do posledniho kli¢ového
snimku animace.
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» V paletce nastroju animace stiskneme tla¢itko Play a zkontrolujeme si
animaci.

Nyni nase koule nejen putuje mezi tfemi body, pfi tom pulsuje a také se otaci.

Souhrn

Naucili jsme se nastavovat klicové snimky manualné i automaticky, coz vyuzijeme u
vétsiny nasich animacnich projektl. Pokud je to mozné, je lep$i pouZzivat automatické
vkladani klicovych snimkl. Vyhneme se tak rozhodovani, manualné umistit klicovy
snimek. Eliminuje se také riziko opomenuti dileZité zmény stavu objektu ¢i zbyteéné
nahravani kazdého parametru.
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Casova osa a
krivky F-Curves

Jak vytvorit realistickou animaci,
aby vypadala jako Ziva? VZdyt
vytvofeni veSkerych pohybovych
detaild muZe byt pfimo dabelské.
Pravé pro takové ukoly obsahuje
CINEMA 4D dva mocné
pomocniky, editovani klicovych
snimku v casové ose a manazer
F-Curves kfivek. S jejich pomoci
vytvolime pravé takové animace
jaké potrebujeme a vyhneme se
cesté do pekel.

Rika se, Ze u 90% véech projekt(i (af uZ se jedna o animace, programovani &i stavitelstvi),
se pouziva stejnych osvédcéenych postupl na vyrobu ¢ehokoliv. Travime spolu relativné
kratkou dobu pfi studiu zaklad( prace s 3D. Jedno je jasné, at uz tento ¢as travime
u jakékoliv €innosti, tak ndm bude na$e prace v budoucnu diky ziskanym znalostem
Iépe plynout a vysledek bude splriovat nase predstavy. Cokoliv se nau¢ime béhem
tohoto pomérné kratkého procesu se nam v budoucnu vrati pfi tvorbé nasich vlastnich
projektd.

F-Curves neboli funkéni kfivky se pouZivaji pro prfesné nastaveni chovani objektu
napfiklad pfi zméné jeho polohy. F-Curves samoziejmé nejsou limitovany jen na
zménu polohy objektu, méfitka a rotace, tfebaze se u téchto parametrd pouzivaji snad
nejéastéji, ale muZeme s nimi v ¢ase upravovat i dalsi atributy objekt(.

F-Curves se zobrazuji na 2D miizce. Cas je zosobné&n horizontalnim smérem, &islo
aktualniho snimku je zobrazeno nalevo od posuvniku ¢asové osy a je také ziejmé z
jezdce na horizontalni ose okna. Upravou kfivky mtZeme napfiklad ménit rychlost
objektu, pohybujiciho se mezi kli€¢ovymi snimky.

V tomto tutoridlu budeme animovat vrtule dvoumotorového letadla (P 38). Nejdfive
vytvofime animaci vrtule jednoho motoru, pouZijeme ¢asovou osu a upravime dynamiku
rotace vrtule pomoci F-Curves. Poté zkopirujeme pfipravené parametry animace na
druhy motor.
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» Nahrajeme si scénu nazvanou ,Propeller Plane Before.c4d‘ z adresare

Animation - Fcurves.

Tato scéna obsahuje model letadla, u kterého chceme animovat rotace vrtuli.

» Ujistime se, Zze posuvnik na ¢asové ose je na snimku 0.

» V Object manageru vybereme objekt Propeller1 (vrtule).

EPslighning  10[ 2
Fropellerl g

Propeller2 [Che

» V Attributes manageru klepneme na zalozku Coord. (Sourad.) a zobrazi se nam

okno se soufadnicemi.

» Pravym tlaéitkem klepneme na pismeno P v R.P. a zvolime Animation > Add

Keyframe (Animace > pridat kliGovy snimek).

Coordinates

P.x[630505n%] 5. %1 2l R.HJ30° ]

F'.Y|-53.4D?m$J‘S.Y|1 B R.PD° [
M| Add Keyframe Animation » | B |20 E
?§_|—| [ext Kepframe User Interface 3

R znamena Rotace a P Pitch (vySkova osa). Toto je osa rotace, podle které potfebujeme
nechat vrtuli rotovat. V prvém okamziku, na snimku 0, je hodnota rotace 0.

Jakmile jsme pfidali kli¢ovy snimek, tak se u poloZzky R.P. objevila ¢ervena tecka. Tato
tec¢ka znamena, Ze u tohoto parametru objektu a v tomto ¢ase je zaznamenan kli¢ovy
snimek. Cervena tegka se v jiném snimku neZ v kli¢ovém zméni na &erveny krouzek.

Poznamka. Je podstatny rozdil mezi klepnutim na pismeno P nebo R z nadpisu R.P.
Klepnuti na R je prostfedkem pro editaci rotace v§ech tfi os najednou, kdezZto klepnutim
na P. editujeme jen tuto osu.

Znovu klepneme na pismeno P v R.P. pravym tlacitkem a vybereme Animation
> Show Track (Animace >Zobrazit stopu).

Timeline | F-Curve I

4 File Edt View Objects Sequences Laper 'f'ﬂ|
o o o o EO 120 180 240 300 360 =]
& EmEmE S m®m @

666 66EEE A ] e e T, L1

[ Fropeller! [+l* R otation
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V &asové ose je nyni zobrazena animacéni stopa rotace vrtule. Maly obdélnik na za¢atku
stopy oznaduje pfidany klicovy snimek. Alternativou k vy$e uvedenému postupu je
uchopeni objektu Propeller1 v Object manageru a ruénim pretazeni do okna ¢asové
osy. Vysledek by byl totozny.

V casové ose vybereme pocatecni klicovy snimek a klepneme na néj.

Cerveny rameéek okolo tohoto klidového snimku sdéluje, Ze je pravé vybrany.
Poznamka: jestlize potfebujeme vybrat vice klic¢ovych snimkl najednou, pak to Ize
ucinit se sou¢asnym stiskem klavesy Shift nebo mizeme tahem mysi vytvofit vybérovy
obdélnik okolo vybiranych klic¢ovych snimkul. Jestlize potfebujeme vybrat kli€ovych
snimku vice, pak je tato metoda samoziejmé rychlejsi.

Stiskneme klavesu Ctrl a tahem mysi zkopirujeme pocate¢ni kliCovy snimek,
ktery umistime na konec ¢asové osy, tedy na snimek 360. Po preneseni do
tohoto snimku na konec osy pustime tlacitko mysi a funkéni klavesu.

Timto jsme umistili kopii kli€¢ového snimku na konec animace. Stisknuti Ctrl a nasledné
uchopeni a taZzeni my$i umoZriuje vytvéaret kopii Eehokoliv. Kopirovany kli¢ovy snimek je
nyni vybrany a informace o jeho hodnotach a nastavenich jsou zobrazeny v Attributes
manageru.

Jestlize bychom zapomnéli stisknout klavesu Ctrl, kterou ménime proces pouhého
pfemisténi na vytvareni kopie, pak mlGzeme kdykoliv béhem probihajici operace
stisknout klavesu Esc (Escape), ktera probihajici operaci zrusi. Musime to v8ak ucinit
pred ukonéenim operace, tedy pfed pusténim tlacitka mySi. Po stisknuti klavesy Esc
se kli¢ovy snimek (i cokoliv jiného) vrati na svou plvodni pozici.

V Attributes manageru nastavime hodnotu (v tomto pfipadé rotace) na
360*20.

57 Yalue Key [Rotation . P]

Key Properties

Mame |Fotation . P
Time |360F [
Walue (360720 3]

Chceme, aby se vrtule b&hem animace otocila 20 krat kolem své osy, coz mizeme
vyjadrit matematicky jako 20*360 stuprid. Nemusime tedy vypocitavat finalni hodnoty
rotace (7200), protoze je program spocita sam. Jakmile zadame do vstupniho pole
jakykoliv vyraz pomoci matematického vyjadieni (samoziejmé korektné), tak si s nim
program poradi.

V nastrojové paletce animaci stiskneme tlacitko Play.

Vrtule nyni rotuje po celou dobu animace konstantni rychlosti. Ani nezrychluje, ani
nezpomaluje.
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» V Object manageru klepneme pravym tlaéitkem na objekt Propeller1 (vrtule 1)
a z otevieného menu vybereme Show F-Curves (Zobrazit krivky).

4 Edit Wiew Curves Sl

B0 50 120 150 180 210 240 270 300 330 360
[RERTY ERRUTH NARERY ANRUNY ARUNUA FRRANE CRRUNA FRUNNA RRNREY KNRERY ARTHNA RRANEL

E000

4000 4

2000+

Fotation . P01

Tento pfikaz nam otevie F-Curves manager (Spravce kfivek). Alternativou tohoto
postupu je uchopeni objektu vrtule v Object manageru a jeho pfetazeni do F-Curves
manageru. Pomoci F-Curves manageru upravime rychlost ota€eni vrtule tak, aby
nejprve zrychlila a poté zpomalila. V tomto momentu je F-Curve Useckou, coZ znamena,
Ze rotace ma konstantni charakter.

» V menu F-Curve manageru zvolime Edit (Upravy) > Select All (vybrat vse).
Nyni budou oba kli¢ové snimky Use€ky vybrany a zobrazeny ervené.

» Zvolime Curves (kfivky) > Custom Tangents (uzivatelské tangenty) > Soft
Interpolation (jemna interpolace).

Timto pfikazem vytvofime v kliGovych snimcich kfivky tecny, kterymi ji mizeme
upravovat. Tyto te€ny pracuji uplné stejné jako te€ny pfi Upravé beziérovych kfivek.
Kratké te¢ny tedy znadi ostfejsi vrchol, kdezto dlouhé velmi pozvolny.
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» Zvolime Curves (kfivky) > Custom Tangents (uzivatelské tangenty) > Flat
(vyrovnat).

4 Edit Wiew Curves el
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2000+

Fotation . P01
Time: OF --> 360 F Value: 0.000 --> 7200.000

Tangenty jsou vyrovnané a kfivka vypada jinak. Na pocatku kfivka postupné nabiha,
poté zrychli svij rist a na konci se opét postupné vyrovnava do vodorovné polohy.

» Na nastrojové paleté animaci stiskneme tlacitko Play.

Rychlost rotace vrtule se zjevné méni. Na pocatku je rotace pomala, poté zrychli a
na konci zpomaluje, az se vrtule Uplné zastavi. Nicméné mame dojem, Ze se zastavi
pfili§ nahle.

» Pouzijeme ikonu pro pfriblizeni pohledu v pravém hornim rohu manageru F-
Curve a oddalime si kfivku tak, aby u partie pravé ¢asti diagramu kfivky bylo

vice mista.
4 Edit Wiew Curves Sl
1] E0 120 180 240 300 360 420 480 540
WA FRTRE NRRURN RNRREA NENRNA NRRUNA FRRUNY ANNNNA SRUNE] ENUREN NRURE
E000 4
4000 4
2000+
Fotation . P01

Time: OF --» 360 F Yalue: 0.000 -> 7200.000
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» Uchopime fidici bod teény pravého bodu fidici kfivky a potahneme jej doprava,
dokud neni te€na dvakrat tak dlouha.

4 Edit View Curves Sl
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Time: 360 F Yalue: 7200000 > 7200.000

DelSi te€na znamena delSi zaobleni kfivky. Tim, Ze jsme protahli te€nu, jsme vytvofili
jesté pozvolnéjsi a zietelnéjsi zpomaleni rotace nez predtim.

» Stiskneme tlacitko Play a prehrajeme si animaci.

Vrtule ma nyni na zpomaleni podstatné vice €asu nez na zrychleni a diky tomu vypada
pohyb podstatné realisti¢téji.

» Otevieme Timeline (€asovou osu).

» V Object manageru uchopime objekt Propeller2 (vrtule 2) a umistime jej do ¢asové
osy.

Objekt Propeller2 je nyni obsazen v asové ose.

» V casové ose klepneme za stisknuti tlacitka Ctrl na objekt Propeller1 a tAhneme
jej nad objekt Propeller2. Tla¢itko mysi pustime poté, co se objevi symbol pro
kopirovani +.

Timeline | F-Curve I
4 File Edit ‘iew Objects Sequences Layer =3 A|
g Igl Igl Igl Igl o ] | 30 EO 90 120 180 180 210 240 700 300 330 360«

& ® E
EEBEBEEA L DL

# Propeller]|+= Rotation . P|
# Propellerz|®= Rotation . P|

‘
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Zkopirovali jsme parametry animace prvé vrtule na druhou. Poznamka. Za stisknuti
klavesy Ctrl mGzeme tahem mysi kopirovat cokoliv. Jestlize bychom potfebovali zménit
pozici jakéhokoliv atributu, pak staci nedrzet klavesu Ctrl. Prostym tazenim mysSi €i
kopirovanim ,jmen“ objektll v Timeline (¢asové ose) miZzeme presouvat ¢i kopirovat
individualni animaéni stopy pouhym pfemisténim nad jméno jiného objektu.

» Stiskneme tlacitko Play a prehrajeme si animaci.
Druha vrtule nyni rotuje UpIné stejné jako prvni. Snad jsou ale synchronizované az
prilis.

» Umistime v ¢asové ose prvy klicovy snimek u objektu Propeller2 ponékud

doprava. Na snimek 20 (¢islo snimku se zobrazuje pod oknem ¢asovych os).

Timeline | F-Curve I
4 File Edit ‘View Objects Sequences Layer Sl
o o o f o o I 30 EO 90 120 150 180 210 240 270 300 330 360[

& EEEEEE

EEABEEEA L ]
i
=
i

# Propeller]|+= Rotation . P|
# Propeller2|+» Rotation . P|

-

Time: OF Loop: 3F > 3F Selection: 20 F

Diky tomuto posunu kli¢ového snimku za¢ne druha vrtule rotovat az ve snimku 20.
» Pro prehrati animace stiskneme tlaéitko Play.

Vrtule 2 nyni startuje o néco pozdéji nez vrtule 1. Ale pofad je pohyb vrtuli od poc¢atku
rotace do konce vlastné podobny, diky podobnému pribéhu rotace a to nevypada ani
dobfte, ani reélné.

» Otevieme F-Curve manager (Spravce kfivek).

» V Object manageru uchopime objekt Propeller2 a pfetahneme jej do F-Curve
manageru.

Nyni je v F-curve manageru zobrazena druhd vrtule.
» V menu F-Curve manageru zvolime Edit (Upravy)> Select All (vybrat vse).
Jsou vybrany oba fidici body (kli€ové snimky).

» Stiskneme tlacitko mysi nad prvym z obou bodu a potahneme jej nahoru o cca.
35 bodu.

Aby se ndm pozice bodu Iépe nastavovala (jde o velmi malou vzdalenost) tak si mizeme
oblast prvého bodu pfiblizit pomoci ovladacich prvkl okna v levém hornim rohu.
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» Pro prehrati animace stiskneme tlaéitko Play.

Druha vrtule nyni startuje a také zpomaluje viditelné odliSné nez prvni. Animace obou
vrtuli jizZ nevypada tak synchronizované, diky éemuz vypada podstatné vérohodnéji.

Souhrn

Naucili jsme se pouZzivat €asovou osu a pochopili jsme vyznam kfivek F-Curves pro
vytvoreni realistické animace. Av8ak kfivky F-Curves nekontroluji pouze rotaci &i
pohyb, mohou byt pouZity i pro kontrolu v8ech ostatnich parametri animace. Napfiklad,
kdybychom animovali miru jasu svétla, tak opét mizeme pouzit F-Curves pro pomalé
zjasnéni a ostré ztmaveni. Pfidanim kli¢ovych snimkd a zménou tvaru kfivky mizeme
napfiklad docilit efekt viny pro vytvoreni pulsujiciho svétla.

Pomoci F-Curves Ize redukovat pocet kliCovych snimkd na minimum a tim se ndm
zjednodus$uje editace animaci.
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Animovani
parametru

Animace nejsou omezeny jen na
polohu objektu. Je mozZno animovat
taktka veSkeré parametry véech
objektu, moZnosti a kombinace
jsou doslova nekonecné.

Tato scéna obsahuje kouli z
cervené hlinky.

R—

Animace v programu CINEMA 4D nejsou omezeny jen na polohu, rotaci a méfitko.
MiZzeme animovat jakykoliv parametr. V tomto tutorialu si tento fakt budeme ilustrovat
na prikladu animace parametrd: roztaveni objektu a zméné materialu z ¢ervené hlinky
na leskly kov. Stejnym zplsobem, jakym budeme pracovat v tomto tutorialu, mizeme
pracovat s rozli€nymi parametry u jakéhokoliv objektu. A to vZdy, pokud nema parametr
na levé strané u svého jména v Attributes manageru malé ,x"“.

» Nahrajeme si scénu ,Parameter Anim Before.c4d‘ z adresafe Animation
Parameters, ktery je v adresafi CINEMA 4D Tutorials.

DOpen File BE
Look jn: I@Animation-Parameters j & I‘j‘ -

V této scéné se nachazi koule otexturovana materialem cervené hlinky.
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>

>

Zvolime Objects (objekty) > Deformation (deformace) > Melt (taveni) a tim
vytvofime deformator taveni.

V Object manageru premistime deformator Melt ve struktufe pod Sphere
(kouli).

& HyperNURES |sv| &
é—Sphere 0 iy 00 “

Lvat 2|2 v

Zvolime nastroj Move (Posun) a v modelaénim okné premistime deformator na
spodek koule. (Y = -100).

Deformator Melt musi byt nutné umistén vespodu taveného télesa. Kdybychom jej
nechali na plivodnich souradnicich (ve stfedu koule), pak by bylo toto téleso pfi aplikaci
deformatoru ofezavano ve vysce, ve které by byl deformator umistén, tedy y=0. Jestlize
uchopime oranzovy fidici bod, tak mizeme sledovat pribéh taveni.

Ujistime se Ze je posuvnik na ¢asové ose na snimku 0 a v Object manageru
vybereme deformator Melt.

V Attributes manageru nastavime hodnotu Strength (sila) na 0%.

Hodnota Strenght (sila) je v modelaénim okné reprezentovana oranzovym fidicim
bodem.

Klepneme pravym tlacitkem na slovo Strength (Sila) a z otevieného menu
zvolime Animation (Animace) > Add Keyframe (Pridat kli€ovy snimek).

| Melt Dbject [Mel]
DObject Properties
Strength 0% 3l
Add Keyframe Animation 3
[ext Kepframe User Interface 3
Erevious Kepframe b Shovy Subchannels
[relete Kepframe iy

Timto jsme nahrali po€ate¢ni pozici efektu taveni.
Potahneme posuvnik na ¢éasové ose na posledni snimek animace.

V Attributes manageru nastavime hodnotu Strength (sila) na 100%.
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» Opét klepneme pravym tlaéitkem na slovo Strength (Sila) a z vyvolaného menu
zvolime Animation (animace) > Add Keyframe (pfidat kliCovy snimek).

| Melt Dbject [Mel]
DObject Properties
Strength IESE |
Add Keyframe Animation 3
[ext Kepframe User Interface 3
Erevious Kepframe b Shovy Subchannels
[relete Kepframe iy

Timto jsme nahrali koneény stav efektu taveni, objekt se nyni v ase zcela roztéka po
podlaze.

» Umistime posuvnik zpét na snimek 0.
» V Material manageru jednou klepneme na material ¢ervené hlinky.

Altributes | Shap Settingsl
4 Mode Edit UserData

= 5
“Matenal [rew] é 5
| Basic | Calor | Specular IIIuminati0n|
Color
Colar b =] 100z ﬂ
G——F——— 1% 3
B 6% 4
Brightriess [ IﬁU z 3
X Texture Image. . | ﬂ
Sampling [MIF =]
Offset |0 % 3l
Scale ez =
Iz ade [Momal =i
Wi Strenth ooz &

Koule ma pfitazeny material ¢ervené hlinky. Nyni budeme chtit tento material v pribé&hu
animace prfeménit do lesklého kovu. Pfi taveni koule se bude ménit nékolik parametrd
materialu jako barva, odrazivost a odlesk. V Attributes manageru jsou zobrazeny
v8echny parametry materidlu €ervené hlinky. Tfebaze jsme mohli pouZzit pro zmény
materialu editor materialu, tak Attributes manager je jedinym mistem, kde miZeme tyto
parametry animovat a proto jsme jej zvolili.

Poznamka. Jestlize je u néjakého parametru zobrazeno malé ,x“ pak jej nelze
animovat.
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» Zapneme vlastnost Reflections (odrazivost) a kliknutim na zalozku Basic (Zakl.)
v Attributes manageru zapneme stranku s nastavenim této vlastnosti.

Nyni jsme v Attributes manageru na strance Reflection (Odrazivost), ktera je v tomto
momenté nastavena na 0%.

» V Attributes manageru klepneme na stranku Color (barva).

» Pomoci stisknuté klavesy Shift vybereme slova Color (barva) a Brightness
(jas).

» Klepneme pravym tlaéitkem a z vyvolaného menu vybereme Animation (animace)
> Add Keyframe (pridat klicovy snimek).

Altributes | Shap Settingsl
4 Mode Edit UserData
%Material [new] & 5
| Basic | Color | Reflection | Specular |IIIuminati0n|
H L0 Color
Colar vi =] 100z ﬂ
’7 G——F——— |1z 3
o |B———F——|#x 3
Brightriess [ IﬁU FE |
| Add Keyframe | Animation L

[ext Kepframe Show Subchannels

Timto jsme nahrali do snimku 0 informace o barvé a jasu materialu. Jako vZdy kdyz
nahravame parametry, tak se po nahrani snimku objevi €ervena te€ka. Kdyz zménime
posuvnikem na ¢asové ose snimek, tak se z ni stane €erveny kruh. Ten upozorfiuje
na skute€nost, Ze tento parametr obsahuje néjaky kli€ovy snimek, ale v jiném snimku,
nez na kterém se pravé nachazime.

Jesté jedna poznamka k animaci materiald, posuvniky RGB jsou zaznamendavany
nezavisle na posuvniku Brightness (jas).

» Klepneme na zalozku Reflection (odrazivost).
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Jestlize pouzivame platformu ).
Mac, pak stiskneme tlaéitko
Command.

Nahravame klicovy snimek
pro hodnotu jasu u parametru
odrazivosti.

Jestlize pouzivame platformu .
Mac, pak stiskneme tlaéitko
Command.

Nahravame klicovy snimek pro
parametr odlesku.

Klepneme pravym tlacitkem na Brightness (jas) a zvolime Animation (animace)
> Add Keyframe (pridat kliCovy snimek).

Altributes | Shap Settingsl

4 Mode Edit UserData
“Material [new] ﬁ
Reflection
Color > R ooz 3
G M ESE |
» |B N ESE |
Brightriess ——|oz 3l
| Add Keyframe | Animation 3 —ﬂ
Iext Kepframe User Interface 3 Z

Nahrali jsme prvy klicovy snimek parametru odrazivosti s hodnotou jasu 0% do
snimku 0.

Klepneme na stranku Specular (odlesk).

Se stisknutou klavesou Shift klepneme na parametry Width (Sitka) a Height
(vyska).

Klepneme pravym tlaéitkem a z vyvolaného menu zvolime Animation (animace)
> Add Keyframe (pfidat klicovy snimek).

Altributes | Shap Settingsl

4 Mode Edit UserData
“Material [new] ﬁ
Mode Plastic =]
‘width RS B
Height TH 3l
| Add Keyframe Animation 3
[dext Kepframe User Interface 3

Odlesk je na pocatku animace velmi maly, tak jak se slusi pro material hlinky. Mame
nyni nahrané klicové snimky u vSech parametri materialu, které budeme potfebovat
morfovat, aby vznikl material lesklého kovu.
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» Pfemistim posuvnik na posledni snimek animace.

» V Attributes manageru klepneme na stranku Color (barva) a zménime barvu
materialu na bilou (R = 100%, G = 100%, B = 100%) a hodnotu Brightness (jasu)
nastavime na 0%.

Vysledkem je ¢erna barva. Mohlo by se zdat snaz§i pouze nastavit hodnotu jasu na
0% a viibec neménit nastaveni barvy. VZdyt vysledek je ¢erny. Ale diky nastaveni
vysledné barvy na bilou se barva méni na Sedou a zaroven tmavne, coz je rozdil, nez
kdyby pouze Cervena barva tmavla do ¢erné.

» Se stisknutym Shiftem oznacime parametry Color (barva) a Brightness (jas).

Jestlize pouzivame platformu p. Klepneme pravym tlaéitkem mysSi a z menu vybereme Animation (animace) >

Mac tak stisk tlagitk - P
e “erg‘f,m?,f;ng_ Add Keyframe (pfidat kli¢ovy snimek).

Pfidali jsme kli¢ovy snimek

g ! Altributes | Shap Settingsl
parametrim barvy a jasu.

4 Mode Edit UserData

“M aterial [new] ﬁ

i

oColor [ R Af100% 3

’7 G {|1o0% 3

v |B | |1o0% 3

o Brightness J' ID_°/° =

| Add Keyframe Animation Y

[ext Kepframe Show Subchannels

» Klepneme na stranku Reflection (odrazivost) a nastavime posuvnik parametru
Brightness (jas) na 100%.

Jestlize pouzivame platformu . Klepneme pravym tlacitkem mysi a zvolime Animation (animace) > Add Keyframe
Mac tak stiskneme tlacitko - o ., .
command.  (pFidat kli¢ovy snimek).

Nahrali jsme klicovy snimek s

Attribut i
hodnotou odrazivosti 100%. e | B Settlngsl

4 Mode Edit UserData
ﬁMaterial [new] ﬁ E
-

Reflection

Colar v =] 1003 ﬂ

’7 G M ESE |

v |B N ESE |

o Brightness [ IﬁU x |d

Add Keyframe Animation 3 ﬂ

Iext Kepframe User Interface
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» Klepneme na stranku Specular (odlesk) a nastavime hodnoty Width (Sifka) na
50% a Height (vysSka) na 100%.

Timto dodame materialu vysoky a ostry lesk, podstatné jasnéjsi nez byl na pocatku
animace.

» Stiskneme klavesu Shift a oznacime parametry Width (Sifka) a Height
(vyska).

Jestlize pouzivame platformu ) Stiskneme pravé tlac¢itko mysi a zvolime Animation (animace) > Add Keyframe
Mac, tak stiskneme tlacitko .. o , P
command.  (pFidat kli¢ovy snimek).

Nahrali jsme kliCovy snimek s

P . Altribu i
novymi hodnotami odlesku. = | S Semngsl

4 Mode Edit UserData

ﬁMaterial [new] ﬁ
Specular
Mode IPIastic =1

& width 50 % E|

o Height [IESE|
| Add Keyframe Animation 3
et Keyframe: User Interface 3

» Z hlavniho menu vybereme Render > Render Settings (nastaveni renderingu)
a na strance Save (ulozit) nadefinujeme cestu a jméno souboru ve formatu
QuickTime movie, ktery bude obsahovat nasi animaci.

Ku pfikladu mazeme animaci ulozit na plochu, kde ji snadno najdeme.

» Z hlavniho menu zvolime Render > Render to Picture Viewer (renderovat do
prohlizeée) a vytvofi se animace ve formatu QuickTime movie.

Nékolik snimku z animace.
oY i

Rendering zabere nékolik minut. Kdyz skonéi, poklepeme na vytvoreny klip a miZeme
se podivat na finalni animaci, ve které se bude morfovat koule do kaluze tekutého kovu.
Kdy?Z si pfehrajeme animaci pozadu, tak tento efekt uvidime mozna jesté 1épe. Zda se,
Ze se z kaluze kovu formuje koule.
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Souhrn

Prace na tomto tutorialu nam patrné dodala velké mnoZstvi napadt o jinych efektech a
vyuZiti parametr(, které by mohly byt animovany. MdZeme animovat jas a Uhel kuzele
svétla, ¢i vinéni vodni plochy pomoci shaderu vody. P¥i vizualizaci starnuti kovové
konstrukce mudZeme animovat materidl, ktery se bude ménit z lesklého kovu na rezavy
a hrbolaty.

V programu CINEMA 4D se d& animovat takfka jakykoliv parametr, moznosti jsou
témeér nekonecné.
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Nastaveni fizeni
1

S vyuZitim oviddacich klica
muZeme ovlddat pomocr jednoho
parametru parametr jiny. Touto
metodou muZeme redukovat
mnoZstvi potfebné prace.

Nastaveni Fizeni (Driven Keys) je relativné jednoduchy postup pfi kterém animaci
jednoho parametru objektu animujeme mnoZstvi jinych parametr(i. Nastaveni fizeni
se pouziva v kazdé situaci, kdy potfebujeme ovladat jeden objekt druhym. Np¥. regulaéni
vypina¢ kontroluje intenzitu svétla Zarovky, tlacitko kontroluje zavérku fotoaparatu,
dokonce i rotace vietynka mlzZe byt nastavena na zakladé nastaveni fizeni.

Tento tutorial obsahuje jednoduchy pfiklad, pfi kterém dostaneme pod kGzi zakladni
praktiky této technologie (pokrocilejsi priklad nasleduje v dal§im ¢lanku). V tomto malém
pfikladu tedy nastavime kontrolu poloméru koule pohybem krychle.

» Nahrajeme scénu pojmenovanou ,SetDriven Simple Before.c4d‘ z adresare
Animation - SetDrivenKeys 1 v adresafi CINEMA 4D Tutorials.

Tato scéna obsahuje kouli a
krychli.

DOpen File EHE
Look jr: I@Animation-SetDrivenKeys‘I j = EF '

SetDriven Simple After.c4d
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Nasim cilem je kontrola
poloméru koule v zavislosti na
poloze krychle.

» V Object manageru vybereme objekt Cube (krychle).

» V Attributes manageru klepneme na zalozku Coord. (Sourad.)

Stranka se soufadnicemi zobrazuje stavajici pozici (P), méfitko (S) a rotaci (R)
krychle.
Uzivatelé platiormy Mac . Klepneme pravym tlacitkem na pismeno Y z P.Y a zvolime Animation (animace)

stisknou klavesu Command. . Py o~
> Set Driver (nastaveni fizeni).

Timto definujeme pozici ve
sméru Y coby Fidici parametr.

Hodnota pozice krychle Y je nyni fidicim kontrolujicim parametrem. Poznamka. Je rozdil
mezi kliknutim na pismeno Y a pismeno P v P.Y. Kliknuti na P je prostfedkem k vybéru
vSech parametrd tfi os, kdezto klepnutim na Y vybereme pouze osu Y.

» V Object manageru vybereme objekt Sphere (koule).

» V Attributes manageru klepneme na zalozku Object (Objekt).
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» Pravym tlacitkem klepneme na slovo Radius (Polomér) a zvolime Animation >

Set Driven (Absolute) (nastavit absolutni Fizeni).

=
5 °Sphere Object [Sphere]

Object Properties
Radiuz [100m 3]

Add Keyframe Animation L3l
[ext Kepframe User Interface » 2l
Frevious Kepframe V' Show Subchannels
[relete Kepframe G
Add Track Easte
Copy Track Faste [dentizal
Easte Tirack Select Al
[elete Track Deselect Al
o Trach Edit Ertry. .
Show E-Curve i B
Sl Load Data..
| Set Driven [Absolute] Cave Data

Set Driven [Relative)

VySe vyvolané menu obsahuje dva typy pfikaz( Set Driven (nastaveni fizeni). U
absolutniho typu je prostfedkem pro prvni parametr pfimo pouzita hodnota Fidiciho
parametru. V nasem pfipadé to byla poloha hodnoty krychle Y=100, éemuz odpovida
polomér 100. Relativni rezim pracuje ponékud jinak, méni ovlddané parametry na
zakladé soucasné hodnoty fidiciho objektu. Tento rozdil se pfimo neprojevi u naseho
pfikladu, ale v jinych urcité ano. Pfedstavme si kontrolu pozice jednoho objektu druhym.
P¥i pouziti absolutniho médu se bude ovladany objekt pohybovat naprosto stejné, jako
objekt fidici, ale pfi pouZziti relativniho médu by zlistaval ovladany objekt ve stejné pozici
a pohyboval by se pouze pomérné k pohybu objektu fidiciho.

Zvolime nastroj Move (Posun) a v modelovacim okné - viewportu budeme ménit
pozici krychle a sledovat zmény poloméru probihajici na krychli.

Polomér koule je nyni kontrolovan pozici krychle podél osy Y. To je to, co jsme chtéli
nastavit. Nyni kontrolujeme parametrem jednoho objektu parametr jiného objektu.

Souhrn

Nastaveni fizeni je velmi silnym nastrojem programu CINEMA 4D. Vidéli jsme extrémné
jednoduchy pfiklad ovladani vlastnosti jednoho objektu jinym objektem. MoZnost pouZiti
tohoto nastroje je ale takika neomezena, jak se ostatné pfesvédcime na nasledujicim
pfikladu.
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Nastaveni fizeni
2

Dalsi fascinujici priklad propojeni
vilastnosti objektu, jehoZ celkova
animace je ovldddna pouze jednim
objektemn.

Tato scéna obsahuje fadu kosti
ocasu §tira.

U tohoto pfikladu si nastavime fizeni objektli o néco komplexnéji nez v predeslém
¢lanku a pfedvedeme si tuto technologii na skute¢né praktickém pfikladu. PouZzijeme
fadu kosti v ocasu $tira a vS§e nastavime tak, Ze pouhou rotaci prvé kosti bude dochazet
ke sta€eni celého ocasu. V tomto projektu uvidime, Ze technologie fizeni objektd neni
omezena pouze na dva parametry. Jeden parametr mGzZe kontrolovat velky pocet
jinych parametr(.

Nahrajeme si scénu pojmenovanou ,ScorpionTail Before.c4d‘ z adresare
Animation -SetDrivenKeys 2 v adresafi CINEMA 4D Tutorials.

DOpen File EHE
Look jr: I 5 Animation - SetDrivenkeys 2 j = EF '

@ ScorpionTail After.c4d
ScorpionTail Before, c4d

V ocasu $korpiéna jsou asociované kosti a kdybychom pootoc¢ili ¢i popotahli nékterou z
téchto kosti, tak by se ocas podle tohoto pohybu nalezité deformoval. My v§ak chceme
nastavit automatické stahovani ocasu na zékladé rotace prvé kosti.
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» V Object manageru vybereme kost Bone1.

Tato kost bude Ffidicim objektem. HyperNUIRES 5@ y -
i ,i\ s [P if?'
é—Bone‘I V M EJ

Tato kost je prvou, tzv. matefskou kosti z fady. Nastavime tuto kost tak, aby jeji rotace
kontrolovala rotaci ji podfizenych kosti.

» V Attributes manageru klepneme na zalozku Coord. (Sourad.)

Na této zaloZce muZeme vidét hodnoty polohy, méfitka a rotace kosti. Nas budou
zajimat pouze hodnoty rotace (R).

Uzivatele platformy Mac » Klepneme pravym tlacitkem na jakékoliv ze tfi pismen R a zvolime Animation
(animace) > Set Driver (nastavit Fizeni).

stisknou tlac¢itko Commnand.

Kliknutim pravym tlac¢itkem na
pismeno R pfifadime funkci
v8em tfem osam rotace.

ek
I'm
Add Keyframe
[ext Kepframe

Erevious Kepframe
[elete Kepframe

2 5. 2l R.H|O® i
o S A R.PJO° B
Animatian I R.B ﬁ

b Show Subchannels

Copy
Easte

Add Track Fazte [dentical
Copy Track Select Al
Faste Track Deselect Al
Welete Tirack
Edit Entre...

Show Track Femave Entry
Shioy F-Curve

. Load Data..
Set Driver Save Data...

Set Driven [Sbsolute]
Set Driven [Felative]

Pro fizeni pohybu podfizenych kosti chceme pouZit vSechny osy rotace a nikoliv pouze
jednu. Misto klepnuti na H, P &i B tak klepneme na R a tim je funkce pfifazena vSem

osam.

» V Object manageru zvolime objekt druhé kosti Bone2.
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» V Attributes manageru klepneme opét pravym tlacitkem na nékteré ze t¥i
pismen R a zvolime Animation (animace) > Set Driven (Absolute) (nastavit
fizeni—absolutni).

. i r\ \.J LB Y H I P D - ﬂ
Add Keyframe Animation 3 r el E|
[ext Kepframe W Show Subchannels
Frevious Kepframe G
[relete Kepframe Fosie
Add Track Faste [dentical
Copy Track: Select Al
Pasiz Trac Deselect Al
[elete Track
Edit Entry...
St Track Femave Entr
Shioyy E-Curve
Load Data..
Set Driver ST
| Set Driven [Absolute]
Set Driven [Relative)

Rotace kosti Bone2 je nyni kontrolovana rotaci kosti Bone1.
» V Object manageru zvolime tieti kost Bone3.

V Attributes manageru klepneme pravym tlaéitkem na pismeno R a zvolime
Animation (animace) > Set Driven (Absolute) (nastavit fizeni—absolutni).

v

TaktéZ rotace kosti Bone3 je nyni oviadana kosti Bonel. Pfed timto krokem jiz neni
nezbytné opétovné natavovat Set Driver (nastavit fizeni) pro kost Bonel. Program si
pamatuje nastaveni z v predeslych krokl. Parametr Set Driver (nastaveni fizeni) staci
nastavit jen jednou a poté jiz nastavovat parametr Set Driven podle potfeby.

» Zopakujeme cely postup z predeslych kosti na zbyvajici podfizené kosti.

Rotace vSech podfizenych kosti je nyni ovladana rotaci kosti Bone1.
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Nasledkem rotace kosti Bonel je
staceni celého ocasu.

» V Object manageru zvolime kost Bone1l.

» Vybereme nastroj Rotate (rotace) a v modela¢nim okné pooto¢ime kost Bonel
okolo osy X (Gervena).

Pfi rotaci kosti Bone1 se budou sta€et vSechny podfizené kosti a tim cely ocas (nejvice
je tento efekt zietelny v ose X). Animace pohybu ocasu $korpiéna by nyni byla velmi
shadna.

Souhrn

Tento pfiklad odhaluje pouze fragment toho, co Ize dokazat pomoci technologie
nastaveni fizeni. Mizeme naptiklad ovladat jas na fadé svétel pohybem objektu nahoru
a dolu a tim simulovat regulaéni vypina¢. Jinym pfikladem muZe byt vyduti svalu na
horni ¢asti paze, vyvolané rotaci spodni ¢asti.

Nastaveni fizeni je vlastné jen jednodusi verzi pouZiti diagramového systému pod
nazvem XPresso. Kdykoliv pouZijeme nastaveni fizeni, tak se ,v pozadi“ scény vytvofi
malé nastaveni XPresso. Poklepanim na tag XPresso u objektu kosti bychom otevfeli
editacni okno systému XPresso a zde Ize spatfit nadefinované vztahy mezi objekty. V
pristich tutoridlech si ukaZeme, jak se pomoci tohoto editacniho systému tvofi podstatné
komplikovanéjsi a sofistikovanéjsi vazby.
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XPresso 1,
funkce Clamp
a uzivatelska
data

Nendsilnym uvodem do mocného
svéta ndstroje XPresso bude
vyroba jednoduchého nastavent,
kterym omezime pohyb objektu tak,
aby nebylo mozno jej umistit nize,
neZ do jisté hranicni vysky.

mﬁctive Tonl TSnapi Settings 1

4 Mode  Edit  User Data
. Cube Object [Cubs]

Border [0 m

- 868 XPresso Editor |
3 ‘k File Edit Layout View Custom Calculate E
W #Group

4 Edit
Systemﬂperators =3

System Presets [
Default

Cube

Border
al Position . Y
e :

MlzZe se stat, Ze obas budeme chtit omezit moznost pohybu objektu. Typickym
pfikladem muZe byt noha, ktera nesmi pfi pohybu pronikat podlahou. Této a podobnym
situacim Ize snadno predejit pouZitim editoru XPresso a funkce Clamp.

PFidani uzivatelskych dat (user data) nam zpfistupni kontrolu pomoci nastaveni XPresso
uvnitf Attributes manageru, ktery nam poskytuje maximalni flexibilitu, zatimco se
soubé&zné zachovava nase nastaveni XPresso editoru.

V tomto tutoridlu zabranime krychli, aby se mohla “potopit”. Tedy omezime jeji pohyb
ve vertikalnim sméru.

» Vytvofime novou prazdnou scénu.
» Vlozime objekt Cube z nabidky primitivnich objektu.
Parametry krychle neni tfeba upravovat.

Uzivatelé platiormy Mac . Klepneme v Object manageru pravym tlacitkem na objekt Cube (krychle) a
stisknou klavesu Command. ~e y . . . . .
pfidame objektu tag Xpresso expression zvolenim Expression > XPresso
Expression.

Po pfidani tagu XPresso expression k objektu se otevie editatni okno XPresso
editoru.
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» Uchopime objekt Cube v Object manageru a tazenim jej preneseme do XPresso
editoru.

Pridanim vlastnosti XPresso

objektu a tazenim tohoto objektu | k? m ﬁstimcture*larowéeﬂ
i

do editoru XPresso se vytvori = = -
: 4 File Edit Objects Tags Texture

nod, ,,uzel“ objektu Cube. | =
sano cu @ v-E% -

eo0e XPNgsso Editor

‘k File Edit Layout VYiew Custom Calculat\

anager @ S i
4 Edit I |
+-5ystem Operator: |
+-5ystem Presets |
Default |
1
4 * | Object:Border:RealReal) - - > Clamp:Min:Real {Real) |

Po pretahnuti krychle do XPresso editoru se v editoru vytvori ,uzel“ tohoto objektu, ktery
obsahuje vSechna data nezbytna pro integraci s jinymi objekty v XPresso editoru.

» Klepneme na cerveny étverec uzlu objektu Cube a vytvofime vystupovy port
pro globalni pozici Y, zvolime Coordinates > Global Position > Global Position.Y.
Podle potfeby muzeme zménit velikost okna uzlu.

Globalni pozice zadavana ve — T
vystupnim portu se muze ménit Local Matrix
pomoci nabidky parametri u System Presets
uzlu objektu Global Matrix
) Object

‘| Dhject:Border:Real { Real ) --» Clamp:Min:Real (Real)  Previous position

F Positin =0hje Previous rotation

Start Distance lﬁ__ Previous scale
History Depth 1 73] Previous global matrix

Path Previous local matrix

Position velocity
Rotation welocity
Scale velocity

. Basic Properties 3
Position 3
Scale » | Object Properties 4
Rotation L3

Global Position

Global Rotation » Global Position . X

Global Position . ¥
Glnhal Pnzitinn 7
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Pouzivame li platformu Mac tak ).
stiskneme tla¢itko Command.

Uzel Clamp (omezeni) ovlivni
svymi vystupnimi hodnotami
omezujici limity.

Vrchni limit omezuje vzdalenost
pro uzel Clump a je vysoce
praktické neomezovat
(nechceme li) objekt nizkou
hodnotou.

Jak je zfejmé, tak se pozice krychle nastavuje adekvatné ke svym osam, kdy kazda z nich
je prezentovana korespondujicim vystupnim portem uzlu objektu krychle. Poznamka.
Je rozdil mezi pouzitim v portu globalnich a lokalnich dat, pouZiti globalnich hodnot se
pouziva v pfipadé, Ze je objekt umistén hierarchicky pod jinymi objekty a poloha t&chto
objektl by ovliviiovala pozici objektu, coZ by bylo nezadouci.

V XPresso editoru klepneme pravym tlaéitkem do prazdné plochy a z menu
zvolime Clamp node (omezeni) (New Node > XPresso > Calculate > Clamp).
Tazenim mysi propojime uzel Cube s uzlem Clamp mezi parametry Global
Position. Y a vstupni (modrou) polozkou Value (hondota).

[ i | |

0086 XPresso Editor
4 File Edit Layout  Yiew Custorn  Calculate
— |
=Pael] () KGroup )

@ Max
@ Value

System Dperatoﬂ Cube
System Presets i
| Global Position . ¥ &

Yalue:Real { Real ) A

Start Pnaitinn This [Thiee

Uzel Clamp je zde pouZit pro ovlivnéni pozice Y za nastaveni meznich limit( pohybu.
Objekt nemuzZe prekrogit tyto limity nastavené v této funkci a bude se pohybovat pouze
v rozmezi téchto hodnot.

Poklikanim na vrchni pasek zvolime uzel Clamp a v Attributes manageru, na
strance Parametr nastavime vysokou hodnotu Max, napfiklad 1000000.

g Clamp Dperator [Clamp] & E
| Basic | Hode |Parameter|
Parameter

Min[o ]

Max (1000000 '¢]

Pouzitim Attributes manageru mohou byt pfifazené hodnoty do vystupu portu bez pouZziti
dal§iho uzlu, jako napfiklad uzlu Constant. Nastavenim vysoké hodnoty do hodnoty
vystupu Max jsme jakoby virtualné vypnuli horni omezeni pro pfipad, Ze bychom chtéli
posouvat krychli vzhiru. Hodnota Max reprezentuje maximalni povolenou hodnotu
pro konkrétni omezeni.
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» V Object manageru zvolime krychli a v Attributes manageru pfidame objektu

parametr uzivatelskych dat a to pomoci volby User Data (uzivatelska data) >
Add User Data (pfidat uzivatelska data).

Add User Data

Mame -:Data|
Data Type '_Float I's ]
Interface :Float T]
Unit _.Percent s 1
Frin 0% 5
@ [100% )
Step E

Cancel 0k

Vrchnilimit pohybu krychle je definovan pomoci hodnoty Max uzlu Clamp. Chceme, aby
spodni hodnota limitu polohy podle osy Y z(lstala variabilni (pro nasledné modifikace
nastaveni XPresso), a z toho dlvodu pouze nenastavime hodnotu Min u uzlu Clamp.
Tento uzel je nezbytny pro definovani limitl, ale odlisSné od aktualni pozice krychle a
nemuZe byt tak lehce zpfistupnén a editovan pomoci nastaveni XPresso. Pro tuto
moznost editace zde mame User data (uZivatelska data) — pomoci kterych mizeme
individualné manipulovat a upravovat limitni hodnoty uzlu objektu v XPresso editoru.

Poznamka, musime se ujistit Ze jsme vybrali objekt krychle Cube a ne XPresso tag
za objektem, jinak by byla uZivatelska data pfifazena tagu XPresso a nikoliv objektu
samotnému.

V dialogovém okné User Data (uzivatelskych dat) viozime jméno Border
(hranice).

Kdyz zvolime ,add user data“, tak se automaticky otevie dialogové okno pomoci
kterého definujeme nezbytné parametry. Nejdfive vlozime pfijatelné jméno. Jméno
Border (hranice) odpovida nastaveni hodnot kontrolujicich spodni ohrani¢eni volného
pohybu krychle.

Nastavime Data Type na Float (typ dat, plovouci).

Stejné jako uzivatelska data budou kontrolovat spodni limit (min) uzlu Clamp, tak je typ
dat zpusobem tohoto omezeni. Definujeme typ dat na plovouci — &isla s desetinnym
mistem, ktera jsou rozdilna od prostych celych &isel.

Nastavime Interface na Float (rozhrani, plovouci).

Nastaveni rozhrani na plovouci nam doda do Attributes manageru vstupni pole
nasich uzivatelskych dat, pomoci kterého muzeme zadavat hodnoty, které budou
pouZity coby spodni hodnoty omezeni.
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» Nastavime jednotky na metry.
» Nastavime hodnoty Min na —1000 a Max na +1000.

Hodnoty Min a Max definuji rozsah hodnot, se kterymi se bude v uZivatelskych datech
pocitat. Hodnoty mimo tyto limity nebudou akceptovany. Jsou to hodnoty, v jejichz
rozmezi muZe byt definovana spodni hranice pohybu krychle.

» Nastavime hodnotu Step (krok) na 1 a stisknutim tlaéitka OK dialog zavieme.

Koneéné nastavime velikost intervalu kroku. Velikost kroku 1 zvétSuje a zmen$uje
hodnoty uvnitf Max/Min limitu o 1 jednotku.

Vytvofili jsme uzivatelska data,
pro ktera jsme zadali jméno, typ Add User Data

dat a hodnoty ohraniceni. Narne
Interface :@
& vin
v

Step 1m %
!Cancel !

Poznamka, k objektim muZeme pfidat jakykoliv po€et uZivatelskych dat. V naSem
ptipadé nam ale staci jedno pole uZivatelskych dat.

» Klepneme na cerveny ctverec uzlu Cube a z nabidky zvolime User Data >

Border.
Cube
Global Position . ¥

System Operator
Yalue:Real { Real )

Uzivatelska data Border se
vyberou z menu vystupni éasti
uzlu.

Local Matrix
Global Matrix
Object

Previous position

System Presets
Default

Previous rotation
Previous scale
Previous global matrix

Previous local matrix

a0F) Wl

Position velocity

A 303 0) JEEN

Materials

Rotation welocity

Scale velocity

Basic Properties 3
Coordinates 3
Object Properties (.
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Spojeni mezi portem Border
uzlu Cube a portem Min uzlu
Clamp zapne kontrolu spodniho
limitu omezeni Clamp pomoci

uzivatelskych dat Border.

KdyZ jsou uZivatelska data pfifazena objektu, tak také mohou byt od tohoto okamzZiku
pouzivana jako normalni vystupni port uzlu. Hodnota vystupu se nastavuje v Attributes
manageru. V tom je nastavena hodnota Border 0. Tato hodnota je limitovana oblasti
Max/Min, tedy —1000 az 1000.

V uzlu Cube klepneme na jméno portu Border a tahneme jej nad port Global
Position.Y.

Spojime port krychle Border s portem Min omezeni Clamp.

0086 XPresso Editar

4 File Edit Layout  Yiew Custorn  Calculate

AGroup

Cube

Object:Border:Real {Reald - - > Clamp:Min:Real {Real )

Spojeni mezi portem Border a portem Min neustéle vysila hodnoty uZivatelskych dat
Border do portu Min, uzlu omezeni Clamp. To také znamena, Ze se toto omezeni da
editovat mimo XPresso editor, pomoci Attributes manageru, kde miZeme konstantné
ménit spodni limit pohybu podél osy Y. Jedinym poZadavkem je, abychom méli v Object
manageru vybrany objekt krychle, protoZe jinak se nam nemU(zZou zobrazit parametry
tohoto objektu v Attributes manageru.

Poznamka, jestlize se nam nezamlouva ,Float“ plovouci vstupni pole, pak miZeme
provadét zmény nastaveni pomoci posuvniku vyvolaného z menu po stisknuti pravého
tla¢itka mysi na jménu uzivatelskych dat.

V Object manageru uchopime objekt Cube a znovu jej pfenesem do XPresso
editoru.

V uzlu Clamp je port Output, ktery je vystupem omezujicich hodnot pohybu krychle. Pro
aplikaci efektu musime tyto hodnoty ,pfeposlat do hodnot pozice krychle podél osy
Y. Proto je potfeba novy uzel krychle (Cube), ktery je vytvofime op&tovnym taZenim
objektu Cube z Object manageru do XPresso editoru. Tento zpusob, nékolik uzld téhoz
objektu, miZzeme pouZit i v jinych pfipadech.
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Omezujici hodnoty se ,otaci“
zpét a opét vstupuji do
omezovaného objektu.

» V XPresso editoru klepneme na levy modry Etverec uzlu Cube a zvolime

Coordinates > Global Position > Global Position.Y a upravime velikost okna
podle potieby.

» Spojime vstup Global Position.Y s vystupnim portem uzlu Clamp.

806 XPresso Editor
ﬁ'\ File Edit Layout View Custom Calculate
T - Manager f—”:P'O'O-ﬂ |. HGroup EY

14 it I
E Systemﬂperators €

. Cube
Global Position . ¥ & @ Global Position .Y

Nyni si mGzeme zkusit pohybovat krychli. Zjistime, Ze nemGzeme pohybovat mimo
spodni zadanou hranici, nez ktera je zadana v uZivatelskych datech Border. V Attributes
manageru mizeme zménit vychozi hodnotu 0 na jinou a to v mezich dfive zadanych
omezeni Max/Min.

System Presets €
Default €

Souhrn

Vidéli jsme jak pracuiji vstupni a vystupni porty uzld v prostfedi XPresso editoru. Vstup
uzlu dostava hodnoty z jinych vystupnich portd jinych uzlG. V Attributes manageru
muZeme nasledné kontrolovat vstupujici hodnoty portu. Pridani uZivatelskych dat ndm
umoznilo nastavovat vlastni hodnoty ve vstupnim portu.
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XPresso 2,

kontrola
materialu

a chovani
(tagu)

Zobrazena koule na obrdzku
poskakuje po krivce a pfi

tomto pohybu méni pfi dotyku
s cestou pohybu barvu.

= :

Wﬁctive Tonl TS nap Setti ngs}

4 Mode Edit User Data

A Base Object [Sphere] 6 E
Height
XPresso Editor |
ayout  Yiew Custom  Calculate E

AGroup

Formula

ABS(SINCE1*3600) O

lamp:Output:Real { Real ) - - > Object:Colar . G:Real{Real )

THATTTER lddl 4 E eIl 10 e e EE

XPresso muzZe byt pouZito pro kombinaci rozdilnych parametrd objektu, tagd a materiald.
V tomto tutoridlu se budeme zabyvat kombinaci pravé téchto tfi elementl. Vytvotime
kouli, ktera se bude poskakovat podél cesty tvorené kfivkou a béhem téchto pohybu
bude koule ménit barvu.

» Vytvofime novou prazdnou scénu.
» Vlozime do scény primitivni objekt Sphere (koule).
Tato koule bude naSim poskakujicim mic¢kem.
» Zvolime Spline Primitive > Circle (primitivni kfivka, kruh) z menu Object.

Pouzijeme kruhovou kfivku na cestu pro pohyb naseho poskakujiciho micku.
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Micek bude poskakovat podél
této krivky.

Uzivatelé platformy Mac
stisknous tlac¢itko Command.

Chovani Align to Spline (natoéit
ke kfivce) automaticky posune
objekt Sphere na kfivku.

>

>

PFi vybraném objektu Circle v Object manageru klepneme na stranku Object
v Attributes manageru a ujistime se, Ze je nastavena rovina XZ (horizontalni
orientace).

Circle Object [Circle] ﬁ 5
ST R

DObject Properties

] Ellipse

[ Ring

Radius

Radius ¥

Inner Radius
Plane

1 Reverse

Umistili jsme kfivku do roviny XZ, tedy je poloZena na ploSe. Koule se bude pohybovat
po krivce a pfi tom skakat nahoru a dol podél osy Y. Dal§i zmény na objektu jiz délat
nemusime.

V Object manageru klepneme pravym tlaéitkem na objekt Sphere a z menu
zvolime New Expression > Align To Spline Expression (nové chovani, natacet
ke kfivce).

V Object manageru vybereme tag Align To Spline (natacet ke kfivce), uchopime
objekt Circle a pretahneme jej do dialogového okna Spline Path (Cesta ke kfivce),
které je v Attributes manageru.

o !Structure | Browser

_ | % File Edit Objects  Tags Texture

|:Circ|e !:\f
Sp\e o =~" %
|

rm'ti"lﬁu\é'YActive Tool Y Snap Settings |
[% Mose\ Edit User Data

|

I
I ;‘ Align o Spline Expression [Align To Spline] ﬁ 5
(eic | Ta0\

|| Basic Prop

ties

Spline Path |
L

2@

Rail Path |
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Uzivatelé platformy Mac pouziji p
tlaéitko mysi za stisklé klavesy
Command.

Pfeneseni tagu Align To Spline
do XPresso editoru.

Stejné jako objekty tak i tagy
muzeme tazenim umistit do
XPresso editoru.

P¥i pouZiti chovani Align To Spline (natogit ke kfivce) bude objekt sledovat cestu
tvofenou kfivkou. Aby se objektu urcilo kterou kfivku ma sledovat, tak je tfeba uchopit
a prenést kfivku do vstupniho pole pfislusného tagu chovani daného objektu. Tazenim
a umisténim objektu Circle do vstupniho pole jsme sdélili kouli, Ze toto je kfivka, ktera
je cestou jejiho pohybu.

Nastaveni funkce Align To Spline (natacet ke kfivce) v Attributes manageru také
obsahuje hodnotu Position (pozice), ktera je udavana v procentech. Touto hodnotou
kontrolujeme pozici koule na kfivce. Kdyz ji zménime, tak se zméni i poloha koule.
Pro pohyb koule podél celé délky kfivky je tfeba nastavit hodnotu pfi animaci na 0%
a100%.

V Object manageru stiskneme pravé tlacitko nad objektem Sphere a zvolime
New Expression > XPresso Expression (nové chovani — XPresso).

Po pfidani tagu XPresso objektu koule se automaticky otevie okno XPresso editoru.

V Object manageru uchopime tag Align To Spline (natocit ke kfivce) a tazenim
jej umistime do XPresso editoru. Je li potieba tak zménime velikost uzlu.

u
&

Po preneseni tagu do okna se XPresso editoru se vytvofil uzel tohoto tagu.
V XPresso editoru klepneme na modry roh uzlu Align To Spline a zvolime Tag
Properties > Position (nastaveni vlastnosti, pozice).

8006 XPresso Editar

ﬁ': File Edit Layout View Custom Calculate

AGroup

Systemn Operator:
System Presets

Default &ilign To Spline
@ Position

IMath:Output:Real{ Real ) - - > Clamp:Y¥al ue:Real { Real )

Kliknutim na modry roh uzlu a vyb&rem parametru tagu jsme vytvofili vstupni port.
PFidali jsme uzlu port Position (pozice), pomoci kterého budeme schopni XPressem
kontrolovat polohu koule na kfivce. Hodnota pozice 0% odpovida startovnimu bodu a
prvému bodu kfivky, hodnota 100% odpovida kone¢nému bodu a poslednimu bodu
kfivky. (U kruhu se prvy a posledni bod navzajem ,kryji, jsou na stejném misté).
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Uzivatelé platformy stisknou . V prazdné ploSe okna XPresso editoru klepneme pravym tlaitkem a zvolime
New Node > XPresso > General > Time (novy nod, XPresso, hlavni, ¢as).

klavesu Command a kliknou
tlaéitkem mysi.

Diky pouziti uzlu Time muzeme
kontrolovat prubéh animace.

XPresso Editor

Wiew Custom  Calculate

80e
4 File Edit

Layaut

AGroup

Systemn Operator: GG S
System Presets Dbject
pefeult ConvertTo¥Group | Thinking Particles »  Adapter »  FPoint
Yiew - Bool  »  Constant
Content 3 Calculate . Random
Connections 3 Logic »  Result
| Ports » N Spy
Math:Output:Real{  Rename al { Real ) 1
Optimize Remark
Select Connected Memory
—isr 7 " Disable r 50F) M AE P> e | a
TrEverIals | Iteration =
Folygon |

‘unction

» Vhodné si umistime nové vznikly uzel a propojime uzel Time vystupnim portem

Real s uzlem Align To Spline se vstupnim portem Position.

4 File Edit

4 Edit

System Presets
Default

XPresso Editor

Wiew Custom  Calculate

Layaut

AGroup

Align To Spline

Position:Real { Real )

Uzel Time muaze byt pouZit pro nastaveni ¢asu béhem animace. Vystupni port Real
nastavuje animaci v sekundach. Pro tento pfipad hodnota 1 u vystupu Real znamena ze
animace probéhne béhem jedné sekundy (od 0% do 100%). (tento parametr upravime
za okamzik).

Od propojeni portu Real s portem Position (ktery je definovan procenticky) se béhem
jedné sekundy zméni pozice z 0% na 100%. V naSem pfipadé to znamena, Ze koule
prekona jeden obéh po kfivce pravé za jednu sekundu. Mdzeme si zkusit prehrat
animaci.
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Pfidani uzlu s Math

(matematickou) funkci, kterym

budeme kontrolovat rychlost
koule.

JestliZze jsme si spustili animaci tak jsme zjistili, Ze koule po dokonéeni prvniho prabéhu
(dosaZeni pozice 100%) zastavi a dale se nepohybuje, je omezena hodnotou 100%. To
neznamena, Ze bychom si s tim méli délat starosti kvuli manualnimu nastaveni hodnot
vstupniho portu pozice.

» Klepneme pravy tlacitkem do volné plochy XPresso editoru a zvolime New Node
> XPresso > Calculate > Math (novy nod, XPresso, pocitat, mat).

806 XPresso Editor

4 File Edit Layout  Yiew Custorm  Calculate

AGroup

New ¥Group
General »
Thinking Particles »  Adapter »
EBool 3
3
3

Convert To XGroup

Wiew
Content

ST

- v or -
a4

Connections Invert
Hegate
LTRSS ign To Spline :
Rename # Position Cr.oss Producﬁt
Optimize Trigonometric

Select Connected Clamp
Disable Yector 2Matrix
MatrixZHPE
Position:Real { Real ) Distance
Mix
Formula
Absalute
[0 T5F 0 900 Il A B> I ] vegree
O Materials ] Coordinates . Range Mapper
% File Edit » 4 Position Size F  FloatMath

!. ><|Dm ';1X|400m 'WW%-H
[ [V ey el e Anlae =

Pfidali jsme uzel s funkci Math, kterym budeme kontrolovat rychlost koule na kfivce.

» V Attributes manageru nastavime Function (funkce) na Divide (délit) a zménime
hodnotu Inputu (vstupu) [2] na 3.

Nastavili jsme hodnotu vstupu pfi rezimu déleni (Divide) na 3, abychom pohyb koule
tfikrat zpomalili. Nyni se cely pohyb odehraje misto v jedné vtefiné ve tfech vtefinach.
Jestlize bychom potfebovali aby se pohyb koule odehral po celé trase ve dvou vtefinach,
pak bychom nastavili hodnotu druhé poloZzky Input uzlu Math na 2.

» Spojime v XPresso editoru uzel Time vystupnim portem Real se vstupnim portem
Input uzlu Math.
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Spojime vystupni port Output uzlu Math se vstupnim portem Position uzlu Align
to Spline.

Align To Spline
@ Position

Staré spojeni mezi uzlem Time a uzlem Align To Spline se smazalo jakmile jsme spojili
uzel Math se vstupnim portem Align To Spline. To proto, Ze ve vstupnim portu je mozné
pouze jedno spojeni.

Klepneme pravym tlacitkem do volné plochy editoru XPresso a zvolime New
Node > XPresso > Calculate > Formula (novy nod, XPresso, pocitat, vzorec).

Pouzijeme uzel Formula (vzorec) abychom mohli kontrolovat pulsovani koule nahoru
a dolu.

Vytvorime vstupni port kliknutim na modry roh uzlu a z menu zvolime Value
(hodnota).

V Attributes manageru, do pole Node Properties (node vlastnosti) viozime vzorec
ABS(SIN($1*360)).

Formula
@ ABS{SINCH1%360)) &

Align To Spline
@ Position

Sinusové viny jsou vyborné pro vytvofeni pulsujiciho pohybu. Standardni sinusoida se
nicméné pohybuje pouze v rozmezi hodnot —1 a 1. Kromé toho by koule pfi pfiblizovani
k podlaze (vySka 0) nezpomalovala. Potfebujeme tedy kfivku, ktera by ostfe ménila
smér z klesani na stoupani.
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Reseni tohoto problému je v oto&eni zapornych hodnot sinusoidy na kladné. Proto jsme
pouzili funkci ABS, ktera konvertuje vSechny zaporné hodnoty na kladné.

Symbol ,$‘ ve vzorci vstupu uzlu Formula, za kterym nésleduiji ¢isla, zapind zahrnuti
externich hodnot do vzorce. Diky pouziti tohoto znaku mizeme zadavat uhel pomoci
stuprid bez toho, aniz bychom je prfed tim museli pfevadét na radiany. Vzorcem
SIN($1*360) vytvofime animaci sinusové oscilace. ,$1° je proménna hodnota v ¢ase a
jejim vyjadfenim je jedna cela sinusoida za sekundu animace.

» V XPresso editoru propojime vystupni port Real uzlu Time se vstupnim portem
uzlu Formula (vzorce) (modry kruh).

» V Object manageru zvolime Sphere a v Attributes manageru zvolime Add User
Data (pridat uzivatelska data) z menu User Data.

» V dialogovém okné Add User Data (pridat uzivatelska data) pojmenujeme data
na Height (vyska).

» Nastavime jednotky na metry a klepneme OK éimz dialogové okno zavieme.

Add User Data

MNarme |Height

Data Type '\Float s 1
Interface :Float s 1
unit  [Meter F
&rin om |

& Max [1000m 5]
Step tm +]
oK

Cancel

Sinusoida vytvari hodnoty v rozmezi—1 a 1, které jsou pomoci funkce ABS konvertovany
potiebujeme upravit méfitko vin vytvarenych sinusoidou. To docilime pfidanim
uzivatelskych dat, zobrazenych jako nové vstupni pole na strance User Data v Attributes
manageru.
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» V Object manageru uchopime objekt Sphere, pretahneme jej do XPresso editoru

a podle potieby zvétSime okno.

Klepneme na ¢erveny roh nového uzlu Sphere a zvolime User Data (uzivatelska
data) > Height.

Jakmile jsou v Attributes manageru vytvorena uzivatelska data, tak jsou také pfistupna
v XPresso editoru. Jsou k vybrani stejné jako ostatni stabilni parametry. Nyni jsme pro
uzivatelska data Height vytvofili vystupni port u uzlu objektu Sphere. Nyni mizeme
pomoci portu spojit uzivatelska data Height s ostatnimi porty a vyuzit jeho nastaveni
pro vypocet animace.

Klepneme pravym tlaéitkem do volné plochy XPresso editoru a zvolime New
Node > XPresso > Calculate > Math (novy node, XPresso, pocitat, mat).

V Attributes manageru, v ¢asti Node Properties (node vlastnosti) nastavime
Function na Multiply (funkce, nasobit).

V XPresso editoru spojime prvni vstupni port Input nového Math uzlu s vystupnim
portem Height uzlu Sphere a podle potfeby si zorganizujeme okno editoru.

Spojime druhy vstupni port Input uzlu Math s vystupnim portem uzlu
Formula.

Nyni jsme spoijili uZivatelska data Height a vzorec v uzlu Formula s uzlem Math, ktery
oba vstupy navzajem nasobi. Data Height jsou nasobena vysledkem ze vzorce v uzlu
Formula. Tvar ,viny“ mGze byt zménén pouhou zménou hodnoty v dialogovém poli
uzivatelskych dat v Attributes manageru (pfi vybraném objektu Sphere) a nadale nejsme
limitovani hodnotami od 0 do 1. Nasobenim vzorce uzlu Formula nasi hodnotou Height
mUGzZeme v Attributes manageru interaktivné kontrolovat miru vysky poskakovanikoule....
To vSe je pékné, ale vSe bude pracovat teprve po spojeni koule s uzlem Math.

Uchopime objekt Sphere v Object manageru a jesté jednou jej pfetahneme do
XPresso editoru.

V XPresso editoru kliknutim na modry roh nového uzlu Sphere vytvofime vstupni
port Coordinates > Global Position > Global Position.Y. (soufadnice, globalni
pozice).
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» Spojime vstupni port Global Position.Y s vystupnim portem uzlu
Math.Multiply.

Math:Multiply Sphere
@ Input .
® Input Output & @ Global Position . ¥

Vyskova poloha objektu Sphere je kontrolovana vzorcem a muZe byt interaktivné
upravovana parametrem uzivatelskych dat Height.

» V Object manageru zvolime XPresso tag objektu Sphere.
» V Attributes manageru nastavime prioritu na Dynamics.

5
'—r& %Presso Tag [XPresso] @ 5

Basic Properties
XName  [#Presso

XPriority ;Dynamics % ]D 3| [} Camera Dependant

ﬂ Enable

Koule jesté poskakovat nebude. A to proto, Ze tagy ,chovani“ (expression) jsou vzdy
vyhodnocovana zleva doprava. Je duleZité, jak jsou jednotliva chovani umisténa v
hierarchii a jaké pfikazy se aplikuji na objekty. Kdyz je nékolik druhd chovani aplikovano
na jeden objekt, tak jeden druh chovani miZze byt ,prekryty“ jinym. V nasem pfipadé by
meél objekt poskakovat nahoru a dolu a tak ¢aste¢né ,prevazovat” nad funkci chovani
LnataCet ke kfivce", ktera je také asociovana u objektu Sphere v Object manageru
vpravo od tagu XPresso.

Pro nas$ pfipad jsou moZna dvé feSeni problému. MdZeme zménit prioritu chovani (tagu)
XPresso na Dynamics (dynamické), diky kterému bude toto chovani pfevazovat nad
v8emi ostatnimi. AvSak mizeme také tahem umistit doprava od tagu Align to Spline
(natacet ke kfivce), ¢ehoz vysledkem bude kontinualni pohyb koule po kfivce, pficemz
by koule poskakovala do vysky diky definici zadané chovanim XPresso. Tak by chovani
Align to Spline kontrolovalo pohyb v roviné X, Z, ale ne v ose Y.

» V Material manageru vytvofime novy material a pojmenujeme jej Color.

» Tento material tazenim na objekt Sphere v Object manageru aplikujeme na
kouli.
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Nastavime kontrolu materialu
pomoci XPresso editoru. V
okamziku kontaktu koule s
podlahou (tGrovni 0) zméni

material barvu..

Uzivatelé platformy Mac pouziji
klavesu Command.

» TaZenim umistime material do okna editoru XPresso.

>

>

FrGroup

Sphere
Height &

Farmula | | Math:Multiply Spher

@ Input S

Glabal Posit

@ ABS(SINGE1*360)) @@ input  Output §|—— @ Global Posith

=ler_—sF )
bl —

fH— |a|3
3“&: File Edit  Funcijgse™

.:., Color

L

Materialy mohou byt taZzenim umisténé do XPresso editoru pric¢emz vytvofi uzly, které
obsahuji jak v oblasti vstupu tak i vystupu vSechny parametry, které u materidlu miZzeme
editovat. Mnoho téchto parametrd, jako jsou barva a jas, mize byt snadno kontrolovana
pouzitim numerického zadavani ¢i vektord.

Vytvofime vstupni porty pro komponenty barvy, zeleny kanal a modry kanal
(G, B) materialu kliknutim na modry roh nové vytvoreného uzlu. Zvolime Color
> Color > Color.G a Color > Color > Color.B (barva). Podle potfeby upravime
velikost uzlu.

Chceme kontrolovat zeleny a modry kanal barvy tak, aby koule ménila barvu z bile
(R=100%, G=100%, B=100%) na &ervenou (R=100%, G=0% a B=0%). Cerveny kanal
neni nutno ménit, protozZe je stale nastaven na 100%.

Klepneme pravym tlaéitkem do prazdné plochy XPresso editoru a zvolime New
node > XPresso > Calculate > Clamp (novy uzel, XPresso, pocitat, omezeni).

V Attributes manageru nastavime hodnotu Max tohoto uzlu na 1.
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» V XPresso editoru spojime vystupni portu uzlu Clamp (omezeni) s obémi
vstupnimi porty Color.G a Color.B uzlu Color.

Pouziti uzlu Clamp nam zajistuje ,dodavku“ hodnot mezi 0 a 1 do vstupnich portt barvy.
To reprezentuje hodnoty kanalt barvy 0% a 100%.

» Spojime vystupni port uzlu Math.Multiply se vstupnim portem Value (hodnota)
uzlu Clamp (omezeni).

Uzel Math (ktery je propojen se vzorcem) produkuje hodnoty mezi nejniz&§im bodem

vertikalniho pohybu koule a jakoukoliv hodnotou zadanou ve vstupnim poli pro
uzivatelska data Height. Nataveni uzivatelskych dat Height bude pravdépodobné
po vétSinu €asu vySSi nez 1 (jinak koule by koule jen velmi nezfetelné poskakovala)
a pouzili jsme uzel Clamp (omezeni) pro zménéni barvy koule pouze v pfipadé jeji
velké blizkosti nulové vysSce. Material se zméni z bile na ¢ervenou vzdy, kdyz se koule
vyskytuje mezi hodnotami 0 a 1. Timto jsme vytvofili rychlou zménu barvu pfi dotyku
koule pfi dotyku koule se zemi.

» Pfehrajeme si vyslednou animaci.
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Souhrn

Vidéli jsme jak mGzeme pouzivat chovani XPresso pro editovani parametrd objektd,
tagu a materialt a jak miZzeme pouzit hodnoty jednoho &i vice parametrd ke zméné
jednoho &i vice jinych parametril. Zkusme si vybrat objekt Sphere v Object manageru
a nastavit v Attributes manageru hodnotu uZivatelskych dat Height na 100 a poté si
znovu spustit animaci.
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XPresso 3,
manipulace s
vektory

Vektory jsou jedny z
nejpouZivanéjsich elementu v
3D prostoru. Definuji totiZ pozici,

orientaci a také velikost objektu.

| | |
wmtive Tonl 7fS nap Se

4 Mode Edit User Data

il |

806 XPresso Editor
4 File Edit Layout  Yiew Custom  Calculate
AGroup
Dog
Global Position St
Master Clamp
~ |@ Min
Distance @ Max  Output B —
1@ Value

Global Position &

Distance
@ Input 1
1® Input 2

T Math:Add

- ® et oot @)
FloatMath:Multiply — i Input
@ Float Yalue 1 )
@ Input Output :

Output &

Universal
@ Hormal o

Math:Output:¥ector{Vector) - - > Object:Global Position:Vector {Yector}

Math:Subtract
H® Input
L@ Input

Output &

Pfed praci na tomto tutorialu bychom méli mit za sebou Uspésné zvladnuti
pfedchozich tutorial( tykajicich se témata XPresso. V tomto tutoridlu se totiz
predpoklada zakladni znalost problematiky.

Vektory jsou tvofeny tfemi hodnotami, jako napfiklad (-1.5;9;13). Cisla mohou
reprezentovat pozici XYZ nebo HPB orientaci komponentt vektord. Manipulace s
orientaci a délkou vektortl mlze byt pouZita u rozliénych aplikaci. V tomto tutorilu
vytvofime virtualni spojeni voditkem mezi dvémi objekty.

Je to v zasadé jako prochazka se psem. Pes je omezen v pohybu polomérem tvofenym
voditkem. Jakmile se budeme pohybovat, budeme tedy tahnout voditkem, tak nas pes
bude nasledovat. Abychom tento jednoduchy pfiklad ponékud rozsifili, tak vytvofime
variabilni délku voditka, které se tak muZe jakoby automaticky navijet.
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Nova scéna obsahuje kouli a
nulovy objekt.

Objekty Master a Dog budou
pouzivany coby uzly (nody)
objektu v editaénim okné
XPressa.

» Vytvofime novou prazdnou scénu.
» Vlozime do scény primitivni objekt Sphere (koule) a pojmenujeme jej Dog
(pes).

» Z hlavni liSty zvolime menu Object a z tohoto menu viozime do scény Null Object
(nulovy objekt, obsahujici vlastné jen osy) a ten pojmenujeme Master (pan).

Iaﬁiéﬁé‘ Structure | Browser 1

4 File Edit Ohjects Tags
@:7%

|:Dog
Master L’.? :

Texture

» V Object manageru vybereme objekt Master a pfiddme mu tag chovani
XPresso.

» Tazenim z Object manageru umistime objekty Master a Dog do editaéniho okna
XPresso.

2

Iaﬁi 90%" Structure T Browser 1

4 File  Edit Tags

Texture

Objects

e Edit

|

Systemn Operator
System Presets
Default

Pro pouZiti vypoctu pozice objektli Master a Dog musime oba tyto objekty umistit do
editoru XPresso.
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» V XPresso editoru v obou uzlech objektu klepneme na ¢ervené pole pro zadani
vystupniho portu a vliozime do vystupnich portu Global Position (globalni
pozice)(Coordinates > Global Position > Global Position)(soufadnice, globalni
pozice).

Dog
Global Position &)
Master
Global Position &)

Ukolem kalkulace je vypogitat vzdalenost mezi dvémi objekty a je vhodné pouZit globalni
pozici, protoZe objekty mohou byt rozdilné umistény ve struktufe scény (hierarchicky). |
kdyZ v nasem pfipadé jsou objekty na stejné urovni. Pouziti globalnich hodnot znamena,
Ze objekty mohou byt pfemistény do nové hierarchické struktury bez toho, Ze by se
narusil efekt vytvoreny pomoci nastaveni chovani XPresso.

» Vytvofime novy uzel zvolenim New Node > XPresso > Calculate > Distance
(vzdalenost) a spojime vstupni porty tohoto uzlu s vystupnimi porty Global
Position uzlu Master a Dog.

Dog
Global Position &)
Master
Global Position &)

Distance

Uzel Distance vypogita vzdalenost mezi dvémi zadanymi pozicemi. Kdyz spojime prvni
port uzlu Distance s vystupnim portem Global Position uzlu Dog a to samé provedeme
mezi porty uzl( Distance a Master. Vystupni port uzlu Distance nyni bude vysilat pozici
mezi objekty Master a Dog jakémukoliv uzlu ktery na tento vystup bude pfipojen.

Poznamka. Pozice objektl Dog a Master je zadana vektorem, ale hodnota vypoctené
vzdalenosti uzlem Distance je &islo.

» V Object manageru vybereme objekt Master a v Attributes manageru zvolime
User Data > Add User Data (uzivatelska data, pridat uzivatelska data).

Objektem Master potfebujeme kontrolovat voditko, objekt Master samotny musi
obsahovat vloZzena uzivatelska data. Jak jsme vidéli v pfedchozich pfikladech,
uzivatelska data jsou vyhodna tim, Ze nam dodavaji vétsi miru kontroly nad jednotlivymi
hodnotami XPresso. V tomto pfipadé jsou uzivatelska data pouZita pro definovani
délky voditka.
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V dialogovém okné Add User Data (pfidat uzivatelska data) zadame jméno
Distance.

Nastavime Data Type (typ dat) na Float.

Nastavime Interface (typ rozhrani) na Float Slider (plovouci posuvnik).
Nastavime jednotky na metry.

Nastavime hodnotu Min na 0 a hodnotu Max na 1000.

Tim fikame, zZe kdyz budeme upravovat aktualni hodnoty uzivatelskych dat pro Distance,
tak tyto hodnoty nemohou byt mensi jak 0 a vétsi jak 1000 m.

Nastavime velikost Step (krok) na 1 a klepneme na OK ¢imz zavieme dialogové
okno.

Add User Data

Harme Distance

Data Type :Float s 1

Interface | Float 5lider I's 1
unit  [Meter s,
# HMin D m 3]

# tax [1000m 3]
Step 5_1 m =1

Cancel Ok

Vybereme v Object manageru objekt Master a v Attributes manageru prepneme
na stranku User Data a nastavime vzdalenost Distance na 200.

Pro G€el naSeho pfikladu sta¢i nastavit délku voditka na 200 m.

V XPresso editoru klepneme na cerveny roh portu uzlu Master a z nabidky
vybereme uzivatelska data Distance.

V XPresso editoru vytvofime uzel Clamp (omezeni) (New Node > XPresso >
Calculate > Clamp).

Spojime vystupni port uzlu Distance se vstupnim portem Value (hodnota) uziu
Clamp.
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» Spojime vystupni port Distance uzlu Master s portem Max uzlu Clamp.

Dog
Global Position &)

Clamp
Master ® Min
Distance & i Max Output &
Global Position & - i Value
Distance

» V Attributes manageru nastavime hodnotu Min portu Clamp na 0.

Od tohoto okamZiku je vrchni limit omezujici vzdalenosti definovan uZivatelskymi daty
Distance. Vysledna hodnota je vysilana z portu uzlu Clamp a ta nemuze prekrogit
hodnotu uzivatelskych dat Distance.

Aktualni vzdalenost mezi psem a panem, ktera je vycislovana uzlem Distance a vstupuje
do uzlu Clamp, pouze ukazuje jak daleko je omezovany vystup, kdyZ hodnota lezi uvnitf
hrani¢nich hodnot 0 a zadanou vzdalenosti. Vzdalenost mezi dvémi objekty nemuZze byt
logicky niz&i nez 0, tak jak jsme to nastavili pro port Min pro uzel Clamp. Tato hodnota
je konstantni a mdze byt i na dale nastavena pomoci Attributes manageru.

» V XPresso editoru vytvofime uzel Math (New Node > XPresso > Calculate >
Math)(novy node > XPresso > pocitat > Mat).

» V Attributes manageru zvolime Data Type na Vector a Function na Subtract
(odedist).

» V XPresso editoru spojime vystupni port uzlu Dog s vrchnim vstupnim portem
uzlu Math.
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» Spojime vystupni port uzlu Master Global Position se spodnim vstupnim portem

uzlu Math.

Dog
Global Position &)

Clamp
Master ® Min
Distance &) i Max Output &
Global Position &) - i VYalue
Distance
@ Input 1
o nputz  Duteut

Math:Subtract

Uzel Math nam zprostfedkovava velky pocet moznych vypoctd. Poskytuje zakladni
funkce — scitat, odedcitat, nasobit, délit a modulo — jejichZ hodnota miZe byt ménéna v
Attributes manageru ve kterém je tento Math uzel aktivni. Uzel Math neni omezen jen
na vstupni ¢iselné hodnoty, maze také zpracovavat vektory.

Poznamka. Oba vstupni porty pfijimaji hodnoty téhoz typu, jiné druhy hodnot jsou
upraveny automaticky a to mdze byt pfi€inou Ze Ciselné vstupy ,zmizi“, nebo Ze jsou
vektory konvertovany do jednoduché skalarni veli€iny, coz vede k neoCekavanym a
nechténym vysledkim. V nasem pfipadé je odecitan jeden vektor od jiného, ¢ehoz
vysledkem je jiny vektor. Vysledny vektor charakterizuje orientace, ktera je vyslednici
orientaci vstupnich vektor(.

Vyznamné je tedy i poradi umisténi vektort pfi vypoctu. Obecné se tim fika, Ze odectena
poloha je vyslednici mezi cilovou polohou a stavajici polohou pfi€emz vysledny vektor
je orientovan podle trajektorie mezi stavajici a cilovou polohou. V naSem pfipadé pana
a psa, uzel Math vypocitava smér, ktery je potfebny pro uchyceni psa za panem. Vektor
vypocitany uzlem Math také obsahuje informace o vzdalenosti mezi panem a psem.
Omezeni neni aplikovano na objekt psa a tato hodnota by mohla spadat mimo délku
voditka. Ale nemusime si délat starosti, protoZe nalezita vzdalenost mezi panem a
psem je vypocitana v uzlu Clamp.

V XPresso editoru vybereme Universal node (univerzalni node) (New Node >
XPresso > Adapter > Universal).

» V Attributes manageru nastavime Data Type na Normal.
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» V XPresso editoru spojime vystup uzlu Math se vstupnim portem uzlu
Universal.

Dog
Global Position &)

Clamp
Master ® Hin
Distance & @ [Max Output &
Global Position &) - i Value
Distance

@ Input 1

® Input 2 Output &

Math:Subtract

Universal
@ HMormal &

Nyni je mozné kombinovat r(izné druhy vstupnich dat. Orientace vektoru mezi psem a
panem je vypocitana pomoci uzlu Math; ten charakterizuje smér kterym bude ovliviiovan
pes z pozice pana. Délka vektoru muZe pfesahovat mez ohrani¢enou pomoci vstupu
uzivatelskych dat Distance. Jinou hodnotou je vzdalenost mezi psem a panem. Tato
hodnota se méni na “platnou” hodnotu diky uzlu Clamp a hodnoté Distance.

Ulohou zmé&n v uzlu Math je orientovat vektor a tlohou uzlu Clamp je vypoéitat jeho
délku. V pfipadé, Ze je vSe spravné, tak vysledkem uzlu Math bude vektor o délce 1. Tato
hodnota je nasledné jednodu$e nasobena na odpovidajici délku pomoci uzlu Clamp.

Délka vektoru 1 je prostym matematickym elementem. Takové vektory se nazyvaji
normalné, nebo normaly. Tento typ vektord vSak jiz dobfe zname z modelovani polygond,
jsou to ty malé Zluté ¢ary zobrazené po vybrani polygonu. Konverze vektord do normal,
kterymi definujeme smér, ale nikoliv délku, je zptsobena uzlem Universal. Tento
sadaptér” uleh€uje konverzi jednoho typu dat na jiny, napfiklad vektoru na normalu.

» V XPresso editoru vytvofime novy uzel FloatMath (New Node > XPresso >
Calculate > FloatMath).

» V Attributes manageru nastavime typ dat Data Type na Vector a funkci na Multiply
(nasobit).
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» V XPresso editoru spojime vystupni port uzlu Universal se vstupnim portem
Input uzlu Float Math.

» Spojime vystupni port uzlu Clamp s portem Float Value (hodnota Float) uzlu
FloatMath.

Dog
Global Position &)

Master

Distance &

@ Value
Global Position &—

Distance

@ Input 1

® Input 2 Output &

FloatMath:Multiply

@ Float Value
@ Input Output &

Math:Subtract =
Universal

Jak bylo popsano dfive, uzel Math konvertuje rozdilné typy dat automaticky do
odpovidajiciho jednotného typu. Uzel FloatMath méa témér stejnou funkci jako uzel Math
az nato, Ze pracuje s rozdilnym typem dat bez jejich predeslé Upravy. Timto zplisobem
muZe byt pomoci uzlu Universal snadno nasoben normalny vektor s redlnou hodnotou
z uzlu Clamp. Vysledkem je orientovany vektor s odpovidajici délkou.

» Do XPresso editoru viozime dalSi uzel Math.

» V Attributes manageru nastavime Data Type (typ dat) na Vector a funkci na Add
(scitani).

» V XPresso editoru spojime vystupni port Global Position uzlu Master se vstupnim
portem nového uzlu Math.
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» Spojime vystupni port uzlu FloatMath se vstupnim portem nového uzlu Math.

Dog
Global Position &)

Master

@ Min
Distance & @ IMax  Output &
|—. ‘alue

IMath:Add

Global Position &)

Distance

Vypocitany orientovany vektor uzlem Float Math sméfuje spravnym smérem a ma
odpovidajici délku, ale neni na spravném pusobisti. Orientace vektoru je definovana
spojnici mezi panem a psem, to ale nefesi tento problém. Jednoduse pouzijeme jako
pusobisté vektoru pozici pana a orientace bude zadavana smérem ke psovi.

Tato kombinace pozice a orientace vektoru mlze byt pouzita diky séitani dat v novém
uzlu Math. ProtoZe jsou obé vstupni hodnoty ve stejném formatu (jsou to vektory)
tak neni ani tfeba tyto hodnoty pfed vstupem do uzlu konvertovat. KdyZ pouzivame
funkci Add (s¢itani) s vektorovym typem dat v uzlu Math, tak neni ddleZité, jak velké
spojované hodnoty jsou.

» V Object manageru uchopime objekt Dog a pretahneme jej do XPresso editoru,
¢imz vytvofime novy uzel.

XPresso vypogita novou pozici objektu Dog, pokud délka voditka, ktera je kontrolovana
skrz uZivatelska data Distance objektu Master, nepfekona stavajici pozici. Pro dokon&eni
nastaveni se nova globalni pozice pfesméruje zpét na objekt Dog.
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» V XPresso editoru klepneme na modry roh nového uzlu Dog a zvolime Global
Position.

» Spojime novy vstupni port Global Position nového uzlu Dog s vystupnim portem
posledniho vytvoreného uzlu Math.

Nové vygenerovana globalni
pozice bude posilana na objekt
Dog, pomoci jeho nového uzlu.

IMath:Add

FloatMath:Multiply
Math:Subtract

Universal

Toto spojeni zajistuje, Ze se objekt psa nemiZe pohybovat ve vétsi vzdalenosti od
objektu Master (pan), nez jaka je nastavena v uzivatelskych datech Distance (tu jsme
dfive nastavili na 200 m). Na druhou stranu mizeme objektem Master pohybovat zcela
volné a pes bude pana nasledovat pouze po ,napnuti voditka“.

Souhrn

Vidéli jsme, jak muZeme vytvofit komplexni vztah mezi dvémi objekty tak, Ze neni
podstatné jak se naanimujeme fidici objekt, protoZze pohyb navazaného objektu je
limitovan pouze hodnotami nastaveni.
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Rendering
statickych
obrazku

Rendering je proces, ktery je
nezbytny pro vytvoreni vystupnich
obrézku z drive vytvorenych scén.
V této lekci se naucime, jak s timto
procesem naklddat.

v

Rendering je proces, ktery naSi scénu zobrazi v lepSi kvalité, nez jak ji vidime ve
zobrazovacim okné. Ve zobrazovacim okné totiz nelze zobrazit pIné vSechny detaily
- napf. odrazy svétel nebo odlesky, protoZe jejich vypocet trva delsi ¢as. Po ukonéeni
renderingu se vygeneruje obrazek, ktery obsahuje nasi scénu v pinych detailech.
Obrazky mohou byt renderovany do rGiznych format soubort o jakémkoliv potfebném
rozliseni. MiZeme také vytvorit nahled renderované scény pfimo v modela¢nim okné
(jako jsme to jiz nékolikrat délali v pfedchozich tutoridlech), nebo mizeme vyuZit render
»do prohlizece®, kdy miZeme nastavit rozlicné parametry vystupu.

Cas potiebny pro rendering scény muZe byt znaény. Jednoduché scény, jaké jsou
napfiklad pouzité v téchto tutoridlech, mohou byt vypoc&itany béhem nékolika vtefin €i
minut. Velké scény, jako jsou napfiklad detailni architektonické vizualizace, se mohou
také renderovat nékolik hodin. Rychlost renderingu velmi zalezi na pouzitém hardware.
Cim rychlej§i mate poéitad (procesor), tim rychleji bude i rendering.

Nahrajeme si scénu ,Renderingl.c4d‘ z adresare Tutorials/Cinema4D/Scenes/
Rendering/Still.

Tento soubor pouzijeme pro ilustraci zakladniho nastaveni renderingu. Toto nastaveni
je doposud u tohoto souboru vychozi, proces vystupu objektl je zde nastaven pouze
na lepsi zobrazeni.
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Po klepnuti na tuto ikonu se
otevie dialogové okno.

Na levé strané okna je zobrazen
seznam ruznych nastaveni
renderingu.

Toto nastaveni odpovida
¢astému rozliSeni obrazovky
1024*768 bodu.

» Klepneme ve vrchni paleté na ikonu Render Settings (nastaveni parametru pro
vypocet).

i ”E. — . o g
— w Render View ¢
@ Fiender Region

6 Fender Active Objects

Fender Settings...

Pro rendering je pfirozené, Ze veskera nastaveni se musi zadat dfive, neZ vyrenderujeme
a ulozime soubor. Tradi¢ni nastroje na tvorbu obrazki, jako napfiklad Photoshop a
Paint Shop Pro, ukladaji obrazky témér okamzité, ale protoze se 3D obrazky musi
nejdfive vygenerovat, tak je nutné si nejdfive nastavit veSkeré parametry a druh
souboru. Program pak automaticky zobrazi vysledek a po dokon&eni renderingu sam
uloZi pfislusny soubor.

» Klepneme na levé strané dialogového okna Render Settings na slovo Output
(vystup) a zobrazi se stranka s nastavenim vystupu.

General Resolufion [320% 240NTSCMPEGT [w[fa20 w20 3
g:ii“t Film Format. [éutomatic B[ EZE B

Na strance Output (vystup) nastavujeme specifikace vystupu obrazku &i animace, které

vytvarime. JestliZze je nase budouci prace uréena pro tisk, pak potfebujeme napfiklad
nastavit vy$Si rozliSeni nez je nastaveno jako vychozi. To by mélo byt okolo 300 dpi.

» Nastavime rozliSeni na 1024x768.

800 x 600

1024 » 768

1280 % 1024

Vychozi nastaveni je navrzeno pro rychly nahled o malém rozliSeni. Pro zobrazeni vSech
detaill je tfeba zménit velikost vystupu na vyssi rozliseni.

» Prejdeme na stranku Save (ulozit) klepnutim na slovo Save na levé strané

dialogového okna.

Stranka Save ndm umozriuje zvoleni mista a zptsobu uloZeni vystupniho souboru. Zde
zadame nazev souboru a jeho format.
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» Klepneme na tlaéitko Path (cesta) a zvolime umisténi vystupniho souboru, ktery
pojmenujeme tieba Rendering1.tif.

Fath... | IE:\D esktophRendering ki

Vyrenderovany obrazek bude ulozen do mista a ve formatu podle naseho zadani.

» Nastavime format na TIFF.
Farmat ITIFF LI Dptions...l

Formét TIFF je Siroce akceptovanym a pouZivanym formatem. Soubory typu TIFF
zachovavaji data v jejich originalni kvalité a povoluji rendering animace po jednotlivych
snimcich. Jestlize bychom chtéli soubory typu TIFF pouzit pro rendering animace, pak
bychom potfebovali dalsi editaéni software, kterym bychom nacetli jednotlivé snimky
animace a vytvofili z nich filmovy klip.

» Klepneme na tlacitko OK a zavieme dialogové okno Render Settings (nastaveni
vypoétu).

» Zvolime z hlavniho menu Render > Render to Picture Viewer (renderovat do
prohlizece).

Fender Animation Painter ‘Window  Help

Render View Crl+F
Fender Active Objects
Fender Region

| Fender to Picture Viewer  Shift+R |

Ratrh Renderinn
Po nastaveni vSech zakladnich parametri muzZeme klepnout na tladitko Render,
kterym cely proces spustime. Priibéh renderingu Ize sledovat na obrazovce - program
bude postupné “skladat” vysledny obrazek po jednotlivych fadcich. Rendering mize
trvat nékolik sekund az minut - to zalezi na rychlosti vaseho pocitace. Po dokon&eni

vypoctu se na prislusné misto na disku ulozi vysledny soubor, ktery pak mlzete otevrit
v libovolném grafickém editoru a dale s nim pracovat.

Souhrn

Naudili jsme se chapat vyznam nastaveni rozli€énych parametrd renderingu a umime
ménit velikost renderovaného obrazku. Zkuste si nyni prozkoumat jina nastaveni a
vyzkouS$et, jak po této Upravé bude vypadat finalni obrazek. Cinema 4D podporuje
Siroké spektrum formatu, takze ji mazeme pouzit jako vyborny doplnék k aplikacim
zaméfenym na zpracovani pocitaové grafiky a digitalniho videa.



212 RENDERING CINEMA 4D TUTORIALY

Renderovani
animaci

CINEMA 4D umoZriuje uklddat
animace do nékolika formatu jako
QuickTime, AVI ¢i do jednotlivych
snimku. V tomto tutorialu si
objasnime nékteré otdzky tykajici
se tvorby vystupu animaci.

Rendering statickych obrazku a animaci se v mnohém lisi. U statického obrazku je
mozno vénovat jeho renderingu i nékolik hodin, naproti tomu u vétSiny animaci by mél
byt vygenerovan kazdy jeden snimek maximalné béhem nékolika minut. U statického
obrazku m(ze byt zapotrebi pfi pouZziti vysoké rozliSeni o nékolika tisicich bodech (napf,
pro tisk), naproti tomu u animace je typicky poc¢et bodu ve snimku pod jeden tisic. V
této kapitole si projdeme proces nastaveni renderingu pro tvorbu animaci.

» Nahrajeme si soubor pojmenovany ,MakeAnim.c4d‘ z adresafe Tutorials/
Cinema4D/Scenes/Rendering/Animation.

Tento soubor obsahuje animaci, avSak soubor je nastaven na vystup jediného obrazku.
Pomoci nékolika parametrt upravime nastaveni souboru pro render animace.

» Klepneme ve vrchni paleté nastroju na ikonu Render Settings (nastaveni
parametru pro vypocet).
Pomoci nastaveni parametru pro | . % e WL -
vypocet muzeme specifikovat i ”[ _
soubory vystupu (animaci, == ] Render Yiew b
I
@ Fiender Region

obrazku).
& Fender Active Objects

Render to Picture Yiewer

ender Settings...
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Klepnutim na ikonu Render Settings (Nastaveni renderingu) otevieme dialogové okno,
kde Ize upravovat a nastavovat druh a kvalitu vystupu podle naSich potfeb. Poznamka:
stavajici parametry jsou nastaveny na jeden snimek o vysokém rozliSeni. Toto nastaveni
neni vychozi.

Klepneme na levé strané dialogového okna na slovo Output (vystup) a otevie
se stranka s nastavenim téchto parametru.

Nastaveni ve strance Output (vystup) je pro animaci velmi ddlezité. UmoZriuje nam totiz
zvolit pocet renderovanych snimkl animace a rozlieni podle potfeby. Je zde také k
dispozici nabidka vétSiny animacénich formata.

Nastavime rozliSeni na 720x576 D1 PAL.

£ ¥ 45U
7E8 576 PAL

720 % 576 D1 PAL
800 » 600

An94 ., FoD

Dosavadni nastaveni jsou pro animaci pfili§ vysoka. Zatimco pro staticky obrazek
jsou potfeba vysoké detaily, které si mizeme prohlizet nékolik sekund &i minut, tak
jeden snimek animace uvidime jen zlomek vtefiny. To je divod pro sniZeni rozliSeni
na 720x576.

Technicka poznamka. M(zeme také zménit pomér stran bodu, nicméné pro tento pfipad
nechame toto nastaveni beze zmén..

Nastavime Frame (snimky) na All Frames (v§echny snimky).

Current Frame

All Frames

Freview Fange

Spise nez jeden snimek budeme chtit renderovat celou animaci, takZze nechame spocitat
v8echny snimky naseho projektu. Poznamka: Pokud nechceme renderovat vSechny
snimky, mdZeme zadat prvni a posledni snimek animace, ktred se ma vypoditat.

Nastavime Field Rend (pulsnimky) na Odd Field First (liché jako prvni).

None 121 (i
Even Field First

Odd Field First

P¥i vytvareni klipu pro televizi se doporu€uje zapnout volbu Odd Fields First (liché jako
prvni). Televizni signal typu PAL zobrazuje 50 snimkd za vtefinu. Nastavim pualsnimku
na ,liché jako prvni“ tak bude pfehravana animace ,hladsi*.
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Nastavime Set Frame Rate (rychlost prehravani) na 25.
Frame Rate |25 j Frames: 101 [from 0 to 100]

Televize PAL pouzivaji 25 snimkd za vtefinu (30 pro NTSC).

Klepneme na slovo Save (ulozit) na levé strané dialogového okna a zapneme
stranku s nastavenim tohoto parametru.

Stejné jako u statického obrazku by méla byt veSkera nastaveni renderingu pro animaci
nadefinovana pfed spusténim samotného procesu. Tim se také vyhneme neustalému
zobrazovani dialogu s otazkou na jméno souboru a jeho umisténi po kazdém ukonéeném
testu renderu.

Nastavime format na QuickTime Movie.

LUILE, | IS MUyIE Dy

| QuickTime Movie

e S

Aby to bylo jesté jednodussi, tak Cinema 4D automaticky zkompletuje jednotlivé
vyrenderované snimky do souboru filmového klipu a tak neni potfeba dal$iho software,
kterym bychom museli jednotlivé snimky ,sefadit“ do animace.

Klepneme na tlacitko Path (cesta) a zvolime umisténi a jméno souboru.

Jako vystupni format jsme zvolili QuickTime, diky kterému nebude v cilové lokaci
mnozstvi soubord s jednotlivymi snimky, ale jen jeden soubor s celou animaci.

Pfemistime se na stranku Antialiasing (vyhlazeni).

2dve

Antialiazing
B adinsite

Ujistime se, ze Antialiasing(Vyhlazeni) je nastaven na Geometry (hrany).

Antialiazing Geometry LI

Pfi tvorbé animace se ztraci pomérné velky pocet detailli. A to nejen diky mensimu
rozliSeni nez u statického obrazku, ale také diky tomu, Ze kazdy ze snimk( vidime pouze
na zlomek vtefiny. To znamena, Ze pfi pouziti nejlepSiho vyhlazovani typu Best (nejlepsi)
jen stéZi pozname rozdil oproti nastaveni Geometry, takZe ve vétsiné pfipadi neni nutné
nastaveni Best (jehoZ vypocet trva podstatn déle) u animaci pouZzivat. Vyjimkou jsou
scény s velkym pocétem prahlednych a lesklych objektd, kde se pouzitim vyhlazeni typu
vyhneme “roztfepani” kontur nékterych objektu.
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» Nastavime Filter na Animation.

Filter Animation LI

U animaci je uzite€né zvolit filtr pro vyhlazeni animaci (Animation — na animace). Timto
filtrem mirné rozostfime vystupni obrazek (oproti filtru Still Image, ktery je uréen na
statické obrazky), ale to nam mGze pomoci vice vyhladit hrany a tim ,redukovat“ mensi
kvalitu vyhlazeni hodnoty Geometry (hrany). Toto nastaveni pro staticky obrazek by
zpUsobilo pfilisné rozostieni, ale kvalita animace se tim zvysi.

Klepneme na tlacitko OK a zavieme dialogové okno.

Zvolime z hlavniho menu Render > Render to Picture Viewer (renderovat do
prohlizece).

Po zvoleni tohoto pfikazu zacne program vytvaret 3D obrazky potfebné pro animaci.
KaZzdy z takto vyrobenych snimku je automaticky pfifazovan do souboru QuickTime
movie. Tento proces muZe trvat i nékolik minut podle rychlosti vaseho stroje. Kdyz je
rendering ukoné&en, tak finalni soubor QuickTime nalezneme na nami dfive zvoleném
misté. Nezbyva ndm nic jednodussiho, nez si soubor pfehrat.

Poznamka. Pro pfehrati souboru typu QuickTime je potfeba pfehravaé QuickTime.
pokud ho nemate na svém podcitaéi nainstalovan, tak ho naleznete na stejném CD
jako instalaci programu CINEMA 4D v adresafi Goodies.

Souhrn

Naucili jsme se nékolik dalezitych véci o tom, jak renderovat obrazky v programu
CINEMA 4D. Jiz vime, Ze pfed samotnym procesem renderovani musime nastavit
velikost obrazku, jeho format, jméno a umisténi vysledného souboru. Rendering bychom
nemeéli spoustét hned. Animace jsou sloZeny z velkého mnozZstvi statickych obrazku
spojenych dohromady. Cas, ktery je potfeba pro rendering, je zavisly na nasteveni
jednostlivych parametrl a také na rychlosti pocitace.

Rendering je nedilnou ¢asti produkéniho procesu, bez kterého nase modely zlstavaiji
pouze kolekci Eisel a kalkulaci uvnitf souboru naseho projektu. Pfi sestavovani rozpoctu a
planovani bychom vzdy méli brat ohled na to, jak mnoho €asu nam rendering zabere.
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Multi—Pass
Rendering,
renderovani do
vrstev

V této kapitole si ukdzeme jak
nastavit render, aby vysledny
obrazek obsahoval nékolik vrstev.
To ndm podstatné ulehci praci v
postprodukénim procesu.

MozZnost renderingu do vrstev je nesmirné silnym rysem programu, ktery bychom neméli
prehlizet, zvlasté jsme-li profesionalnimi uzivateli s naro€nymi klienty. Renderovani
do vrstev (dale budume pouzivat termin multi-pass) umozriuje renderovat nékteré
objekty ¢i elementy do rozdilnych vrstev &i soubord, a ty pak nasledné mixovat pomoci
postedita¢nich nastroju a programu. Ze zacatku to mize vypadat jako zbyte€néa prace
, ale zkusme se na moment zaméfit na nasledujici pfiklad. Pravé jsme dokongili
rendering animace o velkém poctu snimk(, feknéme 10 000, ktera obsahuje prilet
slozitou budovou v ¢ase polednim. Skvélé, ale navic bychom méli vytvofit scénu pfi
zapadu slunce a o pulnoci...

To je vétSinou jeden z obvyklych pozadavk( klientd. PouZitim multi-pass renderingu
mUGzZeme vytvofit v8echny tfi scény najednou a to pouze s o mélo vétS§imi casovymi
naroky. V8e, co je tfeba pro to udélat, je nastavit svétla pro vSechna tfi asova obdobi
riznych nastaveni svétel po ukonéeni renderingu. Neni potfeba separatné renderovat
tfi varianty scény s rliznym nastavenim svétel.

V toto tutorialu si ukaZzeme, jak se nastavuje scéna na multi-pass rendering. Poté bychom
si mohli nahrat vytvoreny soubor do 2D editaéniho programu (Adobe Photoshop), ve
kterém muZeme pokradovat v Upravach.
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» Nahrajeme si scénu Multi-Pass.c4d‘ z adresafe Tutorials/CINEMA 4D/Scenes/

Rendering/ Multi-Pass.

Tento soubor obsahuje kompletni scénu se vSemi objekty a nastavenymi svétly,
pfipravenou pro standardni rendering.

Klepneme na ikonu Render Settings (Nastaveni renderingu) ve vrchni paleté
nastroju.

& FEnder o FICIUre viewer E

Wl Render Settings...

-l b sl a Braviam E

Veskera rozli€na nastaveni renderignu v€etné nastaveni multi-pass jsou obsazena v
dialogovém okné Render Settings. Toto okno muZeme také otevfit pomoci polozky
Render Settings z menu Render z hlavniho menu programu.

Pfejdeme na stranku Multi-Pass.

Options
Mulki-Pass
QuickTime YR

Pomoci stranky Multi-Pass zadavame, jaké rtizné vrstvy chceme béhem renderovaciho
procesu vytvofit. Na tomto misté také nastavujeme format souboru, ktery bude pouzit
pfi uloZeni souboru.

Nastavime Separate Lights na All (separovat svétla: vSechna).

Separate Lights IAII LI

MozZnost Separate Lights rozhoduje, zda budou ¢i nebudou vytvoreny jednotlivé vrstvy
pro kazdy jednotlivy zdroj svétla. Velkou vyhodou pak je, Ze ve vét§iné 2D editacnich
programl mazeme individualné zdroje svétla vypinat, zapinat, nastavovat jejich kryti,
Ci je dodate¢né obarvovat.

Nastavime Set mode na 2 Channels (rezim: 2 kanaly).

Mode |2 Channels: Diffuse+8pecL|

Kazdy svételny zdroj muZe tvofit aZ tfi samostatné kanaly pro vSechny své slozky,
kterymi jsou povrchova uprava, odlesk a stin. My jsme zvolili tvorbu pouhych dvou
vrstev na jeden svételny zdroj, pfi¢emZ v jedné vrstvé je kombinovany kanal povrchové
Upravy a odlesku, ve druhé vrstvé pak kanal stinu.
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» Z menu Channels (kanaly) vybereme Reflection, Refraction a Ambient (odrazivost,
pruhlednost, okoli).

General |7 Enable Multi-Pass Rendering «|¥| Channels _» |
Output [V Refraction

Save [V Reflection

Antialiazing [V &smbient

Toto jsou tfi elementy renderingu, které se ,nekryji“ se specifickymi kanaly svétel.
Odrazivost, priihlednost, osvétleni material( a povrchovych map, to vSe je potfeba
dodat obrazku, aby vypadal kompletné. Osvétleni materiald a povrchovych map je
kombinovano v kanalu Ambient (okoli).

» Z menu Channels vybereme Object Buffer (zasobnik objektu).

Blend Channel

Obiject Buffer

» Po zobrazeni dialogového okna pro zadani Group ID (skupina) potvrdime hodnotu
stiskem klavesy OK.

(i Object Buffer

Group [0 I‘Il j }
()8 | Eancell 1

Object Buffer (zasobnik objektu) nam umozriuje vytvofit alfa kanal pro jednotlivé objekty.
Kazdému objektu ve scéné mize byt pfifazeno specifické ¢islo (ID) a toto ID se poté
renderuje jako vrstva alfa kanalu.

» Klepneme na tlacitko Path a zvolime umisténi a nazev vychoziho souboru.

V8echna nastaveni renderingu jsou navolena pfed uloZenim souboru, nemusime tedy
jiz po ukonéeni procesu soubor znovu ukladat.

» Prfejdeme na stranku Save (ulozit) a vypneme moznost Save Image (ulozit

obrazek).
General I_ Save Image ”
Output Fathi | |
Save :
Antialiasing Farmat ITlFF LI ptiaris... |

Radiosity Depth |saiuchanne| =l

CINEMA 4D obsahuje dva typy vystupu. Standardni a multi-pass. V tomto pfipadé si
predvadime, jak vytvofit multi-pass rendering a tak standardni uloZeni vypneme.
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» Prfeneseme svou pozornost na stranku Output (vystup).

General
Olutput
Save

Nastaveni stranky Output ovliviiuje oba typy renderingu. Nastaveni stranky Output
rozhoduje, jaké snimky budou renderovany a jaké budou mit rozlieni.

» Nastavime rozliSeni na 1024x768.

Resolution |1 024 5 768 =l

Vychozi rozliSeni 320x240 je velmi nizké, proto jej pfiméfené zvétSime, Eemuz bude
odpovidat vice zobrazenych detaill a také se nam bude Iépe pracovat se zdroji svétel
pfi postprodukci.

» Klepneme na OK a zavieme dialogové okno Render Settings.

» V Object manageru (spravci objektu) vybereme objekt Interior a z menu File
(Object manageru) zvolime New Tag > Compositing Tag (nova vlastnost,
kompozice).

Objects | Structurel Browserl
4| File Edit Objects Tags Testure
Anchor Tag Mew Tag 3

| Compositing T ag Mew Expreszzion 3
Cewmctbraint Tam Pactara Calamtioem 3
Compositing tag maze byt aplikovan na jednotlivé objekty ¢i na celé skupiny objektu.
Je to nastroj, ktery nam poskytuje velkou miru kontroly nad nastavenim renderingu
jednotlivych objektu.

» V Attributes manageru, na strance Object Buffer (zasobnik objektu), zapneme
Buffer 1 (zasobnik).

| B asic | Tag | Obiject Buffer |
Add to Object Buffer
|7 Enable Buffer
I_ Enable Buifer,

7
2
[ Enable  Buffer[3
M Fnahla Bibtar T4

o] e |

B

Diky tomu, zZe jsme pfed nékolika okamziky pfidali do nastaveni multi-pass renderu
moznost Object Buffer, tak jsme nyni mohli pfifadit tuto moznost jakémukoliv objektu
a pro tento objekt vytvorit adekvatni alfa kanal. Objekty jsou pfifazovany na zakladé
Cisla zasobniku (Buffer) ID v nastaveni (Attributes) tagu Compositing.
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» Zvolime z hlavniho menu Render > Render to Picture Viewer (Renderovat do
prohlizece).

Jestlize jsme v&e nastavili korektné, tak program spusti render obrazku a okamzité po
jeho vytvoreni jej ve vrstvach ulozi na dfive zvolené misto.

MiZeme poznamenat, Ze standardni rendering a multi-pass poskytuji nepatrné rozdilné
vysledky tykajici se sytosti barev a jasu. PfestoZe poskytuje multi-pass extrémné dobré
vysledky, tak si nemGzeme myslet, Ze se nam mohou pomoci kombinace a filtrace
riznych vrstev zachovat 100% presné barvy.

» V Picter Vieweru (prohlizec¢i) zvolime z menu Channels (kanaly) Cold Light >
Blend: Diffuse+Specular (miseni: povrchova uprava + odlesk).

Muzeme vidét, jak pusobi toto -
svétlo na pravou stranu auta. |pICtUTES

4 File Edit |Ehannels Components  Yiew

Multi-Layer Display

Image
Alpha

Refraction

Reflection
Ambient
‘wharm Light 3
Cold Light ¥ Shadow
v Blend: Diffuse+Specular

Muzeme vidét jak by vypadal obrazek, kdyby ve scéné pusobilo jen jedno svétlo a
v8echny ostatni odrazy a stiny by byly vypnuté. Pomoci nastaveni kryti této vrstvy ve
2D editoru mGzeme upravovat miru intenzity tohoto svétla.
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Pro dalSi editovani multi-pass souboru je potfeba 2D graficky editor, ktery podporuje
format typu PSD. Ve zbyvajici €asti tohoto tutorialu budeme pouzivat pro dokresleni
rozliénych technik Upravy vrstev program Adobe® Photoshop®.

» Spustime si 2D grafickou aplikaci.

Jestlize nemame dostateéné hardwarové prostfedky k sou¢asnému béhu obou
programu, mGzZeme v tomto bodé soubor uloZit a zavfit program CINEMA 4D.

» NV grafickém programu si otevieme multi-pass soubor vytvoreny renderem
programu CINEMA 4D.

|E Adobe Photoshop
File Edit Image Layer Select Filker Wew Window Help

“ ﬂ | Width: I Height: I Resalution: I Ipixels.-"inch ;I

Front Image I

™ Multipass Car.psd @ 50% (Refraction RGB) (M=)

E@ =l n R0
e

Vidime, Ze kaZda vrstva je do scény korektné zaclenéna a kazdé svétlo ma svou viastni
skupinku vrstev. MiZeme poznamenat, Ze obrazek nevypada tak docela stejné jako v
prohlizedi obrazk( v programu CINEMA 4D. To je proto, Ze v8echny typy vrstev musi byt
spravné ,spojeny“ dohromady aby tvofily obrazek a Adobe™ Photoshop™ nanestésti
zatim nepodporuje u michani vrstev rezim ,secist“ a tak se misto toho pouZziva rezim
Screen (zavoj), jehoz vysledkem je, Ze je obrazek ponékud tmavsi.
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» Vybereme vrstvu Warm Light/ Blend: Difusse+Specular a upravime vyvazeni
barev tak, abychom dodali obrazku éerveny nadech.

Obarveni jednoho zdroje svétla
je prostiedkem ke zméné
osvétleni scény.

IScreen _;j Opacity: l]DD% >I
Lck: T CF T+ T @

| Cowarm Light

Shadow

Blend: Diff_..

[ [ Cold Light

Upravou barevného ténovani vrstvy povrchové tpravy a odlesku miizeme vytvorit dojem
zabarveného zdroje svétla, dokonce i kdyby byl plvodni zdroj svétla zcela bily.

» Zvolime vrstvu Cold Light/ Blend: Difusse+Specular a pomoci vyvazeni barev
dodame obrazku tmavé namodraly vzhled.

Chladna modra svétla jsou ¢asto
pouzivana na osvétleni pozadi,
pfi zaméfeném pohledu na
objekt v popredi.

IScreen _;j Opacity: l]DD% >I
Lck: T CF T+ T @

=

[ COWarm Light

| = [celd Light

I:Ishadow
[ |[F Blend: Diff.

Zménou barvy predniho svétla do ¢ervenych ténd a lGpravou barvy zadniho zdroje
svétla do studenych modrych tonl jsme vytvofili stylizované osvétleni zapadu slunce.
Jestlize porovname vysledny obrazek s plvodnim, tak musime zcela jisté konstatovat,,

Ze je podstatné zajimavé;si.
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» Zvolime vrstvu Warm Light/Shadow a zménime kryti stinu na 50%.

Pomoci zmény kryti vrstvy stinu
jsme vytvorili mékkéi efekt
téchto stinu.

|muttiphy | Cpacity: [Box ]
Lck: T CF T+ T @

- Reflection
- Armnbient

- Blend: Diffuse+...

| B [C3Cold Light

Tento obrazek nebyl renderovan s radiositou (specialni vypocetni algorytmus, ktery je
soucdasti modulu Advanced Render), diky ¢emuz byly vSechny stiny zcela ¢erné a to
nevypada zcela realisticky. Redukci sytosti stind se bude zdat, Ze se teplé sluneéni
svétlo odrazi okolo interiéru vozu a lehce osvétluje tmavsi oblasti. NenaruSime tim ani
realisticky vzhled celé scény, protoZe stiny vrhané studenym svétlem zlstanou stale
velmi tmavé.

Souhrn

Nyni je finalni kompozice kompletni. Po vyrenderovani samotného obrazku jsme mohli
snadno upravit nékolik komponentd. Vytvofenymi zménami jsme se na hony vzdalili
tradiénimu postupu nékolikanasobného testovani renderu a pfenastavovani scény. Jak
jsme mohli vidét, metoda multi-pass renderu nam maze usetfit neuvéfitelné mnozstvi
casu.

Vzpomerime si jesté na pridani tagu Compositing k objektu interiéru vozu a zapnuti
Object Buffer u tohoto objektu. V naSem 2D grafickém editoru je nyni k dispozici extra
alfa kanal obsahuijici alfa obrazek interiéru (v zalozce Channels, Kandly). Tento kanal
muiZeme pouZit pro kompozi¢ni Upravy pokazdé, kdy jej budeme potiebovat.
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Tag kompozice
V tutoridlu tykajiciho se tématu
multi-pass jsme objektu priradili
tag (chovani) Compositing, tedy
kompozice. V tomto c¢lanku si
ukdZzeme, jak muZze byt toto
chovani pouZito pro zvyseni
produktivity nasi prace.

Ackoliv vypada vysledek dobfre,
tak by mohl byt, zejména co se
renderovaciho ¢asu tyce, jesté

vylepsen.

Obecné se tag Compositing (kompozice) pouziva pro zvyseni kvality a k redukci €asu
potfebného pro vypocet (rendering) scény. Jestlize nase scéna vypada dobfe, avSak
jeden nebo dva ze zobrazenych objektt maji problémy s vyhlazenim (antialiasing), tak
mUZeme pfifadit témto objektdim tag kompozice. Tag kompozice ndm zpfistupriuje extra
hodnoty nastaveni pro rozdilna nastaveni renderingu u jednotlivych objektl, avSak bez
zvys$eni vstupnich parametrt a narokd na scénu.

Nahrajeme si soubor pojmenovany ,Compositing Tag.c4d‘ z adresare Tutorials/
CINEMA 4D/Scenes/Rendering/Extra.

Mame nahranou scénu, ktera ma jiz nastavené parametry antialiasingu v odpovidajici
kvalité a tim i adekvatnim renderovacim Case.

Klepneme na tlacitko Render to Picture Viewer (renderovat do prohlizece) a
budeme sledovat, jaky ¢as zabere vypocet scény.

00:00:17 | Zoom: 100.0%, Size: B00x600

4]

KdyZ se podivame na obrazek, tak muZeme fici, Ze nevypada $patné, ackoliv by urcité
mohl byt jesté vylepSen. TaktéZ renderovaci ¢as neni nejhorsi, ale mohl by byt kratsi.
Na testovacim stroji (benchmark) trval 20 vtefin.
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» Otevieme nastaveni parametru pro vypocéet Render Settings.

» Prejdeme na stranku Antialiasing (vyhlazeni).

v

m Render Settings
*
General Antialiasing Best LI
Olutput _ .
i Filker Still Image LI
Antialiazing Softness IED 2 j
Fiadiosity T —
k4 -
A Threshold |1 0 []
Effects Mindhdax Level I‘Ix‘l LI Aud LI

Nastaveni vyhlazeni ndm poskytuje kontrolu nad vSemi aspekty zplsobl vyhlazeni
hran, coZ ma uzky vztah s €asem potfebnym pro vypocet scény. Nyni je na této strance
nastaveno velmi vysoké vyhlazeni.

Nastavime uroven vyhlazeni max i min na 1*1.
Mina’MaxLeveII‘lx‘l L||1x1 |

Nastaveni Urovné vyhlazenina 1*1 dramaticky snizi ¢as vypoctu. MdZeme poznamenat,
ze dokonce i nejlepsi zvolené vyhlazeni (Best) ma stejnou kvalitu vyhlazeni hran objektu
jako typ nastaveni Geometry (hrany). Rozdil mezi témito typy nastaveni se projevi
zejména na prihlednych, odrazivych &i sloZité texturovanych plochéach objektu.

Zavieme dialogové okno Render Settings (nastaveni renderingu).

V Object manageru se ujistime Zze mame vybrany objekt Black & White a z menu
File tohoto manageru zvolime New Tag > Compositing Tag (kompozice).

Anchor Tag I
| Compositing T ag

Constraint Tag

Tag kompozice doda konkrétnimu objektu (Ci skupin&) extra nastaveni renderingu.
Umozni nam tim vyfesit problém s plochou za sklem a pfifadi objektu vySsi procesni
¢as. Z tohoto duvodu nemusime nastavovat vys$si kvalitu pro celou scénu, coz by
vypocet zpomalilo a nepfineslo zadny viditelny efekt.
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» V Attributes manageru zapneme moznost Force Antialiasing (vliv vyhlazeni).

Altributes | Shap Settingsl
4 Mode Edit UserData

&HenderTag [Compoziting] ﬁ 5
| Basic | Tag | Obiject Buffer |
Tag Properties
|7 Cast Shadows |7 Seen by Camera
|7 Feceive Shadows |7 Seen by Rays

I_ Compositing Background |7 Seen by Gl
|7 Force Antialiasing

Min [ =1

Max m

Trezhold m

Diky nastaveni vlivu vyhlazeni na tomto objektu zajistime, Ze objekt bude renderovan
Cistéji a ostreji, bez roztfesenych hran.

» Klepneme na tlaéitko Render in Picture Viewer (renderovat do prohlizece).

' ”F. — . o i A
— E Render View 4
@ Fiender Region

& Fender Active Objects

Render to Picture Yiewer

= IS (hee

Tentokrat bude renderovaci €as podstatné zkracen, na testovacim poéitaci trval vypocet
scény 15 vtefin, coZ je o 25% rychlejSi vystup nez dfive. Touto malou optimalizaci
nebyla snizena kvalita obrazku, ale byl podstatné snizen vypoctovy ¢as scény. Ackoliv
pét vtefin nemusi vypadat jako velka Uspora ¢asu, tak v pfipadé rendringu vystupniho
obrazku v rozli§eni nasobné vétsim nebo pfi renderingu 10 000 snimkl animace se uz
bude jednat o velmi vysoké hodnoty.

Souhrn

Pocitacovy grafici a vytvarnici si musi byt jisti svymi technickymi znalostmi nastroju,
které pouzivaji, at jiz maluji na platno ¢€i pouzivaji monitor a mysS. Diky zakladnimu
porozuméni metod a technologii miZzeme zrychlit nasi praci a miZeme byt podstatnéji
produktivnéjsi bez toho, Ze by nase dila méla $patnou kvalitu.









